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NKRemote
Overview
NKRemote allows recent Nikon digital SLR cameras to be operated tethered to a PC using a USB
cable. All of the camera's controls remain fully operational when connected to the PC and pictures can
be taken directly using the camera's shutter release or remotely from the PC.
It is advisable to use a mains DC adaptor when using NKRemote for extended periods or when using
the time lapse features. If the camera is located a long way from the PC or is not easily accessible it is
essential that there is a way of turning the power to the camera on and off. Then if there is a
communication failure between the camera and PC it is possible to turn everything off and to start
again.

Photo Booth Mode

Please see the section on photo booth shooting for help on setting up a photo booth.

Supported Cameras and Operating Systems
NKRemote runs on Windows 10, Windows 8.1, Windows 8, Windows 7 and Windows Vista and
supports the following Nikon DSLR camera models: Nikon D4S, Nikon D4, Nikon D3X, Nikon D3s,
Nikon D3, Nikon D810, Nikon D810A, Nikon D800, Nikon D800E, Nikon D750, Nikon D700, Nikon
D610, Nikon D600, Nikon D300s, Nikon D300, Nikon D90, Nikon D7200, Nikon D7100, Nikon D7000,
Nikon D5500, Nikon D5300, Nikon D5200, Nikon D5100 and Nikon D5000
Windows XP: Microsoft ended support for Windows XP on April 8, 2014 and therefore we are no
longer able test or support our software on Windows XP. NKRemote should still work on Windows XP
however we strongly recommend that you upgrade to a more recent version of Windows.
Please visit our website to find out about our other camera control products: DSLR Remote Pro for
Canon EOS digital SLRs, PSRemote for Canon PowerShot cameras
Nikon D300, Nikon D300s, Nikon D3s and Nikon D3: Please check that the camera USB mode is
set to "MTP/PTP" not "Mass Storage" before connecting to it using NKRemote (this can be set via the
camera's setup menu).
Nikon D200 and Nikon D80: Please use NKRemote v3.3.2 or earlier to control a Nikon D200 or Nikon
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D80. These cameras are not supported in NKRemote v3.4 or later.
Please note: The following cameras DO NOT support remote capture: Nikon D3000, Nikon D3100,
Nikon D3200, Nikon D3300, Nikon One series cameras

2

Installing and Registering NKRemote
When you install NKRemote you need to activate your license on each PC it is running on. Activating
the software is a quick and simple procedure if the PC has access to the internet, however, we
recommend activating the PC at least 48 hours before an event. You can still activate a computer
which does not have access to the internet, but this involves sending an email to sales@breezesys.
com and will take longer than activating the software online. The software can be activated on up to
two computers at any given time.
You must deactivate the software before making any hardware changes, upgrading or repairing
the PC, reinstalling Windows or reformatting a hard disk. The software can then be reactivated after
the work has been done.
Topics covered in this section:
· Installing the software
· Uninstalling the software
· Evaluating the software
· Registering
· Activating
· Deactivating
· Moving the software to a different PC
· Making changes to your PC
· Decommissioning a PC
· Checking for updates
· Activation problems

Installing the software
The latest version of NKRemote can be downloaded from www.breezesys.com.
To install NKRemote simply download and run the setup program then follow the on-screen
instructions.

Uninstalling the software
NKRemote can be uninstalled using the standard Windows "Uninstall a program" option in the
Programs section of the Windows Control Panel.
IMPORTANT: Please deactivate NKRemote before uninstalling otherwise you may not be able to
activate the software on another computer. If you forget to deactivate the software you should be able
to reinstall the software, deactivate it and then uninstall.

Evaluation Version
The trial evaluation version of the software is identical to the registered version and is fully functional
for 15 days. Each time you run the software it will display the registration dialog allowing you to enter a
registration code or press the "Evaluate" button to continue evaluating the software:
© 2016 Breeze Systems Ltd
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At the end of the 15 day trial period you must purchase a license to continue using the software.

Registering the software
To purchase a license forNKRemote please visit our website: http://www.breezesys.com/
purchase_nkremote.htm. You will be sent an email containing your registration details when your
payment has been received.
To register NKRemote run the application enter your registration name and code exactly as they
appear in your registration email. You may find it easier to copy and paste both the registration name
and code directly from your registration email to avoid mistakes when entering it. Please keep a copy
of your registration email safe in case you need to re-enter your registration details.
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Click on the "Register" button after entering your name and registration details. If the details are
correct the message below will be displayed. An error message will be displayed if the name and
registration code are not valid (e.g. they were not entered correctly) or if you need to purchase an
upgrade to use this version of the software.

Click on the "Yes" button to register the software and the following message will be displayed asking
you whether you want to activate the software on this computer:
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Click on the "Yes" button to activate the software on this computer (see the section below for details).

Activating the software
The software must be activated on the computer before it can be used. The software can be run
without activating for up to 10 days after the the date when the registration code was issued. After that
time the software will not run unless it is activated. The software can only be activated on up to two
computers at any given time. If you wish to move the software to a different computer you must
deactivate it from the old computer before activating it on the new computer. Once the software has
been activated on a computer you can run it normally.
To activate the software click on the "Activate..." button in the registration dialog

and the activation dialog below will be displayed:
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The quickest and simplest way to activate the software is to do it online by pressing the "Activate
Online" button. Please note that the computer must have an internet connection and the program must
be allowed to access the internet in order to activate the software online.
Please note that it may take up to 30 seconds to activate the software online.
If the computer is not connected to the internet you can activate the software by email by clicking on
"Activate by email" button and the dialog below will be displayed:

It is important that you copy all of the text and email it to sales@breezesys.com. Please do not modify
the text otherwise we may not be able to validate it. The simplest way to copy the text is to press the
"Copy text to clipboard" button and then paste it into the email by typing Ctrl+V. If the computer doesn't
have email you can copy the activation text to a USB memory stick and then read it on a computer
which does have email.
© 2016 Breeze Systems Ltd
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You should normally receive an email containing your activation code within 12 hours of sending the
activation request email. Paste your activation code into the "Activation code" text area at the bottom of
the activation dialog and click on the "Activate" button to activate the software. If you have closed the
activation dialog you can display it again by running the software and then clicking on the "Activate..."
button in the registration dialog followed by the "Activate by email" button.

Deactivating the software
The software can only be activated on up to two computers at any given time. If you wish to move the
software to a different computer you must deactivate it from the old computer before activating it on
the new computer.
You also need to deactivate the software before making any hardware changes, upgrading or
repairing the PC, reinstalling Windows or reformatting a hard disk. The software can then be
reactivated after the work has been done.
To deactivate the software select "Register..." from the Help menu in the main window to display the
registration dialog:

Then click on the "Deactivate..." button to display the deactivation dialog:
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The quickest and simplest way to deactivate the software is to do it online by pressing the "Deactivate
Online" button. Please note that the computer must have an internet connection and the program must
be allowed to access the internet in order to deactivate the software online.
Please note that it may take up to 30 seconds to deactivate the software online.
If the computer is not connected to the internet you can deactivate the software by email by clicking on
"Deactivate by email" button and the warning dialog below will be displayed:

Click on the "Yes" button if you want to continue and the deactivation dialog below will be displayed:
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It is important that you copy all of the text and email it to sales@breezesys.com. Please do not modify
the text otherwise we may not be able to validate it. The simplest way to copy the text is to press the
"Copy text to clipboard" button and then paste it into the email by typing Ctrl+V. If the computer doesn't
have email you can copy the text to a USB memory stick and then read it on a computer which does
have email.
You should normally receive an email acknowledging the deactivation code within 12 hours of sending
the request email. If you forget to copy the deactivation information and email it to sales@breezesys.
com you can display it again by selecting "Register..." from the Help menu in the main window and
clicking on the "Display" button. Please note that the copy of the deactivation information will be not be
available after another registration code has been entered.

Moving the software to a different PC
The software can be activated on up to two computers at any given time and so if you are moving the
software to a different PC you should deactivate the software from the old PC first. Then install the
software on the new PC, then register and activate the software.
If you are planning to move the software to a different PC permanently please following the instructions
for decommissioning a PC.

Making changes to your PC
You need to deactivate the software before making changes to your PC such as upgrading the PC
hardware, reformatting a hard disk, reinstalling Windows, upgrading Windows or getting a PC
repaired.
Simply deactivate the software online (or by email if the PC doesn't have access to the internet), make
© 2016 Breeze Systems Ltd
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the changes and then re-activate the software. If Windows has been reinstalled or the hard disk has
been replaced or reformatted you may need to re-install NKRemote, re-enter your name and
registration code and then activate the software.
The latest release and previous releases of the software can be downloaded from the upgrades page
on the Breeze Systems website.
IMPORTANT: Please make sure you have a copy of your name and registration code before making
changes to your PC just in case you need to re-enter them later

Decommissioning a PC
If you are decommissioning a PC and planning to sell it or give it to somebody else you need to
deactivate the software and remove your registration details. It is very important that you remove your
registration details even if you have uninstalled the software otherwise the new owner may be able to
reinstall the software and gain access to your registration details. If someone obtains your registration
details they will be able to register and activate the software on their computer and could prevent you
from using it on your computer.
After deactivating the software you can remove your registration details by entering the special
registration code below:
Name: Uninstall
Code: 000JJ3-F5D6KF-D2UQ6G-JAMBHU-XD7GRV-X47WUD-PXXPZ2
This will install a special old code which replaces your registration details and will cause the software
to display an "Upgrade required" message when it is run.
If you decide to use the computer again you can reinstall the software, enter your registration details
and activate software.

Checking for updates
You can check for updates by selecting "Check for updates online". This will connect to the internet
and display details of the latest version NKRemote in your web browser. Alternatively go to the
NKRemote page on our website: http://www.breezesys.com/NKRemote

Activation problems
If the error message "The server name or address could not be resolved" is displayed when you try to
activate or deactivate the software online it means that the PC is unable to access the internet. Please
check that that the computer is connected to the internet and check your firewall settings to make sure
that NKRemote.exe (the NKRemote program) is allowed to access the internet. If you are still unable
to activate the software online you may need to activate it by email instead.
If a different error message is displayed please follow the instructions displayed in the error message.
If you are not sure what to do please email sales@breezesys.com and include your registration name
and code and details of the error message.
Please also see the support page on the Breeze Systems website for help with activation problems.
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Main Window
The Main Window
The main window shows the main camera controls together with a large preview display and a
histogram for assessing exposure. The main camera settings can be changed using the controls down
the left hand side of the main window. Other settings are available from the menus.

Screen shot of NKRemote main window showing optional focus point overlay display

3.1

Release and Preview Buttons
Release Button
Click on the Release button to take a picture. The picture is automatically downloaded to the PC,
displayed in the main window and saved to disk.
Note: No picture is taken and an error message is displayed if the camera is set to auto-focus and is
unable to focus.
Preview Button
Click on the Preview button to take a picture in preview mode. The picture is downloaded to the PC
and displayed in the main window but is not stored on the PC's disk.

3.2

Reviewing and deleting images
Reviewing Previous Images
You may review previous shots by pressing the "<- Prev Image" and "Next Image ->" buttons or by
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using the left and right cursor keys. The main and preview images displays are updated to display the
selected image together with the histogram display. You can delete previously taken shots in the
normal way. To help identify which shot is being displayed the status bar shows the filename of the
image and its number in the sequence e.g. [3 of 5].
When a picture is taken the display is updated to show the new shot.
Deleting Images
Press the Delete key to delete the current picture from the computer's hard disk.

3.3

Changing camera settings
The camera settings can be changed using the controls in the main window or directly using the
camera's controls. When the settings are changed on the camera they are updated and displayed in
the main window. Not all controls can be changed in all camera modes (e.g. the shutter speed can
only be set in Manual and Tv exposure modes) and so some controls are "grayed out" when they are
not applicable.
Some settings (e.g. exposure mode) can only be adjusted from the PC when the "Lock camera
controls" option in the main window is selected.
Notes
1. The lens can only be zoomed by physically turning the zoom ring on the lens
2. You can only switch between manual and autofocus using the switch on the lens or camera body

3.4

Full screen mode
Press F11 or select "Full Screen" from the view menu to display images in full screen mode. Press the
Escape key or F11 to exit full screen mode.
In full screen mode the images fill the screen. The following keyboard shortcuts are available when in
full screen mode:
F7
F8
F9
F11/Esc
Delete
Cursor left
Cursor right
Ctrl+C
Ctrl+F
Ctrl+G
Ctrl+W

3.5

View image
Release the shutter and save the image
Take preview shot
Exit full screen mode
Delete current image
Display previous image
Display next image
Toggle caption display on and off
Toggle focus point overlay display on and off
Toggle grid overlay display on and off
Toggle black and white display mode on and off

Auto Bracketing
NKRemote has flexible settings for auto bracketing (taking a sequence of shots using different
© 2016 Breeze Systems Ltd
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exposure settings) which simplify the taking of shots which are later combined together to form a
single HDR (high dynamic range) image. To enable auto bracketing select the "Auto-bracket"
checkbox and then click on the "Settings..." button to display the auto bracket settings dialog below:

You can set the number of shots in the sequence using the first dropdown list. Then set the number of
exposure stops should separate each shot. This can be 1/3, 2/3, 1, 1 1/3, 1 2/3 or 2 stop per shot
depending on your camera's settings (if your camera is set to use 1/2 stop increments instead of 1/3
stop increments selecting a value of 1/3 or 2/3 stop increments will result in 1/2 stop increments being
used).
The different exposures are set using the camera's exposure compensation control if the one of the
auto exposure modes is selected.
Please note: The range of the sequence is limited by the exposure compensation range of the
camera.
If manual exposure mode is selected the exposure will be varied using either the shutter speed or the
aperture according to the settings in this dialog. Normally it is better to keep the aperture constant (and
hence the depth of field) and vary the shutter speed.
NKRemote can optionally run a command at the end of the auto bracket sequence to combine the
shots. To do this click on the "Execute command at end of auto bracket sequence" checkbox and
enter the name of the program or script to run. In the screenshot above the script "photomatix3.bat"
has been entered. This will run the Windows batch file "photomatix3.bat" which combines the images
using Photomatix Pro (which can be purchased from http://www.hdrsoft.com) and displays the result in
BreezeBrowser Pro (http://www.breezesys.com/BreezeBrowser ). The batch file can be found in the
NkRemote installation folder (usually C:\Program Files\BreezeSys\NkRemote) and makes use of the
command line interface for Photomatix Pro. Please use photomatix3.bat with Photomatix Pro 3.1 and
photomatix2.bat with Photomatix Pro 2.
Suggested procedure for auto bracketing:
1. Use a tripod and compose the shot as required
2. Switch to manual exposure mode and low ISO setting to maximize the quality
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3. Set the required aperture (e.g. use a small aperture like f/16 for good depth of field)
4. Take a preview shot to determine the correct exposure (this can be judged by looking at the
histogram display). It may be necessary to take a number of test shots to get the correct exposure.
Adjust the exposure by changing the shutter speed
5. Set the lens to manual focus and focus carefully
6. Set the required number of shots and number of stops separating each shot (a 5 shot sequence
with 1 stop increments is a good start, more shots may be required if the brightness range in the
shot is very large)
7. Press the "Release" button and NKRemote will automatically take the sequence
Auto exposure bracketing is particularly useful for product shots and for taking pictures of the interiors
of buildings. The photos below compare the results from a single exposure of the interior of a church
with an image which was blended from seven separate exposures taken using the auto bracketing
feature:

Photo of the interior of St Andrews Church, Sherborne St John, Hampshire, England.
(The image on the right was created by blending the auto bracketed images using a separate image
editor which is not part of NKRemote)
The seven shot auto bracket sequence used to create the blended exposure above:
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Grid and focus point overlays
Grid Display
To toggle the grid overlay on the preview image type Ctrl+G or select "Display Grid" from the "View"
menu. Select "Grid Settings..." from the "View" menu to display the "Grid Settings" dialog, shown
below:

Select the show print area checkbox to show the extent of a particular print size. For example most
digital SLRs shoot images with an aspect ratio of 3:1 which fits perfectly on a 6"x4" print but needs to
be cropped if it is printed on 10"x8" paper. You can display extent of a 10"x8" print by setting the print
aspect ratio to 10 x 8.
Note: The grid display is only displayed on the preview image and doesn't affect images saved to disk.
Focus Point Overlay Display
To toggle the focus point overlay display type Ctrl+F or select "Show Focus Points" from the View
menu. When the focus point overlay display is enabled the seven focus point areas are displayed over
the preview image. Active focus points are displayed in red.
Focus points can be selected from the PC or using the camera controls.
Note: The focus point overlay display is only displayed on the preview image and doesn't affect images
saved to disk.

3.7

Flashing highlight display
Select "Flashing Highlights" from the "View" menu to display over-exposed areas by highlighting them
flashing on and off in black. The method of calculating the highlight values and the threshold at which
to start flashing them can be specified by selecting "Highlight Settings..." from the "View" menu. When
the highlight method is set to "Luminosity" the luminosity or brightness of the image is used to
calculate the highlight values. When it is set to "RGB value" the largest of the red, green and blue
channel values is used.
Note: The flashing highlight display is only available for images displayed in the main window. It is not
available in full screen mode or the image preview window.

© 2016 Breeze Systems Ltd
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Color Management
NKRemote supports the color management of images displayed in the main window and when printing
photo booth images. Color management helps produce more accurate and consistent colors when
displaying and printing images. NKRemote uses the perceptual rendering intent for both the display
and printing of images. A detailed explanation of color management is beyond the scope of this help
file.
Select "Color management settings..." from the File menu in the main window to display the color
management settings dialog:

Color Management of displayed images
Select a suitable color profile for your monitor by clicking on the "..." browse button or clicking on the
"Use default monitor profile" button. Next select a suitable color profile for your camera. Normally this
will be the sRGB Color Space profile unless your camera is set to AdobeRGB in which case it should
be the AdobeRGB 1998 profile. Then select "Enable color management of displayed images" to
enable color management.
Please note: For performance reasons color management is only applied to images displayed in the
main and full screen windows. It is not applied to live images or images displayed in photo booth
mode.

Color Management of printed images
First select a suitable color profile for your camera as described above. Next select a suitable color
profile for your printer by clicking on the "..." browse button. Most printer manufacturers provide generic
color profiles for their printers, often with different profiles for different papers. Then select "Enable
color management of printed images" checkbox to color manage the printing of photos for more
accurate colors.
IMPORTANT: Please disable color management in the printer driver when selecting color
management in NKRemote otherwise the colors may be adjusted twice.
© 2016 Breeze Systems Ltd
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Live View Display
Select "Live View" or type Ctrl+L to select the live view display and display the windows below. If the
camera is not already in live view mode the mirror will flip up and the camera will enter live view finder
mode. The controls in the main NKRemote window can still be accessed when the live view window is
displayed. If the live view window is covered by other windows it can be displayed by typing Ctrl+L
when the main NKRemote window is displayed. Closing the live view window will cause the camera to
exit live view mode. The window can be resized to display a larger live view image.

Live view images can either be displayed full frame as in the screenshot above or zoomed as shown
below. The green rectangle shows the area of the zoomed image. The position of the zoomed area
relative to the rest of the frame is also shown in the navigation window in the bottom left hand corner.
The zoomed area can be moved by clicking on the white rectangle and dragging it using the mouse or
by dragging the rectangle in the navigation window. Double click the left mouse button over the image
or the navigation window to move the zoomed area and switch to the zoomed view.
Click on the "Release" or "Preview" buttons to take a image or a preview shot. The shot will be
displayed in the main NKRemote window.
The lens can be focused using the arrow buttons or by using the mouse wheel. The "<<<" button shifts
© 2016 Breeze Systems Ltd
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the focus nearer by a large increment, "<<" focuses nearer by a medium increment and "<" can be
used for fine adjustment. Similarly the ">", ">>" and ">>>" focus farther away by small, medium or
large increments.
The mouse wheel provides a very effective way to adjust the focus. When the Shift key is held down
the mouse wheel adjusts the focus in large increments. When the Ctrl key is held down the mouse
wheel adjusts the focus in medium increments and when no keys are held down the mouse wheel can
be used for fine focus adjustments. The lens can also be focused using the cursor left and right keys
with the Ctrl and Shift selecting medium or large increments respectively.
The size of the small, medium and large focus increments can be adjusted by right clicking on live
view image and selecting "Adjust focus settings...". The dialog below will be displayed:

Different settings may be defined for each lens (the lens name is displayed in the window tittle bar).
Please note: The lens should normally be set to the auto-focus setting for the focus controls to work.
Right click on the image to display a menu for enabling or adjusting the grid overlay display. The live
view shares the same grid overlay settings as the image display in the main window.
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The zoomed area can be moved by clicking the mouse on the image and dragging as required or by
by dragging the white rectangle in the navigation window. It can also be moved by double clicking in
the navigation window.
Double click on the live view image or set the "Zoom" dropdown list to "None" to return to the full frame
view.
Overlay
An optional overlay image can be displayed over the live view images to help composition e.g.
registration marks could be displayed to help align the camera when taking id photos. The overlay
image should be a PNG file with transparency information in the alpha channel. It should be in
landscape orientation with an aspect ratio of 3:2 e.g. 640x426 pixels in size. Once a suitable overlay
image has been defined it can be displayed by right clicking on the live view image and selecting "Load
overlay image...". An example overlay image called example_overlay.png can be found in the
NKRemote installation folder.
Auto Focus
Click on the "Contrast AF" button to auto focus the lens using the camera's contrast detection AF.
During AF the green AF area will be shown in red in the full frame view.
© 2016 Breeze Systems Ltd
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In the full frame view the area defined by the green rectangle is used to define the auto focus area.
The rectangle can be dragged to a new position to auto focus in a different area of the live view image.
In the zoomed view the central area of the image is used for auto focus.
Limitations: Because it takes several seconds to auto focus in live view it is not suitable for handheld
shots or for moving subjects. Auto focus may fail if the image is very out of focus when AF starts, if the
focus area has poor contrast or if the live view images are very noisy due to low light levels. Lenses
which focus in large steps when using the fine focus settings (the "<" and ">" buttons) and lenses
which focus by different amounts when focusing nearer or farther may cause AF to fail to achieve
optimum focus in live view.
EVF Upscaling
The full frame live view image is 640x426 pixels in size. By default the Live View window will enlarge
(or upscale) the images to fit the window. This can produce pixelated images or other display artefacts
depending on the amount of upscaling or the type of subject being photographed. If this is a problem
EVF upscaling can be disabled by right clicking on the image and deselecting "Allow EVF upscaling".
Mirroring and rotating the live view display
Right click on the full frame live view image to display a menu to select horizontal flipping of the live
view image. Horizontal and is useful if pictures are being taken through a mirror or if you want to get
the same effect as looking through a mirror e.g. mounting the camera above the computer display so
that when people look at the display it is like looking through a mirror. The image can be rotated in 90
degree increments by the appropriate option from the View menu in the main window (Landscape,
Portrait, Inverted or "Use Orientation Sensor"). When "Use Orientation Sensor" is selected the live
view display will be automatically rotated to match the camera's orientation (please set "Auto Image
Rotation" to On in the camera's Setup menu to enable this).
Electronic level display
An optional electronic level can be displayed in live view for camera models that support it (Nikon
D7200, Nikon D7100, Nikon D7000, Nikon D810, Nikon D810A, Nikon D800, Nikon D800E, Nikon
D750, Nikon D610, Nikon D600, Nikon D4s and Nikon D4 at the time of writing). To display the
electronic level right click on the live view display and select "Display electronic level".
Focus Peaking (experimental)
Press and hold down the F2 function key to enable live view focus peaking which will highlight areas in
focus in red. The sensitivity of focus peaking can be adjusted by changing the following setting in the
Windows registry (you need to exit NKRemote before changing this setting):
HKEY_CURRENT_USER\Software\BreezeSystems\NKRemote\100\EvfFocusPeakingThreshold
The default setting is 400. Please note that the focus peaking display is experimental and may change
in future releases.
Onion Skinning
Onion skinning is where the current live view image is displayed on top of a previous image help line
up a shot. This is very useful when taking stop motion animations and in other situations where it is
important to accurately line up the camera for consecutive shots.
Onion skinning is only available when the full frame view image is displayed. To start onion skinning
right click on the view image and select "Onion skinning" from the menu. By default the background
image is updated whenever a photo is taken but this behavior can be disabled if required.
The background image used for onion skinning can be saved and loaded to from the a file. This is
useful when doing stop motion animation and you wish to save the background at the end of the day
and load it again to continue work the next day. It also means you can save the background image,
edit it in an image editor to add reference marks and then load it back into the live view window.
Another use for onion skinning is when taking panoramas. The onion skinning background can be
offset to the left or right for panoramas taken in horizontal format or to the top or bottom for vertical
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format. The background is offset by 60% and is used to help align the next shot in the panorama.
Arranging Windows
Type Ctrl+A to automatically arrange the live view and main windows. Repeatedly pressing Ctrl+A will
cycle through the following window layouts:
1. Main window resized to just show the controls and positioned on the left of the screen with the live
view window occupying the rest of the screen. This mode is useful for viewing the live view and
adjusting the camera settings from the computer.
2. Live view window filling the screen - useful for composing and focusing the image
3. Main window filling the screen - useful for viewing images that have been taken
Note: The full frame live view images from the camera are 640x426 pixels and may not fill the live
view window. If EVF upscaling is enabled (right click in the live view window to display a menu to
enable this) the 640x426 pixel images will be scaled to fit the window.
Keyboard Shortcuts
The following keyboard shortcuts can be used when the live view is displayed:
Spacebar or F8
Take a picture
F9
Take a preview image
Ctrl+L
Close the live view window
Cursor left
Focus closer by a small increment
Ctrl+Cursor left
Focus closer by a medium increment
Shift+Cursor left
Focus closer by a large increment
Cursor right
Focus farther by a small increment
Ctrl+Cursor right
Focus farther by a medium increment
Shift+Cursor right
Focus farther by a large increment
Cursor up
Zoom the preview
Cursor down
Select full frame display
Ctrl+O
Toggle onion skinning on and off
Ctrl+B
Capture current live view image as onion skinning background
Ctrl+A
Arrange the main and live view windows
Ctrl+E
Display electronic level overlay for camera models that support it
Ctrl+Z
Zoom in/out
Ctrl+Tab
Cycle through: Controls+AF area display->AF display but no controls->live view
images only

5

Focus Stacking
Focus stacking is a technique for increasing the depth of field by taking a series of photographs with
different focus settings and then combining them together using the areas in focus from each image.
This technique is useful for macro and close-up photography, landscapes, product photography and
any other image where the depth of field is critical and the subject isn't moving.
The live view display in NKRemote makes it simple to automate the process of taking a sequence of
images with different focus settings by running a script. Once the pictures have been taken they can
be combined using free software such as CombineZM or commercial software like Helicon Focus (the
example on this page was combined using CombineZM).
Please note: The photos below were taken using our DSLR Remote Pro software for Canon EOS
digital SLRs. Focus stacking using NKRemote and a Nikon DSLR will produce similar results.
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Image combined using CombineZM from a series of 40 individual shots shot taken with a Canon EOS
40D and Tamron 90mm macro lens set f/5. This is a full frame image which has been resized to fit on
the page and shows the edge effects to the left and right of the image resulting in the text being
reflected and also edge effects at the top and bottom. These can easily be cropped from the final
image but it is worth noting that it is a good idea not to frame the image too tightly when taking the
photos.
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Single shot taken with Canon EOS 40D with Tamron 90mm macro lens at f/5. A smaller aperture could
have been used to get greater depth of field but the image quality would be affected due to diffraction
effects if too small an aperture is used. One of the advantages of the focus stacking technique is the
lens can be set at its optimum aperture to give the best possible quality.

How to take the photos using NKRemote
What do you need?
1. A Nikon DSLR which supports live view e.g. Nikon D7200, Nikon D7100, Nikon D7000, Nikon
D5500, Nikon D5300, Nikon D5200, Nikon D5100, Nikon D5000, Nikon D90, Nikon D300, Nikon
D300s, Nikon D610, Nikon D600, Nikon D750, Nikon D700, Nikon D810, Nikon D800, Nikon
D800E, Nikon D3s, Nikon D3, Nikon D3X, Nikon D4S, Nikon D4
2. A copy of NKRemote (you can use the free trial version for 15-days) and a USB cable connecting
your camera to your computer
3. A sturdy tripod to hold the camera steady while taking the sequence
4. AutoHotKey - a free scripting tool which can be downloaded from http://www.autohotkey.com
5. focus_stacking.ahk - an AutoHotKey script for taking the photos and adjusting the focus which can
be found in the NKRemote installation folder (usually C:\Program Files\BreezeSys\NKRemote)
6. CombineZM - a free program for combining the images (download CombineZM)
First mount the camera on the tripod, select manual exposure mode and compose the shot, roughly
focusing the lens on the subject. Then connect the camera to your PC using the USB cable and run
NKRemote. Activate the live view on the PC by typing Ctrl+L and use the mouse wheel or cursor keys
focus the lens on the nearest part of the subject. Finally, double click on the focus_stacking.ahk file to
run the script to take the photos. NKRemote's live view window will appear and a sequence of shots
with different focus settings will be taken. Please don't touch you computer while the sequence is being
taken otherwise it may not work properly.
By default the focus_stacking.ahk script will take 30 images. This can be changed either by editing the
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script using a text editor or by running the script from the Windows Command Prompt and specifying
the number of images on the command line e.g.
C:\> focus_stacking.ahk 15

Combining the images (or focus stack)
Run CombineZM and select "New" from the "File" menu. Locate the folder containing the images
taken earlier, select all the images in the file open dialog and click "Open". CombineZM will load the
images (this may take a few seconds). Then select "Do Stack" from the "Macro" menu to combine the
image (this may take a few minutes). When it has finished the combined image will be displayed in
CombineZM's main window. The image can be saved by selecting "Save Frame/Picture As" from the
"File" menu.

6

Time Lapse
Select "Time-lapse..." from the "Camera" menu to take time-lapse shots.
The time lapse sequence can be set to start immediately or to start at a particular time and date. You
can either specify an end time and date for the time lapse sequence or the number of frames in the
sequence.
You can specify the interval between shots.
Note: If you set the interval to a time shorter than that required to take and download the picture the
sequence will run as fast as possible.
Press the "Start" button to start the time lapse sequence.

7

Auto Reconnect
When auto reconnect is selected from the "Camera" menu NKRemote will attempt to reconnect to the
camera every 5 secs if it becomes disconnected. NKRemote will display a red screen saying "Not
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connected" to clearly indicate that the connection has been lost.
The connection to the camera will be lost if the USB cable is removed, the camera's memory card door
is opened, the camera is switched off or the battery becomes flat or is removed.
Warning: Do not disconnect the camera from the computer while images are being downloaded. This
may result in some images being lost and may confuse the USB drivers making it necessary to reboot
the PC before reconnecting.
In fullscreen photobooth mode auto reconnect will automatically restart the photobooth mode, enable
the live view if required and display the "ready" screen when the camera is connected.

8

Editing Images and Editor Setup
Right click on the image and select "Edit Image" to open the image in an image editor (or type Ctrl+E).
For this feature to work you need to tell NKRemote how to run the image editor by selecting "Setup
Image Editor" from the File menu.

Select the "Use the Windows Explorer 'Open' command" option to use the same editor or viewer as
when you open or double-click an image in Windows Explorer.
Select the other option and enter the command line in the edit box to specify a different editor.
Select "Automatically edit image when a photo is taken" to automatically load images into an editor
when they are taken. Please take care not to load too many images into your editor as Windows may
run low on memory causing the editor or NKRemote to fail.
Notes:
1. Only images saved to disk can be edited. Preview images cannot be edited.
2. Many image editors cannot open raw files directly and will display an error message if you try to edit
a raw image.

9

Displaying Images in BreezeBrowser Pro
Images can be automatically displayed in BreezeBrowser Pro after they have been taken and
downloaded to the PC. To do this select "Setup image editor..." from the File menu and set it up to run
the command BBProDisplay.exe as shown below:
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The Image Preview Window
To display an enlarged preview window select View Image from the Image menu (or press F7). The
image preview window can be left on the screen while more pictures are taken to monitor composition
or focus in critical areas e.g. the eyes of a model during a portrait session. The preview window is
automatically updated when the image in the main window changes.
The image can be scrolled by moving the scroll bars or by clicking the left button on the mouse and
dragging the image. If the image preview window is still displayed when a picture is taken it will be
updated to show the same area of the new shot. This is very useful for monitoring important areas of
the image e.g. a model's eyes when taking portraits.

11

Photobooth Shooting

Start here
The quickest way to get started is to setup your printer and then use the photobooth setup wizard to
set everything else up for you.
You can then change the appearance of the screens by editing the JPEG screen images in an image
editor such as Photoshop or Photoshop Elements.
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Then use the print layout editor to edit the print layout or to load a different preset print layout.
The advanced settings can be used to fine tune the settings.
A series of shortcut buttons to provide quick access to key photobooth options can be displayed at the
top of the main window:

The photobooth shortcut buttons can be turned on or off by selecting "Photobooth Shortcuts" from the
View menu.

More detailed help...
Topics covered in this section:
Photobooth setup wizard
Editing the print layout
Touchscreen settings
Saving settings for future reference and using profiles
Print layout
Other output options
Images displayed to the user
Running external commands
Touchscreen keyboard
Keyboard shortcuts
Using external buttons for photobooth shooting
In operation
Reprinting photos after an event
Green screen shooting
Live view overlay
How to create PNG images using Photoshop and Photoshop Elements
Uploading to social networking and photo sharing sites
Please also see the series of articles on photobooth shooting on our website.

Summary of changes to print layouts in NKRemote v3.0 onwards
The following changes have been made to the way layouts are printed. These should have little or no
effect on print layouts defined using previous versions, but it layouts created using version 3.0 or later
may not appear the same in earlier releases.
1. background.jpg image is now centered on the page after allowing for the printer margins. In
previous releases the background.jpg image was placed in the top left hand corner of the page and
tiled to fill the page
2. overlay.png is now centered on the page after allowing for the printer margins. In previous releases
the overlay.png image was placed in the top left hand corner of the page
3. The global setting for enabling or disabling captions has been removed. Individual captions can be
enabled or disabled by selecting "Edit captions..." in the "Photobooth settings" dialog or the print
layout editor
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4. Up to 8 captions can be defined (previous releases only supported 2 captions)
5. Custom layouts can now be edited using the new print layout editor which allows you to drag and
drop items interactively
6. Up to 12 photos may be added using the print layout editor (the old custom layouts were limited to
10 photos)
7. A background color can be defined in the print layout editor (this defaults to white when using the
automatic layout option)
8. A QR code can be added using the print layout editor

11.1

Photobooth Setup Wizard
The photobooth setup wizard provides a fast and simple way of creating the screens and the print
layout for common photobooth configurations.

Running the Photobooth Setup Wizard
If the photobooth shortcut buttons are displayed at the top of the main window simply click on the
"Photobooth Setup Wizard" button (if the shortcuts buttons aren't displayed select View->Photobooth
Shortcuts to display them).
Alternatively click on the File menu and select "Photobooth Setup Wizard..."

Step 1: Printer Settings
This step displays the current printer settings and asks you to select a print layout. The settings for a
DNP DS-40 printer loaded with 6x4 paper are shown below:

First check the printer settings and click on the "Setup printer..." button if they need changing.
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Please note: if you printing a double strip of 3 or double strip of 4 photos and are using a dyesub
printer which can cut a 4"x6" sheet into two 2"x6" strips you need to select this option in the printer
driver by clicking on the "Setup printer..." button.
Next select one of the seven print layout options:
"Classic double strip of 4 photos" - This prints two columns of four images side by side as shown
below:

"Single strip of 4 photos" - prints a single column of four images as shown below. This option is useful
for printers like the DNP DS-RX1, HiTi P510 and Mitsubishi CP-D70DW which can cut 6x2 strips from
6x4 paper and treat these as 6x2 pages.
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"Double strip of 3 photos" - Similar to the "Classic double strip of 4 photos" but with only three photos
and more space for logos etc.
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"Single strip of 3 photos" - Similar to the "Single strip of 4 photos" but with only three photos and more
space for logos etc.
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"1 large photo with 3 smaller ones below" - This layout gives plenty of space for logos and captions as
shown below:
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"2 rows of 2 photos" - This option fills the page with four equally sized photos arranged in a 2 x 2 grid:

"Single photo" - This option fills the page with a single photo:
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When you have selected your preferred layout press the "Next >" button to go to step 2.

Step 2: Specify the photo booth images folder
This step allows you to specify the name of the folder where the various screen and layout images
should be stored and looks like this:

Enter the name of the photo booth images folder. The screens for the photo booth and the optional
layout images will be saved in this folder and can be edited later using an image editor to personalize
the look of your booth.
Press the "Next >" button to go to step 3.
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Step 3: Specify user interface options
This step allows you to specify the options available to users of your photo booth and looks like this:

Select the options you wish to use and then press the "Finish" button to create the photo booth
settings. The settings are saved to a file named settings.xml in the photobooth images folder. These
settings can be loaded again by pressing the "Load..." in the photobooth settings dialog.
"Use touchscreen" - select this option if your booth has a touchscreen. The setup wizard will
automatically add buttons and touchscreen actions to the screens shown to users.
"Allow users to select BW or color prints" - If the "Use touchscreen" option is selected this option will
add buttons and touchscreen actions to allow users to choose color or B&W prints. If "Use
touchscreen" is not selected this option will do nothing but users will be able to select B&W or color
using the keyboard shortcuts Ctrl+B and Ctrl+C.
"Preview each photo after it is taken" - when this option is selected a full screen preview will be
displayed for 3 secs after each shot is taken.
"Display thumbnails of the photos taken so far" - select this option to display a small thumbnail of each
shot taken so far down the right hand of the screen. Each screen will have a series of small gray
rectangles added to show where the thumbnails will be placed. Please see the section on the optional
thumbnail display for more information.
"Display print preview and ask for confirmation before printing" - when this option is selected a full
screen preview of the print layout will be displayed before printing. If the "Use touchscreen" option is
selected buttons and touchscreen actions allowing users to print or reject the photos will be added. If
the "Use touchscreen" option is not selected users need to press A to accept the print or X to reject it.
"Add print option in sharing screen" - select this option to allow users to print photos from the sharing
screen.
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"Facebook upload" - select this option to allow users to upload photos to their personal Facebook page
direct from the photobooth (requires an internet connection). Please see the section on uploading
photos to social networks for more information on uploading photos to Facebook.
"Twitter tweet" - select this option to allow users to post photos their personal Twitter feed direct from
the photobooth (requires an internet connection). Please see the section on uploading photos to social
networks for more information on posting photos to Twitter.
"MMS/SMS" - select this option to allow users to text photos to their cellphone via MMS or SMS
(requires an internet connection and an account with Twilio.com). Please see the section on uploading
photos to social networks for more information texting photos
"Email photos" - select this option to allow users to email photos direct from the photobooth (requires
an internet connection). Please see the section on uploading photos to social networks for more
information on emailing photos.
"Add a background.jpg image which can be edited to add logos etc." - select this option if you want to
add logos etc. to the prints. This will create a background.jpg image the same size in pixels as the
printed output and place it the photo booth images folder. Please edit the background.jpg to add logos
etc.
The inactivity timeout can be set to switch the booth to standby mode and display the welcome.jpg
screen after a preset number of seconds if there is no user input. Set this to 0 to disable the inactivity
timeout. The inactivity timeout is useful if the photobooth is not in continuous use because it disables
the live view display and puts the booth into standby mode. Disabling live view will allow the camera's
sensor to cool down to avoid possible overheating problems. The booth can be switched back to the
ready screen by pressing F6 or touching the screen (if available).

What happens next?
Please try running the booth and taking a set of photos to check the print layout. If the photos aren't
correctly centered on the page or the gaps between the photos is too large you can adjust the settings
by clicking on the "Print Layout" shortcut button (or by selecting File->Photobooth settings... and
clicking on the "Settings..." button to the right of the "Custom layout" checkbox. Please see the section
on the print layout editor for more details.
Logos and other graphics can be added to the prints by creating a background.jpg image and editing
this in an image editor. The background.jpg image needs to be the same size in pixels as the print
output. If you selected the "Add a background.jpg image which can be edited to add logos etc." option
when running the setup wizard there will already be a dummy background.jpg image in the photobooth
images folder.
The various screens presented to the user are defined using JPEG images saved in the photobooth
images folder. The look of your booth can be customized simply by editing the screen JPEGs using an
image editor such as Photoshop Elements. The screen that is shown when the booth is ready to take
the next set of photos is called ready.jpg. Please see the section on images displayed to the user for
more details.
There are many other settings that can be adjusted. Please see the section on photobooth setup for
more information. There is a series of articles on our website which includes lots of useful information
about photobooth shooting and a section giving answers to frequently asked questions.

11.2

Print Layout Editor
The print layout editor can be displayed by clicking on the "Print layout" photobooth shortcut button in
the main window or by displaying the "Photobooth settings" dialog (File->Photobooth settings...) and
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clicking on the "Settings..." button to the right of the "Custom layout" checkbox.
Note: if the photobooth shortcut buttons aren't displayed in the main window you can display them by
selecting View->Photobooth Shortcuts

The right hand side of the window displays the print layout. Photos and captions can be edited
interactively by clicking on them using a mouse and then dragging to position, resize or rotate them.
The left hand area of the window contains controls to help with the layout and for loading and saving
settings:
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A Quick tour of the editor
This section gives a quick overview of some of the ways to edit the layout.
Click on the "Preset layouts..." button, select one of the preset layouts (e.g. "1 large, 3 small") and then
click on the "OK" button. The right hand side of the editor should show the page layout similar to the
screenshot above.
Left click the mouse on photo 2 to select it:
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The photo will be highlighted with a dashed red line to show that it has been selected. It will also have
a resize control in each corner and a dashed line in the center with a control for rotating the image.
Move the mouse over the center of the photo (a hand cursor will be displayed) and then click on hold
down the left mouse button and drag the photo to a new position and then release the left mouse
button. The keyboard cursor keys can also be used to adjust the position of the photo e.g. pressing the
left cursor key will move the photo one pixel to the left. Hold the shift key down and press one of the
cursor keys to move the photo 10 pixels in that direction.
Resize the photo by moving the mouse over one of the corners of the photo (a resize cursor will be
displayed) and then click on hold down the left mouse button and drag the corner to resize the photo
and then release the left mouse button.
Rotate the photo by moving the mouse over the control area at the end of the dashed line in the center
of the photo (a rotate cursor will be displayed) and then click on hold down the left mouse button and
move the mouse to rotate the photo and then release the left mouse button. The keyboard cursor left
and right keys can also be used to rotate the photo when the ctrl key is held down e.g. hold down the
ctrl key and press the left cursor key to rotate the photo 1/2 degree to the counter clockwise. Hold the
ctrl and shift keys down and press cursor left or right to snap the rotation to the nearest 15 degrees
and then rotate in 15 degree steps.
Select all the photos by typing Ctrl+A or by right clicking on a photo as selecting "Select all". The
selected photos will be highlighted with dashed red lines and can be dragged as a group by holding
down the left mouse button.
When a photo is selected it is also highlighted in the image position display in the top left corner of the
edit window. The size, position and rotation of the photo can be entered directly by clicking on the "..."
button for that image. Click on the dropdown list to change the photo number (or select "None" to
remove it or "QR code" set it to a QR code).
Add a caption by clicking on the "Edit captions..." button and the dialog below will be displayed:
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Check the "Enable caption" checkbox if it is not already checked. Caption 1 should now be displayed
highlighted on the print layout (if it isn't visible click on the "Move to center" button). Type in the edit box
to change the caption text or click on the "..." button to the right of the "Font:" label to change the font
or to the right of the "Font color:" display to change the color. Click on the "OK" button and the font
should remain highlighted. You can drag, resize and rotate the text using the mouse just the as with a
photo.
Click on the "Undo" button a few times (or type ctrl+Z) a few times to undo the changes. Then click on
the "Redo" button (or type ctrl+Y) to redo the changes.
Note: The dashed line around the layout shows the full printing extent of the printer including any
overlap over the edges of the paper for borderless printing. The inner solid line represents the area of
the final print.

Printer setup and margins
It is a good idea to check the printer settings and printer margins before designing the layout or
running the photobooth setup wizard. To do this click on the "Printer Setup..." button and the "Printer
Setup" dialog will be displayed:
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Select the required printer from the dropdown list. If your printer isn't listed you may need to install the
printer drivers first (please see the Windows help files or printer manuals for information on how to do
this).
Click on the "Setup Printer..." button to select the page size, print orientation, print resolution and other
printer settings.
Note: if you want to print a double strip of three or four images and are using a dyesub printer that can
cut 4"x6" pages into two 2"x6" strips you need to select the 2x6 cut option in the printer driver.
Click on the "Portrait" or "Landscape" radio buttons to change the printer page orientation.
If the selected printer is setup with a page size of 4"x6" and a print resolution of 300 DPI or 600 DPI
(most professional dyesub printers support this) the "Center page" button will be enabled. You can
press this button to setup the margins to center the page in the printable area. This should produce
correctly centered prints with most printers.
Click on the "Test Print" button to print a page to help setup the printer margins. The test print from a
DNP DS40 printer will look something like this:
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In the enlarged view of the top margin shown below the top margin can be read off the ruler as 14
pixels:

And in the enlarged view of the bottom margin shown below the bottom margin can be read off the
ruler as 26 pixels:
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Check the top, left, right and bottom margins and enter the values in the printer setup dialog, It is worth
spending time setting up the print margins accurately as this will save time later.

Preset Layouts
The "Preset layouts..." button can be used to help design a number of different popular layouts using
three or four photos. These include a double strip of three or four photos, a single strip of three or four
photos, one large image with a row of three smaller images below and two rows of two images. Simply
select the layout you want, adjust the page margins and image spacing and then press the OK button
and the software will work out the settings for you:

Select the preset layout from the list of layouts in the top left of the window. The right side of the
window shows a preview of the selected layout. The spacing between photos and the top, left, right
and bottom margins can be adjusted using the edit boxes on the left of the window.
Note: The dashed line around the layout shows the full printing extent of the printer including any
overlap over the edges of the paper for borderless printing. The inner solid line represents the area of
the final print.
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Click "OK" to copy the layout to the print layout editor.

Editing Photo Positions
A photo can be added to the layout by selecting the photo number from one of the spare image
dropboxes showing "None" in the top left corner of the editor window. Alternatively a photo can be
hidden by setting its dropdown list to "None".
The size, position and rotation of the photo can be edited by left clicking on the photo to select it and
then using the mouse or keyboard cursor keys:

Move the photo by moving the mouse to the center of the photo (a hand cursor will be displayed) then
hold down the left mouse button and drag the photo to the new position.
Tip: Hold down the shift key to limit the movement to a horizontal or vertical direction only.
Alternatively use the left, right, up and down cursor keys to move the photo one pixel at a time. Hold
down the shift key and use the cursor keys to move the photo 10 pixels at a time.
Resize the photo by moving the mouse to one of the circular control handles in the corners (the resize
cursor will be displayed) then hold down the left mouse button and drag the corner to resize the photo.
The aspect ratio of the photo will be preserved (i.e. the ratio of the width to the height). Hold down the
shift key if to resize the photo without preserving the aspect ratio (this may result in the photos being
cropped when they are printed).
Rotate the photo by moving the mouse to the circular control handle at the end of the red dashed line
in the center of the photo (the rotate cursor will be displayed) then hold down the left mouse button and
move the mouse to rotate the photo.
Alternatively hold down the ctrl key and use the left and right cursor keys to rotate the photo in 1/2
degree increments. Hold down the ctrl and shift keys and use the cursor left and right keys to rotate
the photo in 15 degree increments.
Photos are printed in the order in which they are defined and so if the second photo's position overlaps
the first photo the second photo will be printed on top of the first photo. You can change the order in
which photos are printed by right clicking on a photo and selecting "Move to back", "Move back",
"Move forward" or "Move to front".
You can also enter the photo position and angle directly by clicking on the "..." button for that photo on
the left side of the editor window and it will display the "Edit Position" dialog:
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You can also edit the position by right clicking on the photo and selecting "Edit image position..." from
the popup menu.
The left and top entries specify the distance in pixels of the photo from the left and top edges of the
page respectively. The layout in the print editor window will be updated automatically as you change
the settings. If the photo isn't visible you can press the "Move to center" button to center it on the page.
The width and height entries specify the width and height of the photo in pixels. To preserve the aspect
ratio of the photo you can enter 0 for the width or height and the software will replace this with the
correct value when you press the "OK" button.
Note: Entering a width and height with a different aspect ratio from the photos taken by the camera
(3:2) will result in the photo being cropped when it is printed.
The angle entry specifies the clockwise rotation of the photo in degrees.

Editing QR Codes
A QR code can be added to the layout by selecting "QR code" in one of the spare image dropboxes
showing "None" in the top left corner of the editor window. Alternatively the QR code can be hidden by
setting its dropdown list to "None". The size, position of the QR code can then be edited in exactly the
same way as a photo (described in the section headed "Editing Photo Positions" above).
The text encoded in the QR code can be edited by right clicking on the QR code and selecting "Edit
QR code..." from the popup menu. The "QR Code" dialog shown below will be displayed:
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Type in the text you want to be encoded in the QR code. Normally this is a URL which needs to be
prefixed with http://
The QR code display will be updated automatically as you type in the text. You can test the QR code
by pressing the "Test URL" button to open it in a web browser. You can also test the QR code by
scanning it with a cell phone.
The error correction dropdown list specifies amount of error correction encoded in the QR code. A
"Medium" setting should be suitable for most uses. You may wish to use the "Low" setting if the URL is
very long or the QR code is to be printed very small.
Note: The QR code text can also be edited by selecting File->Edit QR code from the main program
window.

Editing Caption Positions
Add a caption by clicking on the "Edit captions..." button and the dialog below will be displayed:
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You can also edit the caption by right clicking on the caption and selecting "Edit caption..." from the
popup menu.
Select the caption you wish to edit using the dropdown box at the top and then check the "Enable
caption" checkbox if it is not already checked. The caption should now be displayed highlighted on the
print layout (if it isn't visible click on the "Move to center" button). Type in the edit box to change the
caption text. Captions span more than one line and can contain tokens such as such as %d for the
date and %t for the time the sequence started, {comment} for the comments entered in the main
screen and {filename} for the filename used for the JPEG copy of the print layout. Please see the
section on tokens for a list of tokens available.
Click on the "..." button to the right of the "Font:" label to change the font, size and style or to the right
of the "Font color:" display to change the color.
Use the "Left offset" and "Top offset" entries to specify the position of the text. This is specified in
pixels from the top left corner of the page. Use the angle entry to specify the angle of the text. This is
specified as degrees rotation in a clockwise direction.
Normally text is left justified (the "Alignment" dropdown list is set to "Left justified") and its position on
the screen is measured from the top left corner of the text area.
If the "Alignment" dropdown list is set to "Centered" the text will be center justified and the position will
be measured from the top center of the text area.
If the "Alignment" dropdown list is set to "Right justified" the text will be right justified and the position
will be measured from the right side of the text area.
Click on the "OK" button to the save the changes. The caption will be selected in the print layout:

The size, position and rotation of the can then be edited using the mouse or keyboard cursor keys
similar to moving and resizing photos.
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Move the caption by moving the mouse to the center of the caption (a hand cursor will be displayed)
then hold down the left mouse button and drag the caption to the new position.
Tip: Hold down the shift key to limit the movement to a horizontal or vertical direction only.
Alternatively use the left, right, up and down cursor keys to move the caption one pixel at a time. Hold
down the shift key and use the cursor keys to move the caption 10 pixels at a time.
Resize the caption by moving the mouse to one of the circular control handles in the corners (the
resize cursor will be displayed) then hold down the left mouse button and drag the corner to resize the
caption.
Alternatively hold down the ctrl key and use the up and and down cursor keys to resize the caption.
Rotate the caption by moving the mouse to the circular control handle at the end of the red dashed line
in the center of the caption (the rotate cursor will be displayed) then hold down the left mouse button
and move the mouse to rotate the caption.
Alternatively hold down the ctrl key and use the left and right cursor keys to rotate the caption in 1/2
degree increments. Hold down the ctrl and shift keys and use the cursor left and right keys to rotate
the caption in 15 degree increments.

Aligning, sizing and moving multiple items
All the currently defined photos, captions and QR codes can be selected by typing ctrl+A (or by right
clicking and selecting "Select all"). Alternatively just photos can be selected by typing Ctrl+P (or by
right clicking and selecting "Select all photos"). You can refine the selection by holding down the ctrl
key and clicking on the item to be added or removed from the selection.
Tip: All captions can be selected by typing Ctrl+P to select all photos followed by Ctrl+I to invert the
selection (this will unselect all photos and select all captions).
A group of selected images can be moved by holding down the left mouse button and dragging them
to the new position or by using the keyboard cursor keys.
There are various options for aligning a group of selected items e.g. left align so that a group of
images are arranged in a column. To align the currently selected elements right click the mouse on the
reference element and select the required alignment from the "Alignment" menu of the popup menu.
The selected elements will be moved to align them with the reference element.
Note: If this doesn't produce the required result simply type ctrl+Z to undo the changes.
A group of photos can be spaced evenly by selecting them in order and then right click on any of the
selected images and select "Space photos evenly". The order in which the photos are selected is
important because the middle photos will be spaced evenly between the positions of the first and last
photos in the selection. To select the photos in the right order simply left click on the first photo and
then add the remaining photos to the selection in order by holding down the ctrl key and clicking on
them.
A group of photos can be set to the same size and angle as a reference photo by selecting them and
then right clicking on the reference photo and selecting "Make photos same size and angle".

Background Color and background.jpg
Normally the page background is white but it can be set to any color by clicking on the "..." button next
to the colored square besides the "Show background color" checkbox.
A JPEG image named background.jpg can also be used as a background. This is useful for adding
logos or fancy captions to the print or to add frames around the photos. Ideally the background.jpg
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should be the same size in pixels as the printed output (e.g. 1844 x 1240 pixels for a 6"x4" print from a
DNP DS40 printer). The background.jpg will be centered on the page and so if it is bigger the excess
will be cropped from the top, left, right and bottom or if it is smaller it won't fill the page.
Tip: Set the background color to the same color as the edges of the background.jpg to avoid white
strips on the edges of the page if the background.jpg doesn't fill it.
The background.jpg should be saved in your photobooth images folder (this is displayed in the title bar
of the print layout editor window). You can copy a JPEG image into your photobooth images folder by
clicking on the "Import background..." button.
To delete a background.jpg image first press the "OK" button to save the print layout and close the
print layout editor window. Then delete the background.jpg from your photobooth images folder.
Note: If the positions of photos and captions don't quite line up with an imported background.jpg they
can be moved by typing ctrl+A (to select all) and then pressing the cursor keys.

Headers and footers
For backwards compatibility with previous releases the print layout can also display a header image
named header.jpg at the top of the page and a footer image named footer.jpg at the bottom of the
page. It is recommended that you avoid using headers and footers and use the background.jpg
instead. This will make it easier save layouts for future reference without them being specific to a
particular printer model.

Overlay
An option overlay can be placed over the photos by placing an PNG image named overlay.png in your
photobooth images folder. You can copy a PNG image into your photobooth images folder by clicking
on the "Import overlay..." button.
The overlay.png should be saved as a 24-bit color PNG file with an 8-bit alpha channel containing
transparency information.
To delete an overlay.png image first press the "OK" button to save the print layout and close the print
layout editor window. Then delete the overlay.png from your photobooth images folder.
Please see the section headed "How to create PNG images using Photoshop" for notes on how to
create an overlay.png file.
There is an example PNG file named example_overlay.png in the installation folder which can be used
for testing.
Tip: The current layout can be saved as a JPEG file by holding down the Shift and Ctrl keys and then
clicking on the "Print Test Page" button. This JPEG image can then be loaded into a photo editor such
as Photoshop to add logos, captions etc. and then saved as a background.jpg or overlay.png image
which can be imported into the layout.

Hiding and showing elements
Use the various "Show" checkboxes to control what is displayed in the print layout preview. This is
useful if you want to simplify the preview display to make it easier to adjust the photo positions.
Please note: Unchecking the "Show" checkbox for an element only affects the print layout preview
and does not affect the final prints.
© 2016 Breeze Systems Ltd

52

NKRemote

Undo and Redo
Most actions can be undone by clicking on the "Undo" button or by typing ctrl+Z and redone by clicking
on the "Redo" button or typing ctrl+Y.
You can't undo the "Printer setup", "Import background...", "Import overlay..." or "Import layout..."
actions.

Exporting and importing layouts
You can save a print layout for future reference by clicking on the "Export layout..." button. This will
save the entire layout including any overlay and background images to a single file with a .pblt file
extension.
A previously saved layout can be imported by clicking on the "Import layout..." button. It should be
possible to import layouts defined for any similar printer (i.e. one with the same page size and print
resolution) provided the print margins were set accurately.
Please note: If your photobooth images folder contains a background.jpg or overlay.png image they
will be deleted or overwritten when importing a print layout.

11.3

Advanced Photobooth Setup
This section gives detailed information about the various photobooth settings. If you want to get started
as quickly as possible you can use the photobooth setup wizard to set everything up and then come
back to this page later to find out more about tweaking the various settings.

Setting up the page layout
To setup photobooth operation select "Photobooth Settings..." from the File menu and the dialog below
will be displayed:
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First select the number of images to be taken and how they are arranged. This could be a single
image on one sheet of paper (1 image, 1 row, 1 column), a passport style strip of images (e.g. 4
images, 4 rows, 1 column), 2x2 grid of 4 images as shown above or any other arrangement of up to 20
images arranged in a grid. Alternatively select "Custom layout" and click on the "Settings..." button next
to the checkbox to position each image manually on the page (this is described in more detail later).
Using live view for long periods of time drains battery power and can cause the camera's sensor to
heat up. Most camera models will automatically cancel live view after 30 minutes to prevent
overheating. Fullscreen photobooth mode has an inactivity timer which will automatically cancel and
restart live view after 25 minutes to prevent the camera from canceling it. Alternatively full screen
photobooth mode can automatically cancel live view and display the welcome.jpg screen image if the
photobooth is not used for a preset time. Live view can also be canceled manually by pressing the F6
function key. Press the F6 function key to reactivate live view and return to ready.jpg screen when the
welcome.jpg screen is displayed. The inactivity timeout can be enabled by setting the "Inactivity in
secs" value to the required number of seconds e.g. 120.
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Next select the delay before taking each photo and how long the shot just taken is displayed on screen
when shooting in fullscreen photobooth mode (this can be disabled by setting the time to 0). After
taking each photo a preview can be displayed on the screen for a specified number of seconds (set
this to 0 to disable the preview). The delay before taking the first photo can be set to a different value
than that for the remaining photos. This is useful when using a touchscreen as it means a longer delay
can be set before the first photo to give people time to move back from the touchscreen.
When the "Minimum duration in seconds before closing 'processing' screen is set to 0 the 'processing'
screen will be close as soon as the data has been sent to the printer. The 'processing' screen can be
displayed for longer by adjusting this value. This is useful if you want to keep displaying a message
such as "Thank you! Your photos are being printed, please leave the booth now" for longer than it
takes to print the images.
The countdown text is displayed before shooting each image and is updated every seconds. The
following tokens can be used:
@imageNumber@ - the shot number in the photobooth sequence
@numberOfImages@ - the number of images in the photobooth seconds
@secsToNextPhoto@ - the number of seconds until the next photo in the sequence is taken
Select "Enable live view for fullscreen photobooth shooting" to display live view images in the
fullscreen photobooth shooting mode. The live view image can be mirrored so that the user sees the
image the same way round as when looking in a mirror. Use the height setting to resize the live view
image up to its (camera dependent maximum setting). The live view image can be displayed in portrait
orientation by selecting one of the portrait orientations from the View menu in the main window.
Select the "Auto standby" option to have the booth automatically switch to standby mode at startup and
after each set of photos. This option is useful because it automatically disables live view when the
booth is not in use which will avoid problems with the camera's sensor overheating. In standby mode
the booth displays the welcome.jpg screen image. You can switch back to ready mode by typing F6
(toggle between standby and ready modes) or Ctrl+Alt+F6 (switch from standby to ready mode) or by
using the "Toggle standby mode" or "Switch from standby to ready" touchscreen actions.
By default the live view images are displayed centered at the top of the screen with the count down text
beneath. The position of the live view images can be adjusted using the "Left offset" and "Top offset"
settings. These specify the offset in pixels from the left and top of the screen respectively. If the left
offset is set to -1 the live view display will be centered horizontally on the screen.
If the count down text offset is set to 0 the count down text is automatically displayed centered in the
spare space above or below the live view images (depending on whether there is more space above or
below the live view images). Please make sure there is enough space for the count down text when
setting the live view size and position.
Alternatively the countdown text can be manually positioned on the screen by setting the offset to a
non-zero value. This value is the number of pixels the text is offset from the top of the screen. If
required, the countdown text can be positioned so that it overlays the live view images.
The live view display can be cropped if required by selecting fullscreen photobooth mode and holding
down the Shift key and using the cursor left and right keys to increase or decrease the cropping.
Cropping removes equal amounts from the left and right of the live view image when displaying live
view images in landscape orientation and from the top and bottom when using portrait orientation.
When adjusting the live view cropping a status message showing the amount of cropping is shown
briefly in the bottom right hand corner of the screen.
Normally the live view display, if enabled, is shown before each image in the sequence is taken. When
the "Only display Live View images for the first shot in the sequence" option is selected live view
images are only displayed to the user before taking the first shot of the sequence and are hidden
during the rest of the sequence. If the "Only display live view in ready screen" option is selected the live
view is shown in the ready screen and is hidden when the user starts the shooting sequence.
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The live view display can be disabled during printing by selecting the "Disable live view when printing"
checkbox. Disabling the live view during printing and displaying a suitable message in the 'processing'
screen is a good way of encouraging people to leave the booth after the photos have been taken. For
example you could disable live view during printing, set the minimum duration before closing the
'processing' screen to 15 secs and display the message "Thank you! Your photos are being printed
and will be ready outside shortly, please leave the booth now" by editing the 'processing screen
(processing.jpg).
Bright live view/AF mode
Recent Nikon cameras may display dark live view images in photobooth mode when using aperture
priority or manual exposure modes. This is because they stop down the lens to the selected aperture
in live view and there may not be enough light to provide bright images. The "Bright live view/AF mode"
option avoids this problem by selecting the lens's maximum aperture in live view and only switching to
the selected aperture when actually taking the photos. This may cause a slightly longer than usual
delay at the end of the countdown before taking the photo.
A side effect of bright live view/AF mode is that the camera will attempt to auto focus before taking
each photo. Auto focus can be useful if people are likely to stand at different distances from the
camera but it can also cause problems if the auto focus can't focus properly. Please note that if the
camera's auto focus system is unable to focus properly the camera will not take the photo and an error
message asking you to stand farther from the camera will be displayed for 5 secs before retaking the
photo. Please set the camera to manual focus if you do not wish to use auto focus. The camera's AF
mode should be set to AF-A or AF-S in order to use AF. If it is set to AF-C the camera will take the
photo immediately without attempting to auto focus.
Clicker mode allows users or a photographer to choose when to take each photo rather than the
standard operation where the software automatically takes the photos at preset intervals. When clicker
mode is selected the software will wait until each photo is taken either by typing Ctrl+Z on the keyboard
or a by using a wireless remote (e.g. a wireless presenter) connected to the PC. The wireless remote
should be set up to send Ctrl+Z. The shooting sequence in clicker mode is:
1. The ready.jpg screen and live view displayed as normal until the start button is pressed (e.g. by
pressing F4)
2. When the start button is pressed the 1.jpg screen will be displayed with no countdown text and the
software will wait until a photo is taken by typing Ctrl+Z on the computer.
3. After each photo is taken a preview is displayed on the screen if enabled in the photobooth settings
and then the screen for the next photo is displayed e.g. 2.jpg
4. After the last photo has been taken the processing.jpg screen will be displayed and the photos
printed as normal
Please note: Unlike the Canon version of our photobooth software (DSLR Remote Pro for Windows) it
isn't possible to take photos in clicker mode by pressing the shutter release on the camera. This is
because Nikon disable all the camera controls on their cameras when live view is active and the
camera is tethered to a computer.
Output Settings
Click on the "Settings..." button to the right of the output options to display the output settings dialog
which allows you to configure the print preview and how JPEG copies of the printed output are
handled:
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The "Output:" drop down list allows you to specify whether photos are printed only, printed with a JPEG
copy of the layout saved in "prints" sub folder, a JPEG copy of the layout is saved in the "prints" sub
folder without printing or no output action is taken. (This is the same as the "Output:" drop down list
displayed in the main photobooth settings dialog).
Select "Display thumbnails" to display a small thumbnail of each photo. The thumbnails can be
arranged vertically down one side of the screen or horizontally across the top or bottom of the screen.
Click on the "Settings..." button to
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The left offset specifies the distance in pixels of the first thumbnail from the left edge of the screen. If a
negative value is specified the distance will be measured from the right edge of the screen e.g. and
value of -1 will place the first thumbnail on the right of the screen. The top offset specifies the distance
in pixels of the first thumbnail from the top edge of the screen. If a negative value is specified the
distance will be measured from the bottom edge of the screen e.g. and value of -1 will place the first
thumbnail on the bottom of the screen.
The thumbnail width specifies the width of the thumbnail in pixels (the height of the image will be
calculated automatically using the aspect ratio of the photo).
The horizontal and vertical spacings specify the positions of the remaining thumbnails relative to the
first thumbnail. The settings in the screenshot above will place four thumbnails 240 pixels wide across
the bottom of the screen and will be centered horizontally if the screen resolution is 1366 x 768.
The default setting is to only display thumbnails during the photo booth countdowns when taking the
photos and not to show them at the end of the shooting sequence on the processing or printing
confirmed screens. Select the "Display thumbnails on processing and printing confirmed screens" if
you also want the thumbnails to be displayed at the end of the shooting sequence when the processing
or printing confirmed screens are displayed.
The "Delay before creating print layout (secs):" setting is normally set to 0 so that photos are printed as
soon as possible. This setting is useful if the photos need to be modified by another program (e.g. by
running a Photoshop droplet to edit the photos or using a green screen program to create high quality
green screen photos) before they are printed by NKRemote. Please see the section on "Modifying
Photos Before Printing" for information on how to use this option.
Select the "Sign or draw on photos before printing" option if you want to allow users to draw on the
print layout before it is printed. This option is useful for letting users sign their photos when running a
magic mirror photo booth with a touchscreen. Please see the section on "Signing or Drawing on the
Prints" for more information on using this setting.
Select "Display print preview and wait for confirmation before printing" in the "Output Settings" dialog if
you want to be able to decide whether to print the images or not (this is the same as the "Confirm
before printing" checkbox displayed in the main photo booth settings dialog). When this option is
selected the print layout will be displayed on the screen with "Print" and "Cancel" buttons in the top left
hand corner. Users should click on the "Print" button (or press the Enter key or A key) to print the
images or click on the "Cancel" button (or press the Esc or key or X key) to continue without printing.
Users can also press the P key (or tap on the "Confirm printing (no JPEG copy)" touchscreen action)
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to print without copying the JPEG copy of the printed output to a separate folder. This is useful if you
want to offer users the choice of printing only or printing and copying the output to a separate folder (e.
g. copying to a folder on another computer running Breeze Kiosk).
If the touchscreen input mode is selected and touchscreen actions for confirm or cancel printing are
defined the "Print" and "Cancel" buttons will not be displayed. The touchscreen sensitive areas can be
displayed using the confirm_printing.jpg screen image.
If a confirm_printing.jpg screen image is in the photo booth images folder this will be used for the
background to the print confirmation window to allow instructions or touchscreen buttons to be
displayed.
If a printing_confirmed.jpg screen image is in the photo booth images folder this will be displayed if the
user selects printing. This allows the processing.jpg screen to show a message like "Processing,
please wait..." and the printing_confirmed.jpg to display a message like "Thank you, please leave the
booth now. Your photos are being printed outside."
Please note that if the "Sign or draw on photos before printing" option is selected the drawing screen
can be used to accept or reject the photos and to select the number of copies to print. In most cases
the print confirmation screen is not required if the "Sign or draw on photos before printing" option is
used.
Click on the "Preview size and position..." to specify how the print preview image should be displayed:

The print preview can be cropped by enabling "Crop print preview" and specifying the top left corner
and the width and height of the cropped area (these settings are in pixels). This is useful when printing
double strips where two 2"x6" strips are printed on a single sheet of 4"x6" paper and automatically cut
into two 2"x6" strips by the printer. The print preview would normally show the whole 4"x6" print with
the two strips side by side, but by cropping the print preview just one strip can be displayed. For
example a typical dyesub printer prints at 300 dpi giving a print size of 1200x1800 pixels when printing
4"x6" media in portrait orientation. This can be cropped so that only the left half of the strip is displayed
in the print preview by setting left=0, top=0, width=600, height=1800.
The print preview can be rotated by 90 degrees CW, 90 degrees CCW or 180 degrees using the
rotation setting. Normally this can be set to "None". If the print preview is displayed on its side it
probably means that the page orientation is set incorrectly in the printer settings. The rotation setting
can be used to compensate for this, but it would be better to change the page orientation setting in the
printer settings and update the print layout.
The size and position of the print preview can be set print preview offset, width and height settings. If
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these are all set to zero the print preview will be sized to fill the window and will be centered on the
screen. The print preview can be moved on the screen, e.g. to make space for the print confirmation
buttons, using the left and top offset settings. For example to leave a space 200 pixels wide on the left
of the screen set the print preview left offset to 200. If the print preview width and height settings are
set to 0 the print preview will be resized to fill the rest of the screen. Set the print preview width and
height settings to values other than 0 to specify the size of the print preview image.
Use the "Timeout (secs):" to specify a timeout for how long the print preview should be displayed (the
default timeout is 300 secs). Set the timeout action dropdown list to the action that should be
performed when the timeout occurs (the default setting is to cancel the print).
Use the sharing options to enable the sharing of photos by uploading to the user's own Facebook
page, Tweeting, texting (MMS or SMS) or by sending photos email. Please see the section on
uploading to social networks for information on how to set this up.
Select the "Share animated GIFs" to enable the sharing of animated GIFs by email, Facebook, Twitter
or texting. When sharing animated GIFs on Facebook the GIFs are hosted on www.giphy.com
Please note: When sharing animated GIFs please note that the files can be large and so it is best to
keep the image size small to avoid excessively large files for sharing. This can result in the animated
GIF appearing very small in the sharing screen. The preview can be made large by increasing the
"Max percentage upscaling setting" e.g. set this to 200 to display the animated GIF 2x normal size or
300 for 3x normal size.
Select the "Printing" option to give users the option to print photos in the sharing screen. Users can
print the photos by typing P or by using the "Sharing: Print photos" touchscreen action. Photos can be
printed if the output is set to "Print and save JPEG copy" or "JPEG copy only". The share_printing.jpg
screen is displayed for a minimum of 5 seconds each time the user selects printing from the sharing
screen. The number of prints that can be made from the sharing screen can be limited by clicking on
the "Settings..." button:

Set the "Number of prints allowed" to the maximum number of prints allowed or to 0 if there is not limit.
Then enter the message that is displayed if the user tries to print more copies than is allowed.
If the user prints the photos one or more times from the sharing screen the photos additional copies
won't be printed if the output is set to "Print and save JPEG copy". If the user doesn't print the photos
from the sharing screen and the output is set to "Print and save JPEG copy" the photos will be printed
when the sharing screen is closed using the currently selected number of print copies.
By default the sharing screen shows a print preview image centered on the screen with a height of no
more than 2/3 the height of the screen. This setting can be overridden by setting the preview left, top,
right and bottom settings to non-zero values. The left value is the offset in pixels from the left edge of
the screen. The top value is the offset in pixels from the top edge of the screen. The width and height
values specify the maximum width of the preview image in pixels.
Select the "Create animated GIF of photos" option to created an animated GIF of the photos taken
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with an optional overlay and title page.
Please see the Animated GIF section for details on how to set up animated GIFs in stills photo booth
mode and in video mode.
When the output option is set to "Print and save JPEG copy" or "JPEG copy only" the filename of the
JPEG copy of the printed output can be specified using the "Filename for JPEG copy of output:" edit
box. This value can use tokens to specify values which are determined at run time e.g. %d represents
the date and %t the time. Please see the section on tokens for a list of available tokens. The JPEG
copy of the printed output is an exact copy of what is sent to the printer and can be used for reprints
after an event.
An optional second copy of the printed output can be saved in a different folder by selecting the "Copy
JPEG copy of printed output to folder:" option. Click on the "Settings..." button to display the "Copy
JPEG Settings" dialog:

You can specify the folder where the additional copy of the printed output is saved using the "Folder:"
edit box. If this is left empty the JPEG will be saved in a sub folder named "copy". You can also enter
the full pathname of the folder where the images should be copied to (e.g. "C:\Print copies") or the
name of a different sub folder (e.g. "Backup"). The folder name can also use tokens to specify values
which are determined at run time. The second copy of the print output can also be cropped, resized
and rotated before it is saved.
Photobooth Start options
The following start options are available:
"Keyboard only (ignore This is the default setting where the photobooth sequence can be started
mouse or touchscreen using the normal keyboard shortcuts e.g. F4
clicks)"
"Left click anywhere to This setting allows a mouse or a touchscreen to start the photobooth
sequence. The user simply needs to click the left mouse button or press
start"
anywhere on the display if using a touchscreen
"Left click to start, right This setting allows a standard mouse to be used to start the sequence (left
click) or to toggle between B&W and color modes (right click)
click to toggle B&W
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This setting is designed for touchscreens and requires the user to click in
the top left fifth of the screen to start the sequence. The ready.jpg image
should be edited to show the user where to touch the screen to start the
sequence.
This setting is designed for touchscreens and requires the user to click in
the top left fifth of the screen to start the sequence in color and the bottom
left fifth to start it in black and white. The ready.jpg image should be edited
to show the user which areas to touch to start the sequence.
This setting allows up to 10 areas on a touchscreen to be given different
actions (described in more detail below)

Touchscreen Settings
Up to 18 areas can be defined on a touchscreen to control different photo booth settings such as
starting the sequence, switching between color and B&W, selecting the number of print copies etc.
First select the "Touchscreen" option in the "Start options" dropdown list and then click on the
"Settings..." button to display the touchscreen settings dialog:
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Select the action using the dropdown lists on the left and the area on the touchscreen that activates
the action using the corresponding "Left", "Top", "Right" and "Bottom" edit boxes. The values entered
in the edit boxes are the screen coordinates in pixels with the origin in the top left corner. The example
in the screenshot above defines three sensitive areas on the touchscreen:
1. A square area 300x300 pixels in the top left corner of the screen which starts the photobooth
sequence (action is set to "Start")
2. A smaller rectangular area 300x150 pixels in size located below the first area which selects B&W
mode
3. A second area similar to item 2 which selects color mode
Touchscreen actions can also be viewed or edited interactively using a mouse by clicking on the
"Show/edit touchscreen areas..." button. When the touchscreen action editor is first opened it will
display the ready.jpg screen and the touchscreen actions for as boxes with white outlines and green
text indicating the action. The action can be moved by clicking in the box and moving the mouse with
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the left button held down. The size of the box can be adjusted by dragging the corners with the left
mouse button held down. Touchscreen actions can be deleted by right clicking on the action and
selecting "Delete action" from the menu. New actions added by right clicking the mouse and selecting
the "Add action...". Different screens can be displayed by right clicking the mouse and selecting the
required screen.
Exit the touchscreen action editor by pressing the escape key or by right clicking the mouse and
selecting "Exit" from the menu. If the touchsrceen actions have been modified a confirmation dialog
will be displayed asking you if you want to save the changes.
Please note: the touchscreen action editor only edits the positions of the touchscreen actions. It
doesn't edit the JPEG screen images which display the graphics for the touchscreen buttons - to do
this you need to use an image editor such as Photoshop Elements.
An optional password can be used to protect the "Exit fullscreen photobooth" action by entering the
password in the "Photo booth exit action password" field. Many photo booth operators define a secret
touchscreen action on the screen to exit photo booth mode which can cause problems if users find it
because it will allow them to break out of full screen photo booth mode. Using a password to protect
this should prevent problems if users manage to find the secret exit photo booth mode touchscreen
action.
An optional touchscreen keyboard can be displayed at the start or end of the photo booth shooting
sequence to allow users to enter information such as their email address. This information is stored in
the XML file saved after each shooting sequence. Use the dropdown list to select when the
touchscreen keyboard should be displayed and the "Test keyboard..." button to test it. The "Timeout
(secs):" value allows a timeout for the keyboard to be specified. If the user does not touch the
touchscreen before the timeout the touchscreen keyboard will be automatically closed.
Please see the section describing the touchscreen keyboard for more details.
Saving settings for future reference and using profiles
Settings can be saved to file for future reference by pressing the "Save..." button and reloaded by
pressing the "Load..." button. This is makes it possible to define a number of different layouts which
can be selected before entering fullscreen photobooth mode. Please note that layout depends on the
size of the page which is affected by the printer settings. The values saved for one setup may not
produce the same results if a different printer is used or the page or resolution settings have changed.
The image download directory specified in preferences is not saved with the photobooth settings, but
you can use the tokens {photoboothDir} and {photoboothSubdir} to specify a different output directory
for each profile.
{photoboothDir} gives the full path of the photobooth images folder e.g. C:
\Photobooth\Layouts\MyLayout
{photoboothSubdir} gives the name of the photobooth subfolder e.g. if the photobooth images folder is
C:\Photobooth\Layouts\MyLayout then {photoboothSubdir} would become MyLayout
For example:
strips_profile: outputs standard photobooth strips to the default printer and uses C:
\Photobooth\Layouts\strips as its photobooth images dir
cubes_profile: takes four photos with the output set to 'none' and uses C:\Photobooth\Layouts\cubes
as its photobooth images dir. Its output directory is then monitored by the Hot Folder Prints utility which
formats the images as a photo cube and sends them to a different printer.
To make this work the download directory in preferences could be set to C:
\Photobooth\Output\{photoboothSubdir}. This would save images from the strips_profile to C:
\Photobooth\Output\strips and the cubes_profile to C:\Photobooth\Output\cubes. The Hot Folder Prints
utility could then be setup to monitor the C:\Photobooth\Output\cubes folder for images and print them
out automatically when the required number of images are available.
Profiles allow you to use a keyboard shortcut (or touchscreen action) to automatically switch between
different sets of saved settings. To assign a profile to a keyboard shortcut click on the "Profiles..."
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button at the bottom of the photobooth settings dialog to display the following dialog:

Then click on "..." button for the appropriate profile and select a previously saved set of photobooth
settings. In the screenshot above profile 1 (keyboard shortcut SHIFT+CTRL+1) loads the settings file
photobooth_settings1.xml and profile 2 (keyboard shortcut SHIFT+CTRL+2) loads the settings file
photobooth_settings2.xml. Profiles can be used to allow users to selects different sets of photobooth
settings e.g. profile 1 might be a traditional layout of two columns of four images and profile 2 might be
a custom layout with one large image and several smaller ones. Profiles can be selected using the
touchscreen actions (described above) allowing a user to easily switch between different settings.
The tokens {photoboothDir} and {photoboothSubDir} can be used to specify the pathname of the
profile file to be loaded. The tokens are replaced with the value of current photobooth images folder
and provide a way to use more than 8 profiles.
The default profile setting can be used to ensure the photobooth starts up in a known state and is reset
to a known state at the end of each photobooth shooting sequence e.g. setting the photobooth to stills
mode, color photos and one set of prints.

Print layout
The recommended method for creating a print layout is to use the print layout editor and one of the
preset print layouts. The automatic print layout method described below as been retained for
compatibility with older versions of NKRemote. The automatic print layout option is used if the "Custom
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layout" checkbox is not selected and the options can be accessed by clicking on the "Print layout.."
button:

The print can have an optional background with a header and or footer image. When NKRemote
prepares the image for printing it looks for the following files in the photo booth images folder:
background.jpg - optional image which is tiled to fill the background of the printed page
header.jpg - optional image which is centered and placed at the top of the page
footer.jpg - optional image which is centered and placed at the bottom of the page
left.jpg - optional image which is centered vertically and placed on the left of the page between the
header and footer
right.jpg - optional image which is centered vertically and placed on the right of the page between the
header and footer
middle.jpg - optional image which is centered vertically and placed between each column of images
overlay.png - optional image which is overlays the page and uses transparency information stored in
the alpha channel
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The images are then arranged in a grid which fills the printable area of the page less any space taken
up by a header or footer image. If the "Rotate image to maximize size" checkbox is selected the
images are rotated through 90 degrees if this would give a larger image. e.g. if the printable area for
the image within the grid is 80mm high and 50mm wide and the image was shot in landscape
orientation it would be rotated by 90 degrees to better fill the printable area.
If the number of images matches the number of rows the images can be repeated in each column by
selecting "Repeat images to fill empty columns". This is useful when printing strips of images on paper
from a dye sublimation printer e.g. two copies of 4x1 strips on a sheet of 8x6 paper.
The easiest way to see how this all fits together is to run NKRemote and take some test shots. First
setup the printer settings by selecting "Printer Setup..." from the File menu and then set basic
photobooth settings using the setup dialog. The take a test sequence by pressing Shift+F4 or selecting
"Photobooth Test Shot" from the File menu. This will take a sequence of images and create a test
page which is saved as photobooth_test_shot.jpg. Load this image into an image editor (or
BreezeBrowser Pro) to view the layout. Then make any changes to the background.jpg, header.jpg,
footer.jpg or overlay.png images and the photobooth settings and take more test shots until you're
happy with the layout.
Some example layouts using four shots arranged in two columns of four:
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With left.jpg down the left border, middle.jpg placed between the columns, right.jpg down the right
border and footer.jpg at the bottom
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Same layout as the first example but with no left.jpg or right.jpg images defining the left and right
borders
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Same layout as the previous example but with no middle.jpg image placed between the columns

© 2016 Breeze Systems Ltd

69

70

NKRemote

Same layout as the previous example but with a 2mm border around each image
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A custom layout where the size and position of each photo is specified individually
Other output options
The images can be sharpened by selecting the "Sharpen images" checkbox and specifying a
sharpening amount in the range 0 to 100. The amount of sharpening required depends on personal
taste, the camera and the printer. A value of around 75 is a good starting point.
If the "Crop image if required to fit the printable area" checkbox is selected the image will be cropped
to fill the printable area within the grid. e.g. if the printable area within the grid is square equal portions
of the left and right of the image will be cropped to make it square.
Photos can be printed in color, pure black and white or toned black and white by selecting the
appropriate option from the dropdown list headed "Print photos:". You can also switch between these
options when the software is running in fullscreen photobooth mode by using the following keyboard
shortcuts: Ctrl+C to select color, Ctrl+B to select black and white, Ctrl+T to select toning, Ctrl+W to
toggle between color and B&W and W to cycle through color, B&W and toning.
When the "toned" option is selected the hue and saturation settings can be adjusted when the software
is running in fullscreen photobooth mode by using the following keyboard shortcuts: Ctrl+cursor left/
Ctrl+right to adjust the hue and Ctrl+cursor up/Ctrl+down to adjust the saturation. A status message
showing the current settings is briefly displayed in the bottom right hand corner of the display when
adjusting the hue and saturation in fullscreen photobooth mode. Setting the B&W toning hue to 200
and the saturation to 40 is a good starting point for sepia toned prints.
Captions
Up to 12 captions can be added by selecting the "Edit captions..." button:
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To enable a caption select it from the "Edit:" drop down list. Then check the "Enable caption" checkbox
to enable the caption or uncheck it to disable the caption.
Each caption can occupy more than one line if required and is left justified by default. Select the
"Center justify" checkbox to center justify multiple lines. The size, font, color and rotation (in degrees
clockwise) of the caption text can also be specified. The font size is calculated using the printer
resolution and so a 72 point font should give text one inch high (one 'point' is 1/72 of an inch). The
caption is printed in the selected font color with a transparent background. Tokens can be used in the
caption text to insert values such as %d for the date and %t for the time the sequence started,
{comment} for the comments entered in the main screen and {filename} for the filename used for the
JPEG copy of the print layout. Please see the section on tokens for a list of tokens available.
Enter the position for the captions as offsets in pixels from the top and the left of the page.

Applying effects to images before printing
You can use the editor command to run a command or script on each image after it has been
downloaded. This could be used to run a Photoshop droplet to modify the image. You may need to add
a delay to allow time for the droplet to finish before the images are printed. This can be done by setting
the following DWORD value in the Windows registry:
HKEY_CURRENT_USER\Software\BreezeSystems\NKRemote\100
\PhotoboothDelayBeforePrintingInSecs
The delay can be cut short by typing Ctrl+Z. This is useful if a script is used to post process the images
because the delay can be minimized if the script sends Ctrl+Z after processing the images.
Please see the section on "Modifying Photos Before Printing" for more details.

Images displayed to the user
If full screen mode is selected (by pressing F11 or Ctrl+F4 to enter full screen mode and display the
ready image) a series of images can be displayed to the user to show them what's happening and to
advertise the photobooth. These images are held in the same folder as the background, header and
footer images and are as follows:
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ready.jpg - image displayed when NKRemote is ready to take the next set of photos
1.jpg, 2.jpg etc. - image displayed before taking the first, second, third etc. images together with the
text specified in the setting dialog
taking.jpg - image displayed for approximately 1 sec before taking each shot
processing.jpg - image displayed after taking the photos while NKRemote formats and sends the page
to the printer
camera_not_connected.jpg - image displayed when the camera is turned off or disconnected
welcome.jpg - image displayed when the inactivity timer has canceled live view or standby mode has
been selected by pressing F6
confirm_printing.jpg - optional background image when displaying print confirmation screen
printing_confirmed.jpg - optional image displayed if user selects printing from the print confirmation
screen
keyboard_input_ok.jpg - image displayed if user selects 'ok' from the on screen keyboard after the
photos have been taken
keyboard_input_cancel.jpg - image displayed if user selects 'cancel' from the on screen keyboard after
the photos have been taken
These images can be JPEGs containing any information you like and are displayed centered on the
display with a black background. The images 1.jpg, 2.jpg etc are displayed together with the text
defined in the settings dialog which can be used to give a count down timer before each picture. The
text is displayed centered on the screen below the live view display, if applicable, as white text on a
transparent background. The following tokens can be used in the text:
@imageNumber@ - the number of the image in the sequence starting from 1
@numberOfImages@ - the number of images in the sequence
@secsToNextPhoto@ - the number of seconds until the next photo is taken
The images displayed to the user should be the same size or bigger than the computer's display. If the
images are too small they will be expanded to fit with a black border and a small warning message will
be displayed in the bottom left corner showing the image size and the display size.
When using live view in photobooth mode the live view images will not be updated while the camera is
actually taking each picture. This will cause the live view display to freeze for a couple of seconds and
can confuse some users as it shows the live view just before the picture is taken and this will be
slightly different from the actual photo. To avoid this problem the live view display will be blanked out
when the photo is taken if you define a release.jpg image.
It is also possible to display different screens depending on whether color, black and white or
monochrome toned mode is selected and the number of print copies. This provides a way of giving
feedback to the user when different settings have been selected.
The way it works is to check for a suffix after the filename for the appropriate screen image in the form
<screen>_<b|c|t><1..9>.jpg where <screen> is the name of the screen image e.g. "ready", <b|c|t> is
the color mode: "b" for black and white, "c" for color or "t" for monochrome toned and <1..9> is the
number of print copies e.g. "1" is one copy is selected.
For example when the ready.jpg image is to be displayed, the color mode is set to black and white and
the number of print copies is set to 2 the software will look for a suitable screen image in the following
order:
ready_b2.jpg - i.e. "ready" + black and white + 2 copies selected or if this isn't found it looks for:
ready_b.jpg - i.e. "ready" + black and white or if this isn't found it looks for:
ready_2.jpg - i.e. "ready" + 2 copies selected or if this isn't found it looks for:
ready.jpg
So to have screens to indicate the color mode and the number of print copies from 1 to 3 you need the
following "ready" screens: ready_c1.jpg, ready_c2.jpg, ready_c3.jpg, ready_b1.jpg, ready_b2.jpg,
ready_b3.jpg.
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When a setting is changed, e.g. the color mode is set to black and white, the screen image is updated
automatically to show the user the current status.

Using movie files to animate screens
Movie files can be displayed on the screens by placing a movie file in MP4 or QuickTime MOV format
in the photobooth images folder and giving it the same name as the screen image. For example, to
play an MP4 movie file when the ready.jpg screen is displayed the movie file should be named ready.
mp4. Movie files can't overlap the live view display and so if live view is active the movie will be
displayed in the area below the live view.
Append "_loop" to the filename , e.g. ready_loop.mp4, if you want the movie to automatically restart
from the beginning and play continuously.
By default movie files are displayed centered on the screen unless live view is active in which case
they are displayed below the live view. Movie files can also be positioned manually by appending the
offsets from the left and top of the screen to the filename in the form _{LeftOffset}+{TopOffset} e.g. to
position the ready.mp4 movie 200 pixels from the left of the screen and 100 pixels from the top the file
should be named ready_200+100.mp4 (or ready_loop_200+100.mp4 if you want it to play
continuously). If the movie is larger than the screen it will be automatically scaled to fit the screen.
When a movie is displayed on the countdown screen (e.g. by naming it 1.mp4) it replaces the normal
countdown text and is only played once. Approximately 1 second before the end of the movie the
taking.jpg screen is displayed and then the photo is taken when the movie reaches the end. There is a
sample movie file called countdown.mp4 in the folder where NKRemote is installed. To use this simply
copy it to your photobooth images folder and rename it to 1.mp4, 2.mp4 etc.
Important: The delay before taking each photo must be set to 2 secs or more otherwise the
countdown movie will not be displayed.
If the MP4 movie file does not play correctly (e.g. portrait orientation MP4 files created using the h.264
CODEC not filling the screen) please try transcoding it to use a different CODEC such as MPEG. This
can be done using free tools such as HandBrake.

Audio Prompts
Audio prompts can be added by placing a WAV sound file in the photobooth images folder and giving it
the same name as prompt screen. For example to play a sound when the photobooth is ready copy a
WAV file named ready.wav into the photobooth images folder and it will be played when the ready.jpg
image is displayed. You can also play an audio file when the touchscreen keyboard is displayed by
naming it keyboard.wav and placing it in the photobooth images folder.
Note: There is no need to use a WAV file if you are already using a movie file (see above) because
movie files can contain both pictures and sound.
The easiest way to see how this works is to try it out. To do this run NKRemote then press Ctrl+F4 to
display the ready screen. Then F4 to start the photobooth shooting sequence.
A typical 4 picture sequence would be:
At startup: "ready.jpg" image displayed on screen and "ready.wav" played once (if present)
Sequence started: "1.jpg" image displayed on screen together with countdown text and "1.wav"
played once (if present)
Approx 1 sec before taking picture #1: "taking.jpg" image displayed on screen and "taking.wav"
played once (if present)
After taking picture #1: preview image displayed for the required number of seconds (if enabled in
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the settings) then "2.jpg" image displayed on screen together with countdown text and "2.wav" played
once (if present)
Approx 1 sec before taking picture #2: "taking.jpg" image displayed on screen and "taking.wav"
played once (if present)
After taking picture #2: preview image displayed for the required number of seconds (if enabled in
the settings) then "3.jpg" image displayed on screen together with countdown text and "3.wav" played
once (if present)
Approx 1 sec before taking picture #3: "taking.jpg" image displayed on screen and "taking.wav"
played once (if present)
After taking picture #3: preview image displayed for the required number of seconds (if enabled in
the settings) then "4.jpg" image displayed on screen together with countdown text and "4.wav" played
once (if present)
Approx 1 sec before taking picture #4: "taking.jpg" image displayed on screen and "taking.wav"
played once (if present)
After taking picture #4: preview image displayed for the required number of seconds (if enabled in
the settings) then "processing.jpg" image displayed on screen and "processing.wav" played once (if
present). During this time the images are formatted ready for output and either saved to file or sent to
the printer queue. When this has finished the screen goes back to the "ready.jpg" image and the
ready.wav sound file is played ready for the next sequence.
It is also possible to display different screens depending on whether color, black and white or
monochrome toned mode is selected and the number of print copies. This makes it possible to show
the user which settings have been selected and could be used as part of a touchscreen menu system.
The way it works is to check for a suffix after the filename for the appropriate screen image in the form
<screen>_<b|c|t><1..9>.jpg where <screen> is the name of the screen image e.g. "ready", <b|c|t> is
the color mode: "b" for black and white, "c" for color or "t" for monochrome toned and <1..9> is the
number of print copies e.g. "1" is one copy is selected.
For example when the ready.jpg image is to be displayed, the color mode is set to black and white and
the number of print copies is set to 2 the software will look for a suitable screen image in the following
order:
ready_b2.jpg - i.e. "ready" + black and white + 2 copies selected or if this isn't found it looks for:
ready_b.jpg - i.e. "ready" + black and white or if this isn't found it looks for:
ready_2.jpg - i.e. "ready" + 2 copies selected or if this isn't found it looks for:
ready.jpg
So to have screens to indicate the color mode and the number of print copies from 1 to 3 you need the
following "ready" screens: ready_c1.jpg, ready_c2.jpg, ready_c3.jpg, ready_b1.jpg, ready_b2.jpg,
ready_b3.jpg.
When a setting is changed, e.g. the color mode is set to black and white, the screen image is updated
automatically to show the user the current status.

Running External Commands
External commands can be used to customize the way the photobooth works e.g. by emailing images
or turning lights on and off. There are three different ways external commands can be run when
shooting in full screen photobooth mode:
1. After each photo is downloaded
2. When the photobooth screen changes during the photobooth shooting sequence
3. When the XML summary file is written after the photobooth output has been printed or saved
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Running commands after downloading each photo
You can use the editor command to run a command or script on each image after it has been
downloaded. This could be used to run a Photoshop droplet to modify the image. You may need to add
a delay to allow time for the droplet to finish before the images are printed. This can be done by setting
the following value in the Windows registry:
HKEY_CURRENT_USER\Software\BreezeSystems\NKRemote\100
\PhotoboothDelayBeforePrintingInSecs
Running commands when the photobooth screen changes
This allows a command to be run each time the photobooth screen changes during the photobooth
shooting sequence. The full pathname of the screen image is passed as a command line argument to
the command e.g. C:\Program Files\BreezeSys\NKRemote\PhotoboothImages\ready.jpg. To enable
this two values need to be stored in the Windows registry: PhotoboothStatusCmdEnable and
PhotoboothStatusCmd (see below for details).
Running a command when the XML summary file is written
This allows a command to be run after the photobooth output has been saved or printed and the XML
summary file has been written. The full pathname of the XML summary file is passed as a command
line argument to the command. To enable this two values need to be stored in the Windows registry:
PhotoboothStatusCmdEnable and PhotoboothStatusCmdXML (see below for details).
Windows registry settings
To enable the photobooth screen change or XML summary file commands the following
REG_DWORD value in the Windows registry should be set to 1:
HKEY_CURRENT_USER\Software\BreezeSystems\NKRemote\100\PhotoboothStatusCmdEnable
The photobooth screen change command is defined using the following REG_SZ value:
HKEY_CURRENT_USER\Software\BreezeSystems\NKRemote\100\PhotoboothStatusCmd
The XML summary file command is defined using the following REG_SZ value:
HKEY_CURRENT_USER\Software\BreezeSystems\NKRemote\100\PhotoboothStatusCmdXML
Enter an empty string or delete the registry value for PhotoboothStatusCmd or
PhotoboothStatusCmdXML if you want to run one command but not the other. The values can be
edited using the Windows regedit utility or by creating a registry file like the one below, giving it a .reg
file extension and then double clicking on the file in Windows Explorer to copy the settings to the
registry:
Windows Registry Editor Version 5.00
[HKEY_CURRENT_USER\Software\BreezeSystems\NKRemote\100]
"PhotoboothStatusCmdEnable"=dword:00000001
"PhotoboothStatusCmd"="C:\\Program Files\\BreezeSys\\NKRemote\\PhotoboothImages\\status.exe"
"PhotoboothStatusCmdXML"="C:\\Program Files\\BreezeSys\\NKRemote\\PhotoboothImages\\statusXML.exe"

11.4

Modifying Photos Before Printing
Sometimes it is necessary to modify the photos using another application before they are printed by
NKRemote. This could be to run a Photoshop droplet to apply a special effect or to produce a specific
"look" to the photos or to run a green screen application to create high quality green screen images.

Step 1 - Run a command on each photo after it has been
downloaded
The Photoshop droplet or other command can be automatically run after downloading each photo
using the edit images option by selecting "Setup Image Editor..." from the File menu:
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Select the "Use command line below" option and enter the pathname of the command or script that
should be run on each photo after it has been downloaded. Then select "Automatically edit the image
when a photo is taken" option and select "Edit JPEG files only". This will run the command on every
time a photo is taken and a JPEG image is downloaded to the computer. This can be disabled by
unchecking "Automatically edit the image when a photo is taken".

Step 2 - Delay the printing of the photos to allow time for the photo
to be processed
Normally NKRemote will start preparing the print layout immediately after downloading the last photo in
the shooting sequence and this can result in the last photo not being modified before it is placed in the
print layout if the command takes too long to process the photo. This problem can be avoided by
setting a delay before printing in the "Output Settings" dialog:
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Set the delay before printing to sufficient time to allow the command to modify the photo. After taking
the last photo NKRemote will wait for the specified number of seconds before it starts to create the
print layout. The delay can be cut short by sending the key sequence Ctrl+Z to NKRemote. This is
useful if a script is used to run the command because the delay before printing can be set to a time
that is guaranteed to always be long enough (e.g. 30 secs) and the script can send Ctrl+Z to
NKRemote when the command to modify the photo has finished, thus minimizing the time NKRemote
waits before printing the photos.

Running Photoshop Droplets
When a Photoshop droplet is run it will launch Photoshop if it is not already running and the Photoshop
Window will appear on the photo booth screen. To avoid this happening run the "Hide Window
Taskbar" utility. This can be run by double clicking on HideWindowsTaskbar.exe in theNKRemote
installation folder (usually C:\Program Files (x86)\BreezeSys\NKRemote):

© 2016 Breeze Systems Ltd

Photobooth Shooting

79

Select the option to "Hide Photoshop window when photo booth is running". The Hide Windows
Taskbar utility will monitor NKRemote and when it is running in full screen photo booth mode the utility
will hide the Windows task bar and the Photoshop window if Photoshop is running. When you exit full
screen photo booth mode the utility will automatically restore the Windows taskbar and show the
Photoshop window again.
Please make sure no tool windows are open in Photoshop otherwise these may appear on the photo
booth screen when running the droplet.
The Hide Windows Taskbar hides the Windows task bar when full screen photo booth mode is
selected to avoid problems with the taskbar appearing on screen during photo booth shooting on some
computers. This function is deliberately not built into the main NKRemote program because if
NKRemote exits prematurely (e.g. due to problems with the camera connection) it won't be able to
restore the Windows taskbar which then makes it very difficult to control the computer. This problem is
avoided by using a separate utility which is simple and very reliable.

Running Different Photoshop Droplets using Profiles
Different droplets can be used for different profiles by placing the droplet in the photobooth images
folder selected by the profile and running a script from the editor command. An example AutoHotKey
script called droplet.ahk can be found in the installation folder (usually C:\Program Files (x86)
\BreezeSys\NKRemote). When the script is run it looks for the droplet file in the current photo booth
images folder and the runs it to process the image. If the script cannot find the droplet in the current
photo booth images folder it will look for it in the same folder as the script.
After running the droplet the script will send Ctrl+Z to the photo booth window if the processing screen
is displayed so that NKRemote can start printing the photos.
AutoHotKey needs to be installed before using the script. This is a free download from https://
autohotkey.com
Then select "Setup Image Editor..." from the File menu and set the command line to the pathname of
the script followed by name of the droplet file e.g.
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The pathname for the script needs to be enclosed by double quotes if it contains spaces e.g. "C:
\Program Files (x86)\BreezeSys\NKRemote\droplet.ahk"

11.5

Signing or Drawing on the Prints
After taking the photos a screen allowing users to sign the prints or draw on them can be displayed by
selecting the "Sign or draw on photos before printing" option in the "Output Settings" dialog.

The print layout is displayed full screen with a menubar down the left hand side. The current line width
and pen color is displayed in the top left hand corner. Users can sign their print or draw on it using a
touchscreen or mouse. Tapping the color palette icon in the menubar will display a panel of colors
allowing users to choose the pen color:
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When the user taps on a color in the panel it is highlighted and the pen width and color indicator in the
top left corner is updated to show the color. The color panel can be dismissed by tapping anywhere in
the menubar or by drawing on the print.
Tapping the line width icon in the menu bar will display a slider allowing users to adjust the line width:

The pen width can be adjusted by moving the slider left or right and the pen width and color indicator in
the top left corner is updated to show the new pen width. The pen width slider can be dismissed by
tapping anywhere in the menubar or by drawing on the print.
If the user makes a mistake they can undo the last action by tapping the "Undo" icon (the red arrow in
© 2016 Breeze Systems Ltd

82

NKRemote

the menubar). Alternatively they can start again by tapping the trashcan icon. Actions that have been
undone by tapping on the undo or trashcan icons can be re-done by tapping the "Redo" icon (the blue
arrow in the menubar).
The number of copies to print can be increased by tapping the + symbol to the right of the number of
copies display in the menubar and decreased by tapping the - symbol.
Tapping the printer icon accepts the the photos together with any drawing added by the user and prints
the selected number of copies.
Tapping on the cancel icon (the red cross in the menubar) will reject photos and the photo booth will
return to the ready screen without printing the photos.

Modifying the appearance of the screen
The default screen appearance is a black background with a white menubar area. The icons for the
actions in the menubar a defined using PNG files in the icons subfolder of in the installation folder:
color.png - image used for the color palette icon
width.png - image used for the pen width icon
redo.png - image used for "Redo" icon
undo.png - image used for the "Undo" icon
clear.png - image used for the clear/trashcan icon
print.png - image used for the print icon
cancel.png - image used for the cancel icon
The appearance of the icons can be changed by replacing the PNG images in the icons subfolder with
new images or by placing PNG images in the current photobooth images folder.
The appearance of the whole screen can be modified by creating a JPEG screen image named
usermodifyprint.jpg and placing it in the current photobooth images folder. The screen image should
be the same size in pixels as the screen on which the photo booth will be displayed.
An optional overlay can be placed on top of the background and print layout by creating a PNG screen
image named usermodifyprint_overlay.png and placing it in the current photobooth images folder. The
overlay image should be the same size in pixels as the screen on which the photo booth will be
displayed and should contain transparency information in the alpha channel. The overlay can be used
to display instructions to the user and will appear on screen but not in the final prints.

Editing the settings
Hold down the shift and ctrl keys and left click the mouse to display the settings dialog:
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Use the checkboxes in the "Menu Items" area to select which actions should be made available to the
user in the menubar area.
The initial color setting specifies the pen color that is selected when the screen is displayed. Click on
the "..." button to choose a different color.
The initial line width specifies the line width in pixels of the pen when the screen is first displayed. The
min line width and max line width settings specify the range of line widths the user can select if the
"Line width selector" menu option is enabled.
The "Inactivity timeout (secs):" setting allows a timeout to be set. If the user does not touch the screen
for a period longer than the timeout value the screen will be closed and the photos either printed or
canceled depending on the timeout action setting. Setting the timeout to 0 will disable the timeout.
The max copies setting specifies the maximum number of print copies the user can select by tapping
the + symbol in the menubar.
By default users can draw anywhere on the print, but this can be limited by enabling the clipping and
exclusion clipping regions. The clipping region is used to specify a region where the user is allowed to
draw. The exclusion region allows an area within the drawing area to be protected e.g. to stop people
drawing on corporate logos. The clipping and exclusion clipping regions can be edited by clicking on
the "OK" button. The clipping region will be displayed by a green rectangle and the exclusion clipping
region by a red rectangle. Click on one of the rectangles to select it and then adjust its size and
position by dragging it corners. Click in the menubar area to save the settings and return to drawing
mode.
Select the "Show mouse cursor" to display the mouse cursor to allow users to draw on the prints using
a mouse.

Implementation notes
The signing and drawing screen is implemented using a dynamic library named UserModifyPrint.dll
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and saves its settings in the Windows registry using the following registry key:
HKEY_CURRENT_USER\SOFTWARE\BreezeSystems\NKRemote\100\UserModifyPrint
If different drawing and signing functionality is required it can be implemented by creating a new
dynamic library to replace the default UserModifyPrint.dll library without requiring a custom build of
NKRemote.
Copyright information for icons used by UserModifyPrint.dll:
Undo/Redo/Cancel icons: These icons are provided by icons8 as Creative Commons AttributionNoDerivs 3.0. You can copy, use and distribute this icon, even for commercial purposes, all without
asking permission provided you link to icons8.com website from any page you use this icon. You may
not alter, transform, or build upon this work. https://icons8.com
Color Palette/Trashcan icons from http://downloadicons.net
Printer icon: royalty free icon purchased from http://artistsvalley.com. This icon may only be used with
Breeze Systems' products unless a separate license is purchased from Artists Valey.
Line width: Copyright Breeze Systems Limited. This icon may only be used with Breeze Systems'
products.

11.6

Touchscreen Keyboard
An optional touchscreen keyboard can be displayed at the start or end of the photo booth shooting
sequence to allow users to enter information such as their email address. To enable the keyboard set
the photo booth start options in the photo booth settings dialog to "Touchscreen" and click on the
"Settings..." button. The touchscreen settings dialog will be displayed:
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Then select the required touchscreen keyboard option from the dropdown list:
"Not displayed" - the touchscreen keyboard is not displayed
"Email input at start of sequence" - the email input touchscreen keyboard is displayed when the user
presses the start button before any of the photos are taken
"Email input at end of sequence" - the email input touchscreen keyboard is displayed after the photos
have been taken and the optional print confirmation screen has been displayed (it isn't displayed if the
user chooses not to print the photos)
"Email input after taking photos".- the email input touchscreen keyboard is displayed immediately after
taking the photos before the optional print confirmation screen
"Message input at end of sequence" - the message input touchscreen keyboard is displayed after the
photos have been taken and the optional print confirmation screen has been displayed (it isn't
displayed if the user chooses not to print the photos)
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The "Timeout (secs):" setting allows an inactivity timeout to be specified. If the user does not tap the
touchscreen for a while the timeout will automatically close the touchscreen keyboard. This is useful if
the user leaves the photo booth without using the touchscreen keyboard as it allows the booth to
automatically close the touchscreen keyboard and display the ready screen ready for the next user.
The touchscreen keyboard can be tested by pressing the "Test keyboard..." button and selecting the
keyboard type to test from the menu. The default keyboard layout will fill the screen and look similar to
the screenshot below:

The text entered by the user is saved in the <user_data> tag (and the <user_data2> tag if two text
fields are defined) in the XML file written at the end of the photo booth shooting sequence. If any
checkboxes are defined (see below) their status will be saved in <chkbox1>, <chkbox2> etc. tags e.g.
if the user selects the first checkbox the XML will contain <chkbox1>1</chkbox1>. The XML file is
saved in the same folder as the photos downloaded from the camera (see preferences) e.g.
<?xml version="1.0" ?>
<breeze_systems_photobooth version="1.0">
<photo_information>
<date>2011/01/26</date>
<time>16:37:19</time>
<user_data>sales@breezesys.com</user_data>
<photobooth_images_folder>C:\Photobooth\PhotoboothImages</photobooth_images_folder>
<photos>
<photo image="1">20110126_163719_1.JPG</photo>
<photo image="2">20110126_163719_2.JPG</photo>
<photo image="3">20110126_163719_3.JPG</photo>
<photo image="4">20110126_163719_4.JPG</photo>
<output>prints\20110126_163719.jpg</output>
</photos>
</photo_information>
</breeze_systems_photobooth>

There is a default timeout of 300 secs after which time the touchscreen keyboard will be automatically
canceled. This timeout is stored in the Windows registry key:
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HKEY_CURRENT_USER\Software\BreezeSystems\NKRemote\100\PhotoboothKeyboardTimeout
When the "Message input at end of sequence" touchscreen option is used the data entered by the
user is also stored in the {message} token which can be used in the captions in the print layout or in
email or Facebook messages when using the sharing options.

Customizing the keyboard
The layout of the keyboard can be customized by creating an XML settings file called keyboard.xml
and putting this in the photo booth images folder. This gives control over the size and position of the
keys, the background color etc. A series of keyboard images can also be used if you need more
control of the appearance of the keyboard.
The easiest way to customize the keyboard is to save a copy of the XML file and TIFF screen images
used to define the default keyboard layout and then edit them as required. The files can be saved by
first displaying the keyboard by pressing the "Test keyboard..." button and then holding down both the
Shift and Ctrl keys and pressing the left mouse button. The keyboard.xml file will look something like:
<?xml version="1.0" ?>
<breeze_systems_photobooth version="2.2">
<photobooth_settings>
<keyboard>
<text_point_size>480</text_point_size>
<prompt1 rows="1">Please enter your email address:</prompt1>
<text1_y>411</text1_y>
<text1_x>50</text1_x>
<text1_r>300</text1_r>
<background_color>0x000080</background_color>
<transparent_color>0x000080</transparent_color>
<text_color>0xFFFFFF</text_color>
<show_cursor>0</show_cursor>
<show_mouse_cursor>0</show_mouse_cursor>
<key>
<left>58</left>
<top>630</top>
<width>112</width>
<height>89</height>
<legend>q</legend>
<shifted_legend>Q</shifted_legend>
<code>q</code>
<shifted_code>Q</shifted_code>
</key>
<key>
<left>186</left>
<top>630</top>
<width>112</width>
<height>89</height>
<legend>w</legend>
<shifted_legend>W</shifted_legend>
<code>w</code>
</key>
...
<key>
<left>1296</left>
<top>840</top>
<width>160</width>
<height>89</height>
<legend>Shift</legend>
<shifted_legend>Shift</shifted_legend>
<code>Shift</code>
<shifted_code>Shift</shifted_code>
</key>
<key>
<left>400</left>
<top>945</top>
<width>368</width>
<height>89</height>
<legend>Send email</legend>
<shifted_legend>Send email</shifted_legend>
<code>OK</code>
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<shifted_code>OK</shifted_code>
</key>
<key>
<left>784</left>
<top>945</top>
<width>368</width>
<height>89</height>
<legend>No thanks!</legend>
<shifted_legend>No thanks!</shifted_legend>
<code>Cancel</code>
<shifted_code>Cancel</shifted_code>
</key>
</keyboard>
</photobooth_settings>
</breeze_systems_photobooth>

The <prompt1> tag defines the text that is displayed above the user input area and defaults to "Please
enter your email address:". The <text1_x> and <text1_y> tags specify the position of the user input
area. This is specified as the number of pixels down from the top, left corner of the screen. The right
hand side of the user input area can be specified using the <text1_r> tag.
Additional prompts can be added by including <prompt2>, <text2_x>, <text2_y>, <text2_r> etc. tags up
to a maximum of 10 user input areas.
The prompt tags can have an optional password attribute which if set to "1" will display the text in the
user input area as * characters e.g. <prompt1 password="1">Please enter your password:</prompt1>.
The prompt tags can have an optional mandatory attribute which if set to "1" means that the prompt
must contain text e.g. <prompt1 mandatory="1">Please enter your name:</prompt1>.
The prompt tags can have an optional email_address attribute which if set to "1" will check that the text
looks like an email address in the form name@domain.com e.g. <prompt1 email_address="1">Please
enter your email address:</prompt1>. If the text does not appear to be an email address an error
message saying "Please enter a valid email address in the form name@domain.com" will be
displayed. The text of this error message can be changed in the email settings dialog.
The input text area is normally on a single line. Multiple lines can be used by setting the prompt tag's
rows attribute to 2 or more e.g. <prompt1 rows="3">Please enter a message:</prompt1>.
When more than one user input area is defined users can switch between the input areas by touching
them. The currently selected input area is highlighted in red.
The optional <text_point_size> tag defines the size of the text font used in the user input area. This is
specified in tenths of a point and defaults to 480 (a point size of 48).
The text entered by the user is stored in the <user_data>, <user2_data> etc. fields in the XML file
saved with the photos.
Up to 10 checkboxes can be added using the <chkbox1_prompt>, <chkbox1_x>, <chkbox1_y>,
<chkbox2_prompt>, <chkbox2_x>, <chkbox2_y> etc. tags. The <chkbox1_prompt> tag specifies the
text displayed to the right of the text box and can include a value attribute to specify whether the
checkbox is initially checked or not e.g. <chkbox1_prompt value="0">Checkbox prompt (default off)</
chkbox1_prompt> or <chkbox1_prompt value="1">Checkbox prompt (default on)</chkbox1_prompt>.
A checkbox can also be made mandatory (i.e. the user has to check the checkbox before pressing the
"OK" button) by adding the mandatory attribute to the <chkbox1_prompt> tag e.g. <chkbox1_prompt
mandatory="1">I agree to the terms and conditions</chkbox1_prompt>. The optional point_size
attribute can be used to specify the point size of the legend and also the size of the checkbox box e.g.
<chkbox1_prompt point-size="240">Checkbox</chkbox1_prompt> adds a checkbox with the legend
displayed using 24 point text.
The <chkbox1_x> and <chkbox2_y> tags specify the position of the checkbox.
The checkbox status is stored in the <chkbox1>, <chkbox2> etc. fields in the XML file saved with the
photos.
The <background_color> tag specifies the background color of the window and the <key_text_color>
specifies the color for the prompt text and key legends.
The optional <text_foreground_color> tag specifies the foreground color for text displayed in the user
input areas. The default value if this tag is omitted is black (0x000000).
The optional <text_background_color> tag specifies the background color for the user input areas. The
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default value if this tag is omitted is white (0xFFFFFF).
The optional <transparent_color> tag specifies a color which will be made transparent when the
keyboard is displayed.
All colors should be hexadecimal RGB values e.g. 0x000000 for black, 0xFF0000 for red, 0x00FF00
for green, 0x0000FF for blue, 0xFFFFFF for white.
The <show_cursor> tag specifies whether a gray cursor is shown in the user input area. Set this to 1 to
display the cursor or 0 to hide it. The cursor display is useful if the keyboard allows the entry of spaces.
The <show_mouse_cursor> tag specifies whether a the mouse cursor is displayed, The default setting
is for the mouse cursor not to be displayed.
The <key> tag specifies the size and position of each key, its legends and what should be typed when
it is pressed. The top left corner of the key is defined using the <left> and <top> tags and the width and
height are specified using the <width> and <height> tags (all values are in pixels). The
<shifted_legend> tag specifies what is displayed on the key when the shift key is pressed and the
<legend> specifies the key legend when shift is not pressed.
The <shifted_code> tag specifies what is typed when the key is pressed when shift is pressed and the
<code> tag specifies what is typed when the shift key is not pressed. The following codes have special
values:
"Shift" - puts the keyboard into shifted mode (i.e. upper case) when pressed
"OK" - closes the keyboard window and returns the user input if at least one text input field contains
text and all inputs marked as mandatory have been entered
"OK all" - closes the keyboard window and returns the user input if all the input fields contain some text
"OK none" - closes the keyboard window and returns the user input even if none of the input fields
contain text provided all inputs marked as mandatory have been entered
"Cancel" - closes the keyboard window and cancels the user input
"Close" - closes the keyboard and returns to the ready screen when the "Email input at start of
sequence" touchscreen keyboard option is used
International and special characters need to be added in UTF-8 unicode format e.g. the Euro symbol,
€, is defined in UTF-8 as 0x20AC. This needs to added to the XML file as &#x20ac; e.g.
<key>
<left>58</left>
<top>630</top>
<width>112</width>
<height>89</height>
<legend>&#&x20ac;</legend>
<shifted_legend>&#&x20ac;</shifted_legend>
<code>&#&x20ac;</code>
<shifted_code>&#&x20ac;</shifted_code>
</key>

The keyboard.xml can just include additional settings and the touchscreen keyboard will use the
default layout (shown above) if it doesn't contain any <key> tags. For example you could use the
default keyboard layout and add a checkbox to ask users whether they consent to their photos being
uploaded to a website using the keyboard.xml file below:
<?xml version="1.0" ?>
<breeze_systems_photobooth version="2.3">
<photobooth_settings>
<keyboard>
<chkbox1_prompt value="0">I agree to my photos being posted on a web site</chkbox1_prompt>
<chkbox1_x>38</chkbox1_x>
<chkbox1_y>70</chkbox1_y>
</keyboard>
</photobooth_settings>
</breeze_systems_photobooth>

When the Facebook upload option is used (see Uploading to social networks...) the touchscreen
keyboard will look for a definition file named fb_keyboard.xml instead of keyboard.xml. If the
fb_keyboard.xml file is not found the touchscreen keyboard will display two input areas to allow users
to enter their Facebook username and password.
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Keyboard images
Separate keyboard screen images can be defined if you need more control over the appearance of the
keyboard. These images should be TIFF images the same size as the resolution of the screen and
should be placed in the photo booth images folder. The keyboard images should be named as follows:
keyboard_uppercase.tif - keyboard image showing upper case key legends
keyboard_uppercase_pressed.tif - keyboard image showing upper case key legends with the keys
pressed
keyboard_lowercase.tif - keyboard image showing lower case key legends
keyboard_lowercase_pressed.tif - keyboard image showing lower case key legends with the keys
pressed
If TIFF keyboard images aren't found the software will attempt to load JPEG images instead
(keyboard_uppercase.jpg, keyboard_uppercase_pressed.jpg, keyboard_lowercase.jpg and
keyboard_lowercase_pressed.jpg).
When the email option is used (see Uploading to social networks...) the touchscreen keyboard will look
for the following keyboard xml definition file and keyboard images:
email_keyboard.xml - XML file defining the keyboard layout
email_keyboard_uppercase.tif - keyboard image showing upper case key legends
email_keyboard_uppercase_pressed.tif - keyboard image showing upper case key legends with the
keys pressed
email_keyboard_lowercase.tif - keyboard image showing lower case key legends
email_keyboard_lowercase_pressed.tif - keyboard image showing lower case key legends with the
keys pressed
Please note that for compatibility with previous releases the email option will use the standard XML
definition file and keyboard images if versions with an email_ prefix aren't found.
When the Facebook upload option is used (see Uploading to social networks...) the touchscreen
keyboard will look for the following keyboard xml definition file and keyboard images:
fb_keyboard.xml - XML file defining the keyboard layout
fb_keyboard_uppercase.tif - keyboard image showing upper case key legends
fb_keyboard_uppercase_pressed.tif - keyboard image showing upper case key legends with the keys
pressed
fb_keyboard_lowercase.tif - keyboard image showing lower case key legends
fb_keyboard_lowercase_pressed.tif - keyboard image showing lower case key legends with the keys
pressed
When the Twitter upload option is used (see Uploading to social networks...) the touchscreen
keyboard will look for the following keyboard xml definition file and keyboard images:
twitter_keyboard.xml - XML file defining the keyboard layout
twitter_keyboard_uppercase.tif - keyboard image showing upper case key legends
twitter_keyboard_uppercase_pressed.tif - keyboard image showing upper case key legends with the
keys pressed
twitter_keyboard_lowercase.tif - keyboard image showing lower case key legends
twitter_keyboard_lowercase_pressed.tif - keyboard image showing lower case key legends with the
keys pressed
When the send SMS/MMS option is used (see Uploading to social networks...) the touchscreen
keyboard will look for the following keyboard xml definition file and keyboard images:
mms_keyboard.xml - XML file defining the keyboard layout
mms_keyboard_uppercase.tif - keyboard image showing upper case key legends
mms_keyboard_uppercase_pressed.tif - keyboard image showing upper case key legends with the
keys pressed
mms_keyboard_lowercase.tif - keyboard image showing lower case key legends
mms_keyboard_lowercase_pressed.tif - keyboard image showing lower case key legends with the
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keys pressed
When the "Message input at end of sequence" option is used the touchscreen keyboard will look for
the following keyboard xml definition file and keyboard images:
message_keyboard.xml - XML file defining the keyboard layout
message_keyboard_uppercase.tif - keyboard image showing upper case key legends
message_keyboard_uppercase_pressed.tif - keyboard image showing upper case key legends with
the keys pressed
message_keyboard_lowercase.tif - keyboard image showing lower case key legends
message_keyboard_lowercase_pressed.tif - keyboard image showing lower case key legends with the
keys pressed
Please take care that the keys are in the same positions in each of the keyboard images and that
these also correspond to the values in the keyboard.xml file. The <background_color>, <text_color>,
<prompt>, <legend> and <shifted_legend> tags in the keyboard.xml file are ignored when keyboard
images are used to define the appearance of the keyboard.
Note: If you only need to change the keyboard layout and are happy with the default keyboard display
you only need to create a keyboard.xml file in the photo booth images folder and can delete the
keyboard screen images (keyboard_uppercase.tif, keyboard_uppercase_pressed.tif,
keyboard_lowercase.tif and keyboard_lowercase_pressed.tif). If keyboard images are defined the
<prompt> tags in the keyboard.xml file will be ignored.

11.7

Animated GIFs
Animated GIFs provide a way of displaying a short slideshow of the photos in a continuous loop. The
slideshow can have optional overlays and title pages which can be displayed at the start or end of the
sequence.
The animated GIFs can be viewed using our Breeze Kiosk software and then shared by email, text
(MMS in USA and Canada, SMS elsewhere) or uploaded to Twitter.

Creating Animated GIFs in Photo Booth Mode
Select "Create animated GIF of photos" on the "Output Settings" dialog and then click on the
"Animated GIF settings..." button to configure the settings:
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The animated GIFs will show the photos in the same orientation as the live view display. If the live view
display is cropped or digitally zoomed the photos added to the animated GIF will be cropped and
zoomed by the same amounts.
If green screening is enabled the green screened copy of the photos will be added to the GIF. The the
transparent background option is selected in the green screen settings the photo placed in the GIF will
also have a transparent background.
If B&W mode, monochrome toning (e.g. sepia) or creative filters are used the photos will be added to
the animated GIF with these effects applied.
Use the "Photo width (pixels):" setting to specify the width photos added to the animated GIF. The
height of the photos will be calculated automatically in proportion to the width e.g. setting the width to
600 pixels will give a height of 400 pixels when the camera is horizontal or a height of 900 pixels if the
camera in in portrait orientation.
The "Photo left offset:" and "Photo top offset:" settings specify the position the photos are added to the
GIF. The offsets are measured in pixels from the left and top edges of the GIF.
The "GIF width" and "GIF height" settings specify the size of the animated GIF in pixels. If these
settings are 0 the GIF will created the same size as the photos.
An optional overlay can be displayed over each photo by placing a PNG file named GIF_overlay.png in
the photo booth images folder. A different overlay can be used for each photo by naming the overlays
GIF_overlay_1.png for photo 1, GIF_overlay_2.png for photo 2 etc.
An optional background can also be used for each photo by placing a JPEG image named
GIF_background.jpg in the photo booth images folder. A different background can be used for each
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photo by naming it GIF_background_1.jpg, GIF_background_2.jpg etc.
Background images can be used as a simple way to provide a background to the GIF when the GIF is
larger than the photo. Background images can also be used to provide the green screen background
when using the transparent background option when shooting green screen. More interesting
animations can be created by having multiple backgrounds per photo when shooting green screen with
a transparent background.
Multiple overlays (and/or backgrounds can be added to each photo by setting "Backgrounds/overlays
per photo" to more than 1 e.g. to display two overlays per photo set "Overlays per photo" to 2 and
name the files as follows: GIF_overlay_1.png for the first half of photo 1's display time, GIF_overlay_2.
png for the second half of photo 1's display time, GIF_overlay_3.png for the first half of photo 2's
display time, GIF_overlay_4.png for the second half of photo 2's display time etc.
The PNG overlay images can be made transparent or semi-transparent by adding an alpha channel.
If overlay images are larger than the GIF width setting they will be resized to the same width. If an
overlay is smaller than the GIF it will be displayed bottom right justified i.e. in the bottom right hand
corner.
The image interval setting specifies how long each photo should be displayed and is in units of 1/100
sec. A value of 75 (3/4 sec) to 100 (1 sec) is probably a good starting point.
One or more optional title pages can be displayed at the beginning or end of the photo sequence. To
add a single title page place a JPEG image named GIF_title.jpg in the photo booth images folder. To
add multiple title pages to create a short animation place JPEG images named GIF_title_1.jpg,
GIF_title_2.jpg, GIF_title_3.jpg etc. in the photo booth images folder
If the title page image is larger than the GIF width setting it will be resized to the same width. Use the
"Title display time" to specify how long each title page should be displayed.
The title page or pages can be displayed before or after the photos. It probably makes more sense to
display titles after the photos because browsers that display animated GIFs will normally show a
thumbnail generated from the start of the animation. Putting the title at the end will mean that the
thumbnail will show the first photo whereas if the title is at the start of the animation the thumbnail will
show the title page.
Select "Play GIF in a continuous loop" if you want the GIF to loop indefinitely. If this option is not
selected the GIF will loop once i.e. it will play the animation twice by running through it once and then
looping a single time to play it again.
Select the "Ping-pong" option to play the photo sequence forwards and then backwards e.g.
4 photos with no title and the ping-pong option selected will display photo 1, photo 2, photo 3, photo 4,
photo 3, photo 2, photo 1, photo 2 etc.
4 photos with no title and the ping-pong option not selected will display photo 1, photo 2, photo 3,
photo 4, photo 1, photo 2, photo 3, photo 4 etc.
4 photos with a title at the end and the ping-pong option selected will display photo 1, photo 2, photo 3,
photo 4, photo 3, photo 2, photo 1, title, photo 1, photo 2 etc.
When using overlays with the "ping-pong" option the overlay files should be named as follows:
Overlay files for 3 photos with no title, the ping-pong option selected and overlays per photo set to 1:
GIF_overlay_1.png for photo 1, GIF_overlay_2.png for photo 2, GIF_overlay_3.png for photo 3,
GIF_overlay_4.png for photo 2
Overlay files for 3 photos with a title, the ping-pong option selected and overlays per photo set to 2:
GIF_overlay_1.png/GIF_overlay_2.png for photo 1, GIF_overlay_3.png/GIF_overlay_4.png for photo 2,
GIF_overlay_5.png/GIF_overlay_6.png for photo 3, GIF_overlay_7.png/GIF_overlay_8.png for photo 2,
GIF_overlay_9.png/GIF_overlay_10.png for photo 1
Select the "Create PNG copies of GIF frames in 'GIF_frames' subfolder" option to create PNG copies
of all the frames that make up the animated GIF. This is useful if the frames are to be processed by
other software.
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Please note: It is not necessary to select this option to create MP4 copies of the GIFs.
Warming: The PNG files created when this option is selected can be quite large and may fill up the
computer's hard disk.
By default the animated GIF will be created in a subfolder named GIF in the download folder. If you
are using our Breeze Kiosk software to display the animated GIFs you need to set it up to monitor the
GIF folder.
Select the "Save GIF in 'prints' subfolder" option to save the GIF in the prints subfolder with the JPEG
copies of the printed output. This is useful if you are using kiosk software and wish to display the GIFs
and the prints.
Select the "Create MP4 copy of the animated GIF" option to automatically create an MP4 movie file of
the animated GIF. Set the minimum duration of the movie in secs or set this to 0 to make the movie as
short as possible. This option is useful if the movie file is to be uploaded to a site which has a minimum
length requirement (e.g. videos posted to Instagram must be at least 3 seconds long). If the movie file
will be shorter than the minimum length the GIF frames, but not the title frames, will be repeated until
the movie is long enough.
Use the "Save MP4 in" checkbox to specify where the MP4 files should be saved:
"same folder as GIF" will save the MP4 file in the same folder as the GIF (either the GIFs subfolder or
the prints subfolder depending on the "Save GIF in 'prints' subfolder" setting)
"'MP4' subfolder" will save the MP4 file in a subfolder named MP4
"prints' subfolder" will save the MP4 file the prints subfolder (where the JPEG copies of the prints are
also saved)
Please note: The output setting must be set to "Print only", "Print and save JPEG copy" or "JPEG
copy only" in order to create the animated GIF. The GIF will not be created if the output is set to
"None". You also need to create a print layout which includes all the photos taken otherwise an error
will be displayed when the software tries to create the animated GIF.

Dithered vs Indexed Color
Animated GIFs can only display 256 different colors per frame which causes a problem when trying to
display photos which typically have many more colors. There are two ways to handle this limitation:
1) Dithered color where the color of each pixel is represented by several pixels
2) Indexed color where the 256 most common colors in the photo are used
Dithered images can give a better representation of the colors in the original photo but will provide less
detail for a given image size. Indexed colors give better detail and usually give adequate colors but
may show some contouring or shimmering with some photos, particularly if there are areas of
graduated color in the original photo.
Indexed color is recommended for most applications for animated GIFs and so the "Dither GIFs to give
better color" option should normally be left unchecked.

11.8

Keyboard Shortcuts
The photobooth mode in NKRemote can accept the following key presses:
F2 - switch to B&W mode and start the photobooth sequence
F3 - switch to color mode and start the photobooth sequence
T - switch to B&W (toned) mode and start the photobooth sequence
F4 - start the photobooth sequence using the current B&W or color setting
F5 - same as F4
F6 - reactivate live view and display ready.jpg screen if previously canceled or cancel live view and
display welcome.jpg screen if live view currently active
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Ctrl+Alt+F6 - switch from standby to ready mode
Ctrl+F1 - select "Standard" camera Picture Control
Ctrl+F2 - select "Neutral" camera Picture Control
Ctrl+F3 - select "Vivid" camera Picture Control
Ctrl+F4 - select "Monochrome" camera Picture Control
Ctrl+F5 - select "Portrait" camera Picture Control
Ctrl+F6 - select "Landscape" camera Picture Control
Ctrl+A - activate contrast detect AF (only available when live view is enabled)
Ctrl+B - switch to B&W mode but don't start the photobooth sequence
Ctrl+C - switch to color mode but don't start the photobooth sequence
Ctrl+K - switch to color mode but don't start the photobooth sequence (alternative for Ctrl+C)
Ctrl+Alt+P - display the reprint selection dialog
Ctrl+R - reprint the last set of photos without displaying the touchscreen keyboard or print confirmation
screens
Ctrl+Alt+R - reprint the last set of photos with touchscreen keyboard and print confirmation screens if
enabled
Shift+Ctrl+R - fast reprint of the last set of photos (if output option is set to "Print and save JPEG
copy")
Ctrl+T - switch to B&W (toned) mode but don't start the photobooth sequence
Ctrl+W - toggle between B&W and color modes
Ctrl+Z - take photo when the booth is running in clicker mode
A - Accept print when print confirmation window is displayed
W - cycle through color, B&W and B&W (toned) modes
X - Reject print when print confirmation window is displayed
Ctrl+1 - select one copy of prints
Ctrl+2 - select two copies of prints
Ctrl+3 - select three copies of prints
Ctrl+4 - select four copies of prints
Ctrl+5 - select five copies of prints
Ctrl+6 - select six copies of prints
Ctrl+7 - select seven copies of prints
Ctrl+8 - select eight copies of prints
Ctrl+9 - select nine copies of prints
Ctrl+Alt+1 - select profile 1 and start shooting sequence
Ctrl+Alt+2 - select profile 2 and start shooting sequence
Ctrl+Alt+3 - select profile 3 and start shooting sequence
Ctrl+Alt+4 - select profile 4 and start shooting sequence
Ctrl+Alt+5 - select profile 5 and start shooting sequence
Ctrl+Alt+6 - select profile 6 and start shooting sequence
Ctrl+Alt+7 - select profile 7 and start shooting sequence
Ctrl+Alt+8 - select profile 8 and start shooting sequence
Shift+Ctrl+1 - select profile 1
Shift+Ctrl+2 - select profile 2
Shift+Ctrl+3 - select profile 3
Shift+Ctrl+4 - select profile 4
Shift+Ctrl+5 - select profile 5
Shift+Ctrl+6 - select profile 6
Shift+Ctrl+7 - select profile 7
Shift+Ctrl+8 - select profile 8
Shift+Ctrl+9 - select profile 9
Shift+Ctrl+F1 - select profile 10
Shift+Ctrl+F2 - select profile 11
Shift+Ctrl+F3 - select profile 12
Shift+Ctrl+F4 - select profile 13
Shift+Ctrl+F5 - select profile 14
Shift+Ctrl+F6 - select profile 15
Shift+Ctrl+F7 - select profile 16
Shift+Ctrl+F8 - select profile 17
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Shift+Ctrl+F9 - select profile 18
Shift+Ctrl+N - select next profile
Shift+Ctrl+P - select previous profile
Number pad '+' - increase the number copies of prints (up to a maximum of 9 copies)
Number pad '-' - decrease the number copies of prints (down to a minimum of 1 copy)
b - cycle through number of copies of prints: 1,2,3,4,5,6,7,8,9,1,2,3...

11.9

Using External Buttons for Photobooth Shooting
This page describes a number of different options for connecting one or more pushbuttons to a PC
and use them to control the photobooth mode shooting mode.
Note: For a simple setup you can use the PC's mouse to control the photobooth by selecting the "Use
mouse left button to start and right button to toggle between B&W and color" option in the photobooth
settings.

StealthSwitch
The StealthSwitch is a robust foot switch which plugs straight into a USB port and makes an ideal
switch for photobooth operation. It is very simple to use: just plug it in to any spare USB port, wait a
few seconds for Windows to recognize it and you're ready to go. In full screen photobooth mode
pressing the StealthSwitch button will start the photobooth sequence - that's all there is to it.
Note: If you have already installed the "desktop cloaking" software that comes with the StealthSwitch
you need to disable it otherwise every time you press the button the photobooth display will be hidden.

Arcade Style Buttons
There are several ways arcade style buttons can be connected to a PC and used to control the
photobooth including the StealthSwitch 3 and the serial port method. The StealthSwitch 3 is simpler to
setup than the serial port method but is a little more expensive. Both the StealthSwitch 3 and the serial
port methods are described in detail below.
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StealthSwitch 3
The StealthSwitch 3 is similar to the original StealthSwitch described above but has two important
differences:
1) You can connect external buttons which simply plug into standard 3.5mm sockets (the same as
used by most MP3 players)
2) Each button is programmable allowing it to send any key press or sequence of key presses you like

StealthSwitch 3 showing the five 3.5mm sockets for connecting external buttons on the front and the
USB port on the side
Please note: The StealthSwitch 3 is functionally identical to the StealthSwitch II which it replaces.
Instructions to add an arcade style button using the StealthSwitch 3:
These are the components required to add an arcade style button: the button, stereo cable with 3.5mm
jacks and two female spade connectors
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1) Cut off the jack plug from one end of the stereo cable and bare the wires
2) Plug the USB cable from the StealthSwitch II and plug the remaining 3.5mm jack from the stereo
cable into one of the StealthSwitch sockets
3) Run StealthSwitch Configuration Utility and select "Keyboard test mode". When you press the each
button you should see something like this:

4) Release the switch and identify the correct wires to use from the stereo cable by shorting two of
them together. When the correct pair of wires are shorted together the keyboard test window will show
A, B, C, D or E
5) Attach the spade connectors to each of the two wires identified in step 4. Use a crimp tool or solder
them to ensure they are firmly attached
6) Connect the wire to the arcade switch using the spade connectors and press the button to check
that the keyboard test window shows A, B, C, D or E
You should now have an arcade button attached to a cable with a 3.5mm jack plug which looks
something like this:

Finally use the StealthSwitch Configuration Utility to program each of the buttons to send the required
key strokes. The best way to do this is to right click on the required button in the main Configurator
window and select "Macro 1", click on "1st KEY" and type the first key in the macro e.g. function key
F4 to start the photobooth sequence. If the macro has more than one key, e.g. Ctrl+B to select black
and white mode, click on "1st KEY" and press (and release) the Ctrl key then click on "2nd KEY" and
press C. When you've finished press the Program button to program the StealthSwitch 3 (you only
need to do this once - the StealthSwitch 3 will remember the settings and can be used on any
computer). The StealthSwitch 3 is now ready to be used to control the photobooth.

Serial Port Method
What you need
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1. Unless the PC has a serial port you will need a USB to RS-232 adaptor such as the StarTech.com
USB to RS-232 Serial DB9 Adaptor. This is not the cheapest adaptor available, but it does work on
Windows XP and Windows Vista.
2. DB9 socket and wires or an old RS-232 cable with a DB9 socket
3. A suitable "push to make" button. The arcade style button below was purchased from Gremlin
Solutions in the UK. This site in the US has a good selection of buttons: www.happcontrols.com
4. Photobooth Pushbutton Utility, PhotoboothBtn_NKRemote.exe, which can be found in the
NKRemote installation folder

Connecting it up
First install the driver software that comes with the USB to serial to RS-232 adaptor and connect it to a
USB port on your PC. Then run the Photobooth Pushbutton utility (PhotoboothBtn_NKRemote.exe):
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Next identify the correct COM port for the serial port. This can be done by using a small piece of wire
and connecting pins 1 and 4 on the DB9 connector (shown below). If the correct COM port is selected
the "Pin 1" checkbox in the Photobooth Pushbutton utility should be checked when pins 1 and 4 are
connected. If nothing happens try selecting a different COM port from the drop down list.

Now wire up the button or buttons to the appropriate pins on the DB9 socket e.g. if you're using two
buttons pin 4 should be connected to the "common" connections of the two buttons and pin 1 should
be connected to the "push to make" connection of one button and pin 6 to the "push to make"
connection of the other button. Normally the connections would be made by soldering the wires to the
DB9 connector but if you're not happy with soldering you can use an RS-232 cable instead and simply
cut off one end, identify which wires to use and then connect them to the spade connections on the
buttons using crimp connectors.
Once the buttons are connected they can be tested by observing whether the appropriate checkboxes
are checked in the pushbutton utility app when each button is pressed.
Finally, select the required action for each button using the drop down lists in the pushbutton utility e.g.
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for a two button setup with NKRemote where the user can select B&W or color prints you would use
settings similar to those below:

In operation
Connect the USB to RS-232 adaptor to a USB port on the PC and, making sure no buttons are
pressed, run the Photobooth Pushbutton utility. Before running NKRemote check that the buttons are
working properly by pressing them and making sure the correct checkbox in the pushbutton utility is
checked. It may be necessary to select a different COM port if the buttons don't work. Normally the
same COM port is assigned provided the USB to RS-232 adaptor is connected to the same USB port
each time.
Next run NKRemote, select fullscreen photobooth mode and you should be able to use the buttons to
trigger the photobooth sequence. The Photobooth Button utility needs to running at all times during
photobooth operation so that it can detect the button presses and forward them to NKRemote.

11.10 Creative Filters
The photobooth creative filters give the option of applying a variety of special effects to photobooth
photos and to the live view images displayed before taking the photos. The default filters include color
and monochrome negative images, color and monochrome posterization effects, desaturation and
over saturation effects and selective saturation. The filters are applied using a DLL which means that
experienced C or C++ programmers can write their own filters if required. A sample VC++ 2005 project
can be downloaded from http://www.breezesys.com/downloads/SampleCreativeFilter.zip
Please note that some filters may produce different results in the live view and final photos if flash is
used. This is because flash will probably give different highlight and shadow areas which will affect
how the posterization effects are applied. This is less of a problem if continuous lighting is used.
To use creative filters you need put a copy of the PhotoboothCreativeFilter.dll file in your photobooth
images folder. The PhotoboothCreativeFilter.dll file can be found in the installation folder (from the
installation folder (normally C:\Program Files (x86)\BreezeSys\NKRemote). Then when you enter full
screen photobooth mode the software will automatically load the filter DLL and the live view images will
display the default filter which is color negative. Type Ctrl+Shift+C to display the setup page to select a
different effect or to configure the settings. The following settings dialog will be displayed:
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The processing of the filters in real time for the live view display can put quite a load on the computer
which may cause the live view refresh rate to slow down. On a dual or quad core computer the load
can be shared between the processor cores by setting the number of threads to more than 1.
The filter type can be selected from the drop down list. The various filter types that are available with
the PhotoboothCreativeFilter.dll that comes with the software are described below.

Color negative
This filter creates a negative color image e.g. yellow items will appear as blue and blue items will
appear as red. There are no controls for adjusting how this filter behaves.

Original image
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Image with color negative filter applied

Monochrome negative
This filter converts the image to grayscale and displays the negative e.g. dark items will appear light
and light items will appear dark. There are no controls for adjusting how this filter behaves.

Image with the monochrome negative filter effect applied

Posterize
This filter produces a thresholding/posterization effect with an adjustable number of levels. The
strength slider controls the size of each threshold with 0 having no effect and 255 producing an image
just made up of fully saturated colors. The recommended range of settings is 10 to 100.
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Image with the posterize filter applied with the strength set to 70.

Monochrome posterize
This is a highly configurable filter which converts the images to monochrome then posterizes it and
colorizes with one or two colors. It's probably simpler to experiment with the different settings below
and see their effect than to try explain how this filter works. The settings are shown below:
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Strength - this controls the size of each threshold from 0, which has no effect, to 255 which gives only
a few solid colors.
White highlights - this controls whether bright highlights appear as one of the colors (top or bottom
color) or as white
Hue - this controls hue of the color displayed in the image
Saturation - this controls how strongly saturated the color is
Top Hue - this controls hue of the color displayed at the top of the image which randomly fades to the
main color at the bottom of the image. If this is set to 0 only the main color is used.
Top Saturation - this controls how strongly saturated the bottom color is

Image with the monochrome posterize filter applied: strength=53, base level=54, hue=8,
saturation=40, top hue=195, top saturation=100, white highlights=on
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Image with the monochrome posterize filter applied: strength=53, base level=54, hue=193,
saturation=40, top hue=0, top saturation=100, white highlights=on

Saturation
This filter allows the image saturation to be boosted to produce an over saturated image or reduced to
produce a more subtle desaturated image. Setting the strength to 100 will leave the saturation
unchanged.
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Image with the saturation filter applied: strength=200 (strongly increasing the saturation of the colors)

Image with the saturation filter applied: strength=10 (almost desaturating to grayscale)

Pop Art
This filter produces a three color "pop art" effect reminiscent of some of the work by Andy Warhol. The
photo is reduced to three colors: the background, dark areas of the subject and light areas.
This filter requires a green or a blue background and works best with continuous lighting rather than
flash. Set the threshold to a middle value (e.g. 140) and the sensitivity to a low value (e.g. 6) and then
adjust the background hue slider until the background is replaced with the background color for the
first photo (the default setting is red). A background hue setting of around 80 should be suitable with a
green background.
Then adjust the threshold and sensitivity sliders to get the desired result. The background, low light
and highlight colors used for each photo can be changed by clicking on them in the setup dialog.
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Set of 4 photos shot using the pop art filter

User selection of different filter effects
The settings for the filter are saved using the name of the photobooth images folder which means that
different effects can be applied in by using profiles to switch to different folders. For example users
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could be given the choice between normal, over saturated and under saturated colors by creating
three photobooth images folders:
C:\PhotoboothImages\normal
C:\PhotoboothImages\over
C:\PhotoboothImages\under
Then save the photobooth settings to three different settings files:
C:\PhotoboothImages\normal\settings.xml - with the photobooth images folder set to C:
\PhotoboothImages\normal
C:\PhotoboothImages\over\settings.xml - with the photobooth images folder set to C:
\PhotoboothImages\over
C:\PhotoboothImages\underl\settings.xml - with the photobooth images folder set to C:
\PhotoboothImages\under
Please note: if you are using a touchscreen you need to create touchscreen actions to load profiles 1
to 3 before saving the settings.
Next create three profiles:
Profile 1 loads C:\PhotoboothImages\normal\settings.xml
Profile 2 loads C:\PhotoboothImages\over\settings.xml
Profile 3 loads C:\PhotoboothImages\saturation\settings.xml
Then copy the PhotoboothCreativeFilter.dll to the "over" and "under" folders (don't copy it to the normal
folder). Now run the booth in full screen photobooth mode and select profile 2 to switch to the "over"
photobooth images folder. Type Shift+Ctrl+C to display the settings and select "Saturation" from the
filter type combo, set the strength to 200 and click on OK to save the settings. Next select profile 3 to
switch to the "under" photobooth images folder. Type Shift+Ctrl+C to display the settings and select
"Saturation" from the filter type combo, set the strength to 10 and click on OK to save the settings.
Check everything is working by selecting profile 1 which should display normal live view images, profile
2 which should display over saturated live view images and profile 3 which should display under
saturated images.
Please see the section on Saving settings for future reference and using profiles for more information
on using profiles.

Saving a copy of each filtered photo
There isn't a direct way to make a a full size copy of each photo with the creative filter applied, but the
following trick can be used instead. In full screen photobooth mode type Ctrl+G to display the green
screen settings dialog. An error dialog may be displayed if the photobooth images folder doesn't
contain a greenscreen_background.jpg image. If this happens press OK and the green screen setting
dialog will be displayed:
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Select the "Enable greenscreen display" and "Save copy of greenscreened photos in photo booth
mode" options. Then move the top slider to the right until the label displays "Green screening disabled"
and click on the "OK" button. With the above settings the software won't attempt to green screen the
images but it will save a full size copy of each photo in the greenscreen subfolder after applying the
creative filter.
Please note: It isn't possible to green screen images and apply creative filters.

11.11 In Operation
In Operation
Once everything is setup simply run NKRemote and press Ctrl+F4 to enter full screen mode and
display the ready screen. You probably don't want to have a keyboard on show otherwise users will be
able to exit the photobooth mode and access your computer. There are a number of methods that can
be used to start the photobooth shooting sequence:
1. The simplest option is to use a mouse and set the start option to "Left click to start, right click to
toggle B&W mode" or one of the other left click options. Provided the keyboard is hidden away the
users won't be able to access your computer but use the left mouse button to start the sequence
and the right mouse button to toggle between B&W and color photos.
2. Alternatively you could use a programmable USB input device which can be setup to send an F4
key press to NKRemote:
a) The Powermate from Griffin Technology (http://www.griffintechnology.com/products/powermate/)
is an inexpensive and nicely made device which works very well.
b) The StealthSwitch (http://www.stealthswitch.com) is a very robust foot switch which simply needs
to be plugged in to be used in fullscreen photobooth mode. No additional drivers need to be
installed. The desktop hiding software that comes with the StealthSwitch should be disabled
otherwise the photobooth screen will be hidden when the switch is pressed.
3. For a more professional setup you could use external panel mounted buttons.
4. Use a touchscreen and one of the left click start options
If "auto reconnect" is selected from the "Camera" menu the camera can be turned off when not in use
and then turned it back on again to automatically restart photobooth operation. When the camera is
turned off the camera_not_connected.jpg screen is displayed and when it is turned back on again the
ready.jpg screen is displayed.
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The keyboard shortcuts Ctrl+1, Ctrl+2, Ctrl+3, Ctrl+4, Ctrl+5, Ctrl+6, Ctrl+7, Ctrl+8 or Ctrl+9 can be
used to specify the number of copies of prints when running in full screen photobooth mode. The
number pad "add" and "subtract" keys can also be used to increase or decrease the number of copies.
A small confirmation message is displayed for approximately 2 seconds in the bottom right corner of
the display when the number of copies is changed.
A default profile can be used to reset the photobooth to a known state after each shooting sequence.
To exit fullscreen photobooth mode either press the Esc key or hold down the SHIFT key and press
the left mouse button.
The camera should be set to JPEG or raw+JPEG when using photobooth mode. Photobooth shooting
only uses JPEG images from the camera, but you can also save raw files for manual post processing
after the event by setting the camera to one of its raw+JPEG settings.

Reprints
The last print layout can be reprinted by typing Ctrl+R in full screen photobooth mode. Alternatively
select the output option to also save a JPEG copy and then use a browser or image editor to select
and print the required layout.

Reprint Selection Screen
A reprint selection screen is available from the ready screen which allows users (or the photobooth
operator) to quickly select a set of photos to be reprinted. The reprint selection screen can be
displayed by typing Ctrl+Alt+P or by using the "Display reprint screen" touchscreen action. This will
display a screen showing thumbnails of the JPEG copies of prints stored in the prints subfolder. The
user can select the photo to be reprinted using the touchscreen or by using the cursor keys or mouse if
no touchscreen is available. After selecting the photo it can be printed by pressing the Enter key or
typing A or by clicking on the printer icon in the center bottom of the screen. The user can also cancel
the reprint selection screen and return to the ready screen by typing Esc or X or by clicking on the
cancel icon at the right bottom of the screen. The reprint selection screen will also cancel automatically
if a timeout occurs.
Please note: The reprint selection screen is experimental in NKRemote v3.2 and may change in future
releases. The following settings can be adjusted using values stored in the Windows registry (please
exit NKRemote before changing these settings):
HKEY_CURRENT_USER\Software\BreezeSystems\NKRemote\100\ReprintThumbnailWidth - the
width of the thumbnails (default=300)
HKEY_CURRENT_USER\Software\BreezeSystems\NKRemote\100\ReprintThumbnailHeight - the
height of the thumbnails (default=300)
HKEY_CURRENT_USER\Software\BreezeSystems\NKRemote\100\ReprintThumbnailSpacing - the
spacing between thumbnails (default=10)
HKEY_CURRENT_USER\Software\BreezeSystems\NKRemote\100\ReprintThumbnailFontSize - the
size of the caption font (default=140 for 14 point font)
HKEY_CURRENT_USER\Software\BreezeSystems\NKRemote\100\ReprintThumbnailTextColor - the
color of the caption font when not selected (default=0 for black)
HKEY_CURRENT_USER\Software\BreezeSystems\NKRemote\100\ReprintThumbnailSelectedTextCo
lor - the color of the caption font when selected (default=0 for black)
HKEY_CURRENT_USER\Software\BreezeSystems\NKRemote\100\ReprintThumbnailSelectedOutline
Color - the color of the thumbnail outline when selected (default=0x000000ff for red)
HKEY_CURRENT_USER\Software\BreezeSystems\NKRemote\100\ReprintThumbnailSelectedBackgr
oundColor - the color of the thumbnail background when selected (default=0x00b4b4b4 for light gray)
HKEY_CURRENT_USER\Software\BreezeSystems\NKRemote\100\ReprintThumbnailTimeout - the
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timeout for automatically closing the screen (default=30 seconds)
HKEY_CURRENT_USER\Software\BreezeSystems\NKRemote\100\ReprintThumbnailShowMouse specifies whether the mouse pointer should be visiable (default=0 hide mouse pointer)
The bottom area of the reprint selection screen defaults to the Windows default background color with
a printer icon and a red cross to cancel the screen. The icons can be replaced by putting PNG images
named Printer-icon.png and Cancel-icon.png in your photobooth images folder. Alternatively you can
use create screen image named reprint.jpg in your photobooth images folder (please note that only the
bottom portion of the reprint.jpg screen will be visible).

Reprinting after an Event
If the output option was set to "Print and save JPEG copy" or "JPEG copy only" when the photos were
taken a JPEG copy of the printed output will be saved in the prints subfolder. The JPEG copies of the
printed output can be reprinted after an event by selecting "Print selected photobooth photos..." from
the File menu and then selecting one or more JPEGs for printing.
If a JPEG copy of the printed output is not available or you want to reprint the photos using a different
layout you can do it as follows:
1. Setup the printer and photobooth print layout as required
2. Use Windows Explorer to drag and drop the first set of photos into the NKRemote main window
3. Type Shift+Ctrl+R or select "Reprint photos" from the File menu and the photos will be printed
4. Repeat steps 2 and 3 to as required

Where Photos and GIFs are Saved
Photos taken by the camera are downloaded to the PC and saved in the download folder. The location
of the download folder is set in File->Preferences:
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The settings shown above will save photos and videos in a separate subfolder of C:\Photos for each
date.
e.g. photos and videos captured on June 15, 2016 are saved in:
C:\Photos\2016-06-15
The XML shooting information file (see below) is also saved in the download folder.
If the output is set to "Print and Save JPEG copy" or "Jpeg copy only" the JPEG copy of the printed
output will be saved in a subfolder of the download folder named "prints"
e.g. the JPEG copy of prints from photos taken on June 15, 2016 are saved in:
C:\Photos\2016-06-15\prints
If the option to create an animated GIF is selected the animated GIFs are saved in a subfolder of the
download folder named "GIF"
e.g. GIFs created on June 15, 2016 are saved in:
C:\Photos\2016-06-15\GIF
A quick method of showing where the photos are being saved is to exit full screen photobooth mode
and take a photo by pressing the shutter release on the camera or by pressing the "Release (F8)"
button in the main NKRemote window. When the photo is taken it is automatically downloaded to the
PC and saved on the hard disk in the download folder. The full pathname (i.e. download folder name
and image filename) will be displayed in the status line at the bottom of the main NKRemote window:
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XML Shooting Information
After each set of shots an XML file containing information about the set of photos is written to the
folder where the photos are downloaded from the camera. The XML file has the same filename as the
first shot in the sequence (but with a .XML file extension). An example XML shooting information file is
shown below:
<?xml version="1.0" ?>
<breeze_systems_photobooth version="1.1">
<photo_information>
<date>2011/01/26</date>
<time>16:37:19</time>
<user_data>sales@breezesys.com</user_data>
<photobooth_images_folder>C:\Photobooth\PhotoboothImages</photobooth_images_folder>
<caption1>First caption</caption1>
<caption2>Second caption</caption2>
<photos>
<photo image="1">20110126_163719_1.JPG</photo>
<photo image="2">20110126_163719_2.JPG</photo>
<photo image="3">20110126_163719_3.JPG</photo>
<photo image="4">20110126_163719_4.JPG</photo>
<output>prints\20110126_163719.jpg</output>
</photos>
</photo_information>
</breeze_systems_photobooth>

The <date> and <time> tags contain the date and time of the first shot in the sequence. Please note
that the date and time will only be correct if the camera's clock is set correctly. The camera's clock can
be automatically synchronized with the PC's time when it connects to the PC by selecting the
automatic synchronization option in the camera settings dialog.
The <user_data> tag contains the text entered by the user if the touchscreen keyboard option is used.
The <photobooth_images_folder> contains the full pathname of the photo booth images folder.
The <caption1> and <caption2> tags contain the text used for the captions printed on the photos or
empty strings if these are not defined.
The <photo> tags contain the filenames of the photos taken in the shooting sequence.
The <output> tag contains the filename of the JPEG copy of the printed output (if selected).
The writing of the XML shooting information file can be suppressed by setting the following value in the
Windows registry to 1:
HKEY_CURRENT_USER\Software\BreezeSystems\NKRemote\100\PhotoboothSuppressXml
This can be done by creating a text file named SuppressXML.reg containing the following and then
double clicking on the file in Windows Explorer to copy the information to the registry:
Windows Registry Editor Version 5.00
[HKEY_CURRENT_USER\Software\BreezeSystems\NKRemote\100]
"PhotoboothSuppressXml"=dword:00000001

Please note that this setting will be ignored and the XML will be written if the touchscreen keyboard
option is used.
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11.12 Green Screen Shooting
The photobooth mode in NKRemote v2.0 introduces green screen shooting. Green screen
photography works by taking photos of the subject in front of a green background and then
automatically replacing the background with a background image. The background image can be
anything you like such as an exotic location, a cityscape or even a photo of the President of the United
States.
NKRemote also supports blue screen shooting. This works in exactly the same way but uses a blue
background instead of a green background. To enable blue screen shooting select the "Blue screen
mode" checkbox when the green screen settings dialog is displayed.
NKRemote will automatically replace the green background with the chosen background when using
live view in photobooth mode and also when using the live view window. This means that the users will
see what the final picture will look like with the new background as opposed to the green background
that the cameras sees.
A basic green screen setup is shown below:

Basic green screen setup with green screened live view images displayed on the monitor

When the images are printed out as a double strip they look like this:
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Live view settings
To enable green screen shooting in normal live view mode first connect a camera and then select live
view from the Camera menu or by typing Ctrl+L. Then type Ctrl+G or right click on the live view display
and select "Green screen settings..." to display the green screen setup dialog:

First select the background image by pressing on the "..." button then click on the checkbox to enable
green screen display (not required in photobooth mode). Then adjust the sliders so that all of the green
screen background is replaced with the background image but the foreground subject is unaffected.
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The easiest way to do this is to move the "Green threshold" slider to the left until most of the
background is replaced and then fine tune the settings by moving the "Red level" and "Blue level"
sliders to the right. The best settings to use will depend on the lighting conditions and the quality of the
green background. If areas of the subject show the background the settings are too strong and should
be reduced by moving the red and blue sliders to the left of the green slider to the right.
For best results the avoid green background should be evenly lit and the subject should be positioned
to minimize shadows falling on the background.
Please note: The greenscreening is optimized for speed not quality in order to be able to display the
greenscreened images in the live view window in realtime. The quality should be good enough for
small photos and prints, but if you want large high quality results you may need to use specialist green
screen software such as FxHome PhotoKey.

Green Screen Shooting in Photo Booth Mode
To display the green screen settings in photo booth mode first connect a camera and then select full
screen photo booth mode. Then type Ctrl+G to display the green screen settings:

The left hand side of the screen shows the live view display and the right hand side shows a green
screened copy of the last photo taken by the camera. Press the "Take Test Photo" button to take a test
photo if no photo is displayed on the right.
If continuous lighting is being used the same settings can be used for the live view and the final photos
and the "Use same settings as live view" checkbox can be selected. When the "Use same settings as
live view" checkbox is selected any adjustments made to the green screen settings for live view will
also be applied to the photos.
If flash is being used it is likely that the lighting for live view is not the same as that for used for the
actual photos and the "Use same settings as live view" checkbox should be unchecked so that
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different adjustments can be used for the live view images and the actual photos.
Select the "Enable green screen display" checkbox to enable green screen shooting. Then adjust the
sliders so that all of the green screen background is replaced with the background image but the
foreground subject is unaffected. Please see the section headed "Adjusting the green screen settings"
below for information on how to adjust the settings to get the best results.
Select the "Save copy of greenscreened photos in photo booth mode" option to save a of the photo
downloaded from the camera with the green background replaced with the background image. The
greenscreened copies are saved the "greenscreen" subfolder of the folder where the images from the
camera are saved. The greenscreened copy will be saved as a JPEG image unless the transparent
background option is selected in which case it will be saved as a PNG file.
Select the "Transparent background (print without overlay or background)" option to save the photos
as a PNG image with a transparent overlay. When this option is selected the images displayed in the
live view will be shown against the selected background image but the photos added to the print layout
will have a transparent background.
By default the photos taken by the camera will fill the green screen background. Select the "Adjust
position of photo within background" option if you want to place the photos in just one part of the
background. Use the "Scale factor" slider to adjust the size of the photo and the "X offset" and "Y
offset" sliders to adjust the position.
In full screen photo booth mode the green screen background and overlay images are loaded from the
photo booth images folder. The background image should be named greenscreen_background.jpg
and the overlay image should be named greenscreen_overlay.png. Different overlays and
backgrounds can be used for each shot by appending the shot number to the filenames e.g.
Shot 1: background filename: greenscreen_background_1.jpg, overlay filename:
greenscreen_overlay_1.png
Shot 2: background filename: greenscreen_background_2.jpg, overlay filename:
greenscreen_overlay_2.png
Shot 3: background filename: greenscreen_background_3.jpg, overlay filename:
greenscreen_overlay_3.png
Shot 4: background filename: greenscreen_background_4.jpg, overlay filename:
greenscreen_overlay_4.png
An different overlay and background file can be displayed in the live view by appending _live_view to
the filename. This is useful if the background or overlay contains text and the live view is mirrored
because it means versions of the background and overlay with no text can be used for live view
instead of displaying mirrored text. Example filenames:
Shot 1: live view background and overlay filenames: greenscreen_background_1_live_view.jpg,
greenscreen_overlay_1_live_view.png
background and overlay files applied to the prints: greenscreen_background_1.jpg, filename:
greenscreen_overlay_1.png
Shot 2: live view background and overlay filenames: greenscreen_background_2_live_view.jpg,
greenscreen_overlay_2_live_view.png
background and overlay files applied to the prints: greenscreen_background_2.jpg, filename:
greenscreen_overlay_2.png
Shot 3: live view background and overlay filenames: greenscreen_background_3_live_view.jpg,
greenscreen_overlay_3_live_view.png
background and overlay files applied to the prints: greenscreen_background_3.jpg, filename:
greenscreen_overlay_3.png
Shot 4: live view background and overlay filenames: greenscreen_background_4_live_view.jpg,
greenscreen_overlay_4_live_view.png
background and overlay files applied to the prints: greenscreen_background_4.jpg, filename:
greenscreen_overlay_4.png
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Backgrounds and overlays can also be switched by saving a number of different profiles each using a
different photo booth images folder containing different greenscreen_background.jpg and
greenscreen_overlay.png images. The user can then select the different backgrounds using the profile
shortcut keys. You can also switch green screen backgrounds and overlays by copying the new
greenscreen_background.jpg and greenscreen_overlay.png images into the photo booth images folder
while the booth is running.
Please note: Green screen should be enabled before saving the settings to file when using profiles to
switch backgrounds. If green screen is not enabled when the settings are saved green screen will be
disabled when the saved settings are loaded using a profile.

Adjusting the green screen settings
To get the best results you need a non-reflective background which is pure green. Try to keep the
lighting of the background as even as possible and avoid shadows cast by the people standing in front
of the background. If you are using a cloth background try to avoid creases as these will result in an
even green background.
Three different chroma keying methods are available:
1. Hue/Saturation - this method is suitable for for both green screen and blue screen shooting and
gives the best results under good lighting conditions
2. RGB Green screen - this method is only suitable for shooting green screen. It can give better results
than the hue/saturation method if the lighting is poor
3. RGB Blue screen - this method is only suitable for shooting blue screen.
Which method works best may depend on your lighting setup and background. Under most lighting
conditions the "hue/saturation" method should give the better results, particularly if the background
isn't pure green.
The "RGB Green screen" and "RGB Blue screen" methods are the same methods as used in versions
of NKRemote up to version v3.4.
Adjusting the settings when using the "Hue/Saturation" method
First select "Hue/saturation" from the "Method:" dropdown list at the top of the green screen settings
dialog:
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Then set the "Hue:" slider to 120 (or 240 if shooting against a blue background), the "Hue variation:"
slider to 5 and the "Saturation threshold:" slider to 45
Next adjust the "Hue:" slider until most of the background is replaced. The selected color is displayed
to the right of the slider.
Then adjust the "Hue variation" and "Saturation threshold" sliders until all of the green background is
replaced. Ask someone to stand in front of the green background to check the settings (or take a test
photo when using photo booth mode). If parts of their clothing are being replaced by the background it
may mean that the hue variation setting is too high and should be reduced. Normally the "Hue
variation" slider can be set to 20 or less.
The "Saturation threshold" slider sets the minimum saturation level that will be treated as background.
Normally the background will be pure green or pure blue and will be highly saturated and the
"Saturation threshold" slider can be set to 45 or more. Using a higher value will reduce the chances of
dark areas (e.g. black clothing) from being replaced with the green screen background.
Adjusting the settings when using the "RGB Green screen" method
This method is only suitable for shooting against a green background. First select "RGB Green screen"
from the "Method:" dropdown list at the top of the green screen settings dialog:
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Start by setting the green threshold to 30, the red level to 230 and the blue level to 222. Then move the
"Green threshold" slider to the left until most of the background is replaced. Fine tune the settings by
moving the "Red level" and "Blue level" sliders to the right. The best settings to use will depend on the
lighting conditions and the quality of the green background. If areas of the subject show the
background the settings are too strong and should be reduced by moving the red and blue sliders to
the left or the green slider to the right.
Adjusting the settings when using the "RGB Blue screen" method
This method is only suitable for shooting against a blue background. First select "RGB Blue screen"
from the "Method:" dropdown list at the top of the green screen settings dialog:
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Start by setting the blue threshold to 30, the red level to 230 and the green level to 222. Then move the
"Blue threshold" slider to the left until most of the background is replaced. Fine tune the settings by
moving the "Red level" and "Green level" sliders to the right. The best settings to use will depend on
the lighting conditions and the quality of the blue background. If areas of the subject show the
background the settings are too strong and should be reduced by moving the red and green sliders to
the left or the blue slider to the right.

11.13 Live View Overlay
Photo Booth Mode
An optional overlay image can be displayed over the live view images in fullscreen photobooth mode to
add fun effects such as superimposing a body builder's body with the user's head. It can also be used
to create fancy borders for the live view images to give the booth a more custom feel.
The overlay image should be a PNG file with transparency information in the alpha channel. It should
be in landscape orientation with an aspect ratio of 3:2 e.g. 1056x704 pixels in size. If the aspect ratio
of the overlay image isn't the same as the live view images it will be stretched to fit and may appear
distorted.
The overlay file should be named live_view_overlay.png and saved in the photobooth images folder.
Please note: The live view overlay image only affects the live view images displayed to the user and
won't appear in the printed output. To overlay the images in the printed output create a copy of the
live_view_overlay.png file called image_overlay.png and save it in the the photobooth images folder.
Overlays can also be used in conjunction with green screen shooting to provide effects such as
foregrounds or overlays to mock up a magazine cover.
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11.14 How to create PNG images using Photoshop
How to create PNG images using Photoshop
First create a new image with a transparent background. Then create a mask by clicking on the "Add
layer mask" in the layers palette.
Next add the graphics such as text overlays and picture frames to the image layer and use the layer
mask to control the transparency. In the layer mask white represents opaque, black represents fully
transparent and values between white and black represent increasing transparency.
Save a copy of the image as a PSD file for future reference and then save the image as a PNG file
named overlay.png.
An existing PNG image containing trnasparency information in the alpha channel can be edited in
Photoshop by loading it into Photoshop. The layer mask containing the transparency information can
be recreated by selecting Layer->Layer Mask->From Transparency.

Photoshop Elements
First create a new image with a transparent background. Next add the graphics such as text overlays
and picture frames and use the opacity slider for the layers to control opacity. To get a simple fade
effect, you can also use the gradient tool. Once you’re happy with your image, save a copy as a PSD
file for future reference and then save the image as a PNG file named overlay.png.

11.15 Uploading to Social Networking and Photo Sharing Sites
Uploading photos to the user's personal Facebook page
Users can upload photos to their personal Facebook page directly from the photo booth if it has an
internet connection and either a touchscreen or a keyboard to enter their Facebook login information.
The simplest way to set this up is to use the photo booth setup wizard and then adjust the settings if
required. After running the photo booth setup wizard the Facebook settings can editing using the dialog
below. This dialog can be opened by opening the "Photobooth Settings" dialog (File->Photobooth
Settings... or Ctrl+S) then opening the "Output Settings" dialog clicking on the "Settings..." button to the
right of the output options and then clicking on the Facebook upload "Settings..." button.
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The album name setting specifies the name of the album that will be created on the user's Facebook
page. Tokens for the date and time can be included in album name and will be replaced with the date
or time the photos were taken when they are uploaded e.g.
%L will be replaced with the long date representation for your computer's locale e.g. Wednesday, June
08, 2015
%l will be replaced with the long date and time representation for your computer's locale e.g.
Wednesday, June 08, 2015 20:23:56
Please see the tokens section for a list of available tokens.
Please note: It is no longer possible to specify the album or photo description when uploading photos
to Facebook. This option was removed in NKRemote v3.3 to comply with current Facebook policy:
Facebook Platform Policy 2.3. This states that an app can only populate the user message with
content manually entered by the user. The user can enter a message by using the keyboard.xml file to
add prompt3 when the touchscreen keyboard is asking the user to their Facebook username
(prompt1) and password (prompt2). Only the text entered by the user will be used for the photo
description. Please see the "Touchscreen Keyboard" section for information on customizing the
touchscreen keyboard.
The photo that is uploaded to the user's Facebook page is based on the JPEG copy of the printed
output. You can crop, resize and rotate the image before uploading it to Facebook.
To crop the image first check the "Crop image:" checkbox and then specify the left offset and top
offset in pixels for the top left corner of the cropped image. Then specify the width and height of the
image in pixels. For example if the photo booth is setup to print a double strip of 4 images on 6"x4"
paper you may wish to crop the image uploaded to Facebook so that only a single strip is sent. If the
printer is set to a resolution of 300 dpi the image will be 1200 pixels wide (4" x 300 dpi) by 1800 pixles
high (6" x 300 DPI) and so to crop it into a single strip you need to set left=0, top=0, width=600 and
height=1800.
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You can also specify a maximum size for the image being uploaded using the "Max width (pixels):" and
"Max height (pixels):" settings. The JPEG copy of the printed output will be resized so that it is no
bigger than these settings before it is uploaded to Facebook. Keeping these values relatively small, e.
g. 500 x 500 pixels, will reduce the time it takes to upload the file.
Depending on you printer page settings the JPEG copy of the printed output may not be saved in the
correct orientation. If this is the case it can be rotated using the "Image rotation:" dropdown list. If you
are also using print preview (the "Confirm before printing" option in the the "Photobooth Settings"
dialog) this can be set to "Same as print preview" and it will use the same rotation settings as the print
preview.
Please note that the image is cropped first, then resized and finally rotated before being uploaded to
Facebook.
Animated GIFs can be uploaded directly to the user's Facebook time-line (the GIFs are hosted on
Giphy.com and a link is placed in the Facebook post). However, animated GIF files can be very large
and so an optional script can be used to create an MP4 copiy of the GIF and the MP4 file can be
loaded instead. Select the "Use MP4 copy of animated GIF if available" option to enable the uploading
of MP4 files instead of GIFs. Please see the animated GIF section for details of how to create
animated GIFs.
GIFs and MP4 files will be sent without being resized or cropped.
Select the "Log uploads to file:" checkbox to log Facebook uploads to a CSV file. Then either type in
the filename of the log file in the editbox or click on the "..." to open a file browser. The log file contains
a line for each Facebook upload attempt containing the following comma separated values: the date in
the format YYYYMMDD, the time in the format HHMMSS, the Facebook username prefixed with
FACEBOOK_USERNAME: and with @ characters replaced by _ , the status (1=success, 0=failure)
and the filename of the image file e.g.
20140114,174842,FACEBOOK_USERNAME:test_gmail.com,1,C:
\Users\Chris\Documents\PhotoboothImages\2014-01-14\prints\140114_174826.jpg
Please note: The log file only contains the date/time, username, filename and whether the upload was
successful. The user's password is NOT recorded and therefore the log file cannot be used to upload
photos to Facebook after the event.
In Operation
When the photo booth is run and the photos have been taken the print preview screen will be
displayed first (if "Confirm before printing" is selected) and then when the user selects "Print" the
sharing screen (share.jpg) will be displayed. If the user selects "Cancel" in the print preview screen the
sharing screen won't be displayed and the booth will return to the ready screen (ready.jpg). If the
"Confirm before printing" option is not selected the sharing screen will be displayed after taking the
photos.
When the sharing screen (share.jpg) the user has the option to upload the photo to Facebook by
touching the Facebook button on the touchscreen or by typing F if they are using a normal keyboard.
The sharing screen can be exited by touching the "Cancel" button on the touchscreen or by typing X or
Esc on a normal keyboard. The sharing screen will also exit automatically if the user does nothing and
the screen timeout occurs. The sharing screen timeout can be specified in the "Output Settings"
dialog.
When the user selects Facebook upload the touchscreen keyboard will be displayed allowing them to
enter their Facebook user name and password. The user can enter their user name and password by
tapping on the touchscreen keyboard or by typing them in using a normal keyboard. The user can then
either tap on the "Cancel" button (or type Esc) to cancel the upload or tap on the "Upload photo" button
(or press the keyboard Enter key) to start the upload. The touchscreen keyboard will cancel
automatically if the user doesn't tap the touchscreen or type anything and the keyboard timeout occurs.
The keyboard timeout can be specified in the "Touchscreen Settings" dialog which can be displayed
from the "Photobooth Settings" dialog.
When the user has entered their Facebook user name and password and selected "Upload photo" the
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Facebook login screen (fb_login.jpg) will be displayed together with a small web browser window
showing the Facebook login page. The user must tap the "Ok" button or press the Enter key on the
keyboard to login to Facebook. If this is the first time the user has uploaded a photo they will need to
authorize the PhotoBoothUploader app by tapping the "Ok" button (or pressing the Enter key on the
keyboard) when the next two Facebook screens are displayed. If the user decides not to authorize the
PhotoBoothUploader app by tapping the "Cancel" button the upload will be aborted and the login
failure screen (fb_login_failure.jpg) will be displayed for a few seconds and then the screen will return
to the sharing screen.
After the user has logged in and authorized the PhotoBoothUploader app the upload will start and the
Facebook upload screen (fb_upload.jpg) will be displayed. If the upload is successful the Facebook
success screen (fb_success.jpg) will be displayed for a few seconds and then the screen will return to
the sharing screen. If there is an error (e.g. the internet connection was lost) the Facebook error
screen (fb_error.jpg) will be displayed for a few seconds and then the screen will return to the sharing
screen.
If there is a timeout waiting for the user to login and authorize the PhotoBoothUploader app the upload
will be aborted and the timeout screen (fb_timeout.jpg) will be displayed for a few seconds and then
the screen will return to the sharing screen.
The sharing screen can also be displayed from the ready screen using the keyboard shortcut
Shift+Ctrl+S or the "Display sharing screen" touchscreen action.
If you have problems with the Windows Taskbar appearing when uploading photos to Facebook you
can run the HideWindowsTaskbar.exe utility to hide the Windows taskbar. HideWindowsTaskbar.exe
will automatically hide the Windows taskbar when NKRemote is running in full screen photo booth
mode. HideWindowsTaskbar.exe can be found in the NKRemote installation folder (usually C:
\Program Files (x86)\BreezeSys\NKRemote on 64-bit Windows).
Please note: The user's Facebook username and password are private and are not saved by the
photo booth software. There is no offline option for Facebook uploads because users need to enter
both their username and password to allow uploading to their Facebook account and no system should
ever keep a record of users' passwords.

Posting photos to the user's Twitter account (tweeting)
Users can post photos to their personal Twitter account directly from the photo booth if it has an
internet connection and either a touchscreen or a keyboard to enter their Twitter login information. The
simplest way to set this up is to use the photo booth setup wizard and then adjust the settings if
required. After running the photo booth setup wizard the Twitter settings can editing using the dialog
below. This dialog can be opened by opening the "Photobooth Settings" dialog (File->Photobooth
Settings... or Ctrl+S) then opening the "Output Settings" dialog clicking on the "Settings..." button to the
right of the output options and then clicking on the Twitter "Settings..." button.
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The comment setting specifies text that will be used in the tweet. Twitter limits messages to 140
characters but approximately 20 characters are required for the URL when posting photos and so the
maximum usable message size is 120 characters. Tokens for the date and time can be included in
text and will be replaced with the date or time the photos were taken when they are uploaded e.g.
%L will be replaced with the long date representation for your computer's locale e.g. Wednesday, June
08, 2015
%l will be replaced with the long date and time representation for your computer's locale e.g.
Wednesday, June 08, 2015 20:23:56
Please see the tokens section for a list of available tokens.
The photo that is tweeted is based on the JPEG copy of the printed output. You can crop, resize and
rotate the image before it is tweeted.
To crop the image first check the "Crop image:" checkbox and then specify the left offset and top
offset in pixels for the top left corner of the cropped image. Then specify the width and height of the
image in pixels. For example if the photo booth is setup to print a double strip of 4 images on 6"x4"
paper you may wish to crop the image uploaded to Facebook so that only a single strip is sent. If the
printer is set to a resolution of 300 dpi the image will be 1200 pixels wide (4" x 300 dpi) by 1800 pixles
high (6" x 300 DPI) and so to crop it into a single strip you need to set left=0, top=0, width=600 and
height=1800.
You can also specify a maximum size for the image being uploaded using the "Max width (pixels):" and
"Max height (pixels):" settings. The JPEG copy of the printed output will be resized so that it is no
bigger than these settings before it is tweeted. Keeping these values relatively small, e.g. 500 x 500
pixels, will reduce the time it takes to upload the file.
Depending on you printer page settings the JPEG copy of the printed output may not be saved in the
correct orientation. If this is the case it can be rotated using the "Image rotation:" dropdown list. If you
are also using print preview (the "Confirm before printing" option in the the "Photobooth Settings"
dialog) this can be set to "Same as print preview" and it will use the same rotation settings as the print
preview.
Please note that the image is cropped first, then resized and finally rotated before being tweeted.
Select the "Log uploads to file:" checkbox to log tweets to a CSV file. Then either type in the filename
of the log file in the editbox or click on the "..." to open a file browser. The log file contains a line for
each tweet attempt containing the following comma separated values: the date in the format
YYYYMMDD, the time in the format HHMMSS, the Twitter username prefixed with
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TWITTER_USERNAME: and with @ characters replaced by _ , the status (1=success, 0=failure) and
the filename of the image file e.g.
20151214,174842,TWITTER_USERNAME:test_gmail.com,1,C:
\Users\Chris\Documents\PhotoboothImages\2015-12-14\prints\151214_174826.jpg
Please note: The log file only contains the date/time, username, filename and whether the upload was
successful. The user's password is NOT recorded and therefore the log file cannot be used to tweet
the photos after the event.
In Operation
When the photo booth is run and the photos have been taken the print preview screen will be
displayed first (if "Confirm before printing" is selected) and then when the user selects "Print" the
sharing screen (share.jpg) will be displayed. If the user selects "Cancel" in the print preview screen the
sharing screen won't be displayed and the booth will return to the ready screen (ready.jpg). If the
"Confirm before printing" option is not selected the sharing screen will be displayed after taking the
photos.
When the sharing screen (share.jpg) the user has the option to tweet the photo by touching the Twitter
button on the touchscreen or by typing T if they are using a normal keyboard. The sharing screen can
be exited by touching the "Cancel" button on the touchscreen or by typing X or Esc on a normal
keyboard. The sharing screen will also exit automatically if the user does nothing and the screen
timeout occurs. The sharing screen timeout can be specified in the "Output Settings" dialog.
When the user selects the Twitter option the touchscreen keyboard will be displayed allowing them to
enter their Twitter user name and password. The user can enter their user name and password by
tapping on the touchscreen keyboard or by typing them in using a normal keyboard. The user can then
either tap on the "Cancel" button (or type Esc) to cancel the upload or tap on the "Upload photo" button
(or press the keyboard Enter key) to start the upload. The touchscreen keyboard will cancel
automatically if the user doesn't tap the touchscreen or type anything and the keyboard timeout occurs.
The keyboard timeout can be specified in the "Touchscreen Settings" dialog which can be displayed
from the "Photobooth Settings" dialog.
When the user has entered their Twitter user name and password and selected "Upload photo" the
Twitter login screen (twitter_login.jpg) will be displayed together with a small web browser window
showing the Twitter login page. The user must tap the "Ok" button or press the Enter key on the
keyboard to login to Twitter and give the application to tweet the photo.
After the user has logged in and authorized the PhotoboothUploader app the upload will start and the
Twitter upload screen (twitter_upload.jpg) will be displayed. If the upload is successful the Twitter
success screen (twitter_success.jpg) will be displayed for a few seconds and then the screen will
return to the sharing screen. If there is an error (e.g. the internet connection was lost) the Twitter error
screen (twitter_error.jpg) will be displayed for a few seconds and then the screen will return to the
sharing screen.
If there is a timeout waiting for the user to login and authorize the PhotoBoothUploader app the upload
will be aborted and the timeout screen (fb_timeout.jpg) will be displayed for a few seconds and then
the screen will return to the sharing screen.
The sharing screen can also be displayed from the ready screen using the keyboard shortcut
Shift+Ctrl+S or the "Display sharing screen" touchscreen action.
If you have problems with the Windows Taskbar appearing when uploading photos to Facebook you
can run the HideWindowsTaskbar.exe utility to hide the Windows taskbar. HideWindowsTaskbar.exe
will automatically hide the Windows taskbar when NKRemote is running in full screen photo booth
mode. HideWindowsTaskbar.exe can be found in the NKRemote installation folder (usually C:
\Program Files (x86)\BreezeSys\NKRemote on 64-bit Windows).
Please note: The user's Twitter username and password are private and are not saved by the photo
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booth software. There is no offline option for Twitter tweets because users need to enter both their
username and password to allow posting to their Twitter account and no system should ever keep a
record of users' passwords.

Emailing photos
Users can email photos directly from the photo booth if it has an internet connection and either a
touchscreen or a keyboard to enter their email address. If an internet connection is not available at an
event the email addresses can be saved and the emails sent later by selecting the offline email mode.
The simplest way to set this up is to use the photo booth setup wizard and then adjust the settings if
required. After running the photo booth setup wizard the email settings can editing using the dialog
below. This dialog can be opened by opening the "Photobooth Settings" dialog (File->Photobooth
Settings... or Ctrl+S) then opening the "Output Settings" dialog clicking on the "Settings..." button to the
right of the output options and then clicking on the email photo "Settings..." button.

The "Subject:" text box defines the text in the subject line of the email.
The body text of the message can be specified in plain text or in HTML format to provide more control
over its appearance. When using the HTML format the token {image} represents the URL of the photo
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to be emailed and can be used with HTML <img> tag e.g. <img src="{image}">.
Tokens for the date and time can be included in the email subject and message text fields and will be
replaced with the date or time the photos were taken when they are uploaded e.g.
%L will be replaced with the long date representation for your computer's locale e.g. Wednesday,
January 08, 2014
%l will be replaced with the long date and time representation for your computer's locale e.g.
Wednesday, January 08, 2014 20:23:56
{sharingMessage} is replaced with contents of the second text entry field (if defined) in the
touchscreen keyboard used for entering the user's email address. This allows the user to enter an
optional message when emailing photos.
Please see the tokens section for a list of available tokens.
When sending photos the photo that is emailed is based on the JPEG copy of the printed output. You
can crop, resize and rotate the image before it is emailed to the user.
To crop the image first check the "Crop image:" checkbox and then specify the left offset and top
offset in pixels for the top left corner of the cropped image. Then specify the width and height of the
image in pixels. For example if the photo booth is setup to print a double strip of 4 images on 6"x4"
paper you may wish to crop the image so that only a single strip is emailed to the user. If the printer is
set to a resolution of 300 dpi the image will be 1200 pixels wide (4" x 300 dpi) by 1800 pixles high (6" x
300 DPI) and so to crop it into a single strip you need to set left=0, top=0, width=600 and height=1800.
You can also specify a maximum size for the image being uploaded using the "Max width (pixels):" and
"Max height (pixels):" settings. The JPEG copy of the printed output will be resized so that it is no
bigger than these settings before it is emailed. Keeping these values relatively small, e.g. 500 x 500
pixels, will reduce the time it takes to send the email.
Depending on you printer page settings the JPEG copy of the printed output may not be saved in the
correct orientation. If this is the case it can be rotated using the "Image rotation:" dropdown list. If you
are also using print preview (the "Confirm before printing" option in the the "Photobooth Settings"
dialog) this can be set to "Same as print preview" and it will use the same rotation settings as the print
preview.
Please note that the image is cropped first, then resized and finally rotated before being emailed to the
user.
Select the "Use MP4 copy of animated GIF if available" option to enable the uploading of the MP4 copy
of animated GIFs. Please see the animated GIF section for details of how to create animated GIFs.
GIFs and MP4 files will be sent without being resized or cropped.
The email server settings also need to be setup so that the program can email the photos. The "Email
Server Settings" dialog can be opened by selecting "Email Server Settings..." from the File menu or by
clicking on the "Email server settings..." button in the "Output Settings" dialog. The "Email Server
Settings" dialog shown below will be displayed:
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To send an email you need to specify the host name and port number of your email server. Most email
servers also require a username and a password to prevent unauthorized users from sending spam
emails. For additional security select the "Use SSL for secure email" option to send the email using
SSL. The port number should normally be set to 587 when using SSL secure email or 25 otherwise
(please check the port numbers used by your ISP). Google's free GMail service is a convenient way to
send emails and can be set up using the settings shown above and replacing yourname@gmail.com
with your GMail email address and entering your password.
Set the "Email addr:" to the sender's email address. To include the name of the sender with the email
address enter it as the name followed by the email address enclosed in angle brackets e.g. "Acme
Photo Booth <photobooth@acme.com>". Most free email services require the sender's email address
to the be the same as that of the email account specified by the username and password.
Please note: If you are using GMail to send emails you need to go to your Google account settings
and set the "Access for less secure apps" option to "Turn on" otherwise GMail will refuse to send the
email.
The settings can be verified by sending a test email by entering the destination email address and then
clicking on the "Send test email to:" button. The email status and any error messages will be displayed
in the status area at the bottom of the dialog.
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Select the "Log email addresses to file:" checkbox to log the email addresses to a CSV file. Then
either type in the filename of the log file in the editbox or click on the "..." to open a file browser. The
log file contains a line for each email containing the following comma separated values: the date in the
format YYYYMMDD, the time in the format HHMMSS, the email address, the status (1=success,
0=failure) and the filename of the image file e.g.
20140114,174842,test@gmail.com,1,C:\Users\Chris\Documents\PhotoboothImages\2014-01-14
\prints\140114_174826.jpg
In Operation
When the photo booth is run and the photos have been taken the print preview screen will be
displayed first (if "Confirm before printing" is selected) and then when the user selects "Print" the
sharing screen (share.jpg) will be displayed. If the user selects "Cancel" in the print preview screen the
sharing screen won't be displayed and the booth will return to the ready screen (ready.jpg). If the
"Confirm before printing" option is not selected the sharing screen will be displayed after taking the
photos.
When the sharing screen (share.jpg) the user has the option to email the photo by touching the email
button on the touchscreen or by typing E if they are using a normal keyboard. The sharing screen can
be exited by touching the "Cancel" button on the touchscreen or by typing X or Esc on a normal
keyboard. The sharing screen will also exit automatically if the user does nothing and the screen
timeout occurs. The sharing screen timeout can be specified in the "Output Settings" dialog.
When the user selects email photo the touchscreen keyboard will be displayed allowing them to enter
the email address. The user can enter the email address by tapping on the touchscreen keyboard or
by typing it in using a normal keyboard. The user can then either tap on the "Cancel" button (or type
Esc) to cancel the email or tap on the "Send email" button (or press the keyboard Enter key) to start
the upload. The touchscreen keyboard will cancel automatically if the user doesn't tap the touchscreen
or type anything and the keyboard timeout occurs. The keyboard timeout can be specified in the
"Touchscreen Settings" dialog which can be displayed from the "Photobooth Settings" dialog.
When the user has entered their email address and selected "Send email" the email upload screen
(email_photo.jpg) will be displayed and the photo will be emailed. If the email is successful the email
success screen (email_success.jpg) will be displayed for a few seconds and then the screen will return
to the sharing screen. If there is an error (e.g. the internet connection was lost) the email error screen
(email_error.jpg) will be displayed together with an error message in the bottom right hand corner.
After a few seconds the screen will return to the sharing screen.
The sharing screen can also be displayed from the ready screen using the keyboard shortcut
Shift+Ctrl+S or the "Display sharing screen" touchscreen action.
Email "Offline Mode" and sending emails after an event
If no internet connection is available at an event you can save user's email addresses and send the
emails later when an internet connection is available. To do this you need to enable "Email photo" in
the "Sharing" section of the "Output Settings" dialog and also select the "Offline mode" option. You
also need to select the "Log email addresses to file" in the "Email Server Settings" dialog - this will
save the user's email address together with the filename of their photos.
The emails can be sent when an internet connection is available by selecting "Send emails..." from the
"File" menu in the main window. When you select this you will be asked the log file to read (this
defaults to the email log file specified in the "Email Server Settings"). The "Unsent Emails" dialog will
be displayed listing the date/time, email address and photo for unsent emails found in the log file.
Select the emails you wish to send and then press the "Send" button to send them.
Please note: The email and text log files have the same formats and so email addresses and
cellphone numbers can be saved in the same log file.

Sending an MMS (or SMS)
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MMS messages can be sent in the US and Canada using a web-based service called Twilio (www.
twilio.com). In other countries the message can be sent as an SMS message with a link to the photo.
Most cellphones should recognize the link as a link to a web server and open a web browser on the
user's cellphone to view the photo. Please note that the image link in an SMS will only be valid for 7
days.
To use this service you need an account with Twilio and enter your Twilio account details in the MMS
setting dialog. Twilio charge for each MMS or SMS message sent using their service. Please see their
website for pricing information.
The maximum image file size that can be sent is 1 MB, but Twilio may resize the image file to conform
to the cellphone service provider's size requirements.
When the user taps the MMS icon in the sharing screen a touchscreen keyboard will displayed to allow
the user to enter their cellphone number. Please see the touchscreen keyboard section for information
on how to customize its layout and appearance.
The MMS settings need to be setup so that the program can send the texts via Twilio. The "MMS
Settings" dialog can be opened by clicking on the "SMS/MMS settings..." button in the "Output
Settings" dialog. The "MMS Settings" dialog shown below will be displayed:
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Enter your Twilio message phone number, AccountSID and AuthToken in the "MMS Settings" dialog.
You can find your Twilio message phone number, AccountSID and AuthToken by logging into your
Twilio account.
Set the country prefix to your country prefix e.g. +1 for the US and Canada, +44 for the UK, +49 for
Germany etc. When users enter their cellphone numbers they can either enter the number with their
country prefix e.g. +1234567890 or without it e.g. 23456789 and the country prefix will be added
automatically before sending the text.
Select the message type from the "Message type:" dropdown list. The available options are:
1. MMS - send the message as an MMS with the image attached to the message. Currently Twilio only
supports MMS messaging in the US and Canada. If this option is used in a country which doesn't
support MMS messaging through Twilio the message will be sent as an SMS + image.
2. SMS - send the message as an SMS. You will need to include a link to a website in the message
text so that the user can view their photos e.g. http://mywebsite.com/photos/{fullFilename}
3. SMS + image - send the message as an SMS with a link to the photo. The photo will only be
available for viewing for 7 days. Use the {url} token to include the URL to the image in the text
message. If the {url} token is not included in the message the URL will be appended to the end of
the message.
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Photos sent using the "MMS" and "SMS + image" options must be no more than 1MB in size after
resizing and cropping. An error message will be displayed if the 1MB file size limited is exceeded.
Twilio may resize the photo to conform with the cellphone service operator's MMS size limits.
Photos sent using the "SMS + image" option will be hosted on the Breeze Systems' website for 7 days.
You can specify a maximum message length to ensure the 160 character SMS message length is not
exceeded. In some countries SMS messages of more than 160 characters may be sent as multiple
SMS messages and will cost more. In other countries the SMS message will be truncated to 160
characters.
You can crop, resize and rotate the photos before they are sent to the user.
To crop the image first check the "Crop image:" checkbox and then specify the left offset and top
offset in pixels for the top left corner of the cropped image. Then specify the width and height of the
image in pixels. For example if the photos are from a photo booth which is setup to print a double strip
of 4 images on 6"x4" paper you may wish to crop the image so that only a single strip is emailed to the
user. If the printer is set to a resolution of 300 dpi the image will be 1200 pixels wide (4" x 300 dpi) by
1800 pixels high (6" x 300 DPI) and so to crop it into a single strip you need to set left=0, top=0,
width=600 and height=1800.
You can also specify a maximum size for the image being uploaded using the "Max width (pixels):" and
"Max height (pixels):" settings. The JPEG copy of the printed output will be resized so that it is no
bigger than these settings before it is emailed. Keeping these values relatively small, e.g. 500 x 500
pixels, will reduce the time it takes to send the email.
If required, the photo can be rotated using the "Image rotation:" dropdown list.
Please note that the image is cropped first, then resized and finally rotated before being sent to the
user.
Select the "Use MP4 copy of animated GIF if available" option to enable the uploading of the MP4 copy
of animated GIFs. Please see the animated GIF section for details of how to create animated GIFs.
GIFs and MP4 files will be sent without being resized or cropped.
You can specify a timeout for uploading the photo to prevent a slow or broken internet connection from
jamming the photo booth.
By default the screens displayed when sending an MMS or SMS will have a simple status message
shown on a black background. This can be overridden by placing the following JPEG screen images in
the screen images folder:
mms.jpg - screen displayed when sending an MMS
mms_success.jpg - screen displayed after an MMS has been sent successfully
mms_as_sms.jpg - screen displayed in if MMS isn't supported and SMS is being used instead
mms_error.jpg - screen displayed if there is an error when sending an MMS

MMS/SMS "Offline Mode" and sending texts after an event
If no internet connection is available at an event you can save users' cellphone numbers and send the
texts later when an internet connection is available. To do this you need to enable "SMS/MMS" in the
"Sharing" section of the "Output Settings" dialog and also select the "Offline mode" option. You also
need to select the "Log uploads to file" in the "MMS Settings" dialog - this will save the user's cellphone
number together with the filename of their photos.
The texts can be sent when an internet connection is available by selecting "Send emails and MMS/
SMS messages..." from the "File" menu in the main window. When you select this you will be asked
the log file to read (this defaults to the email log file specified in the "Email Server Settings"). The
"Unsent Emails and MMS/SMS Messages" dialog will be displayed listing the date/time, cellphone
number and photo for unsent texts found in the log file. Select the texts you wish to send and then
press the "Send" button to send them.
Please note: The email and text log files have the same formats and so email addresses and
cellphone numbers can be saved in the same log file.
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Notes on using a normal keyboard for Facebook uploads, tweets,
texts and emailing photos
The Facebook upload, Twitter tweet, texting and email photo options are designed to be used with a
touchscreen, but can also be operated using a normal keyboard. Please note that if you give users
access to a keyboard you need to prevent them from causing problems by exiting out of the photo
booth program (e.g. by typing Ctrl+Alt+Delete, Ctrl+tab or pressing the Windows key). One way to do
this is to take a basic USB keyboard and either wedge or glue the Ctrl, Alt, Win etc. keys so that they
can't be pressed.
The following keys can be used to navigate the print preview, sharing and Facebook login screens:
Print preview:
Type A to print the photos
Type X or Esc to cancel printing
Sharing screen:
Type F to upload to Facebook
Type E to email the photos
Type M enter user message
Type P to print the photos
Type S to send an SMS or MMS text message
Type T to tweet the photos on Twitter
Type X or Esc to exit the sharing screen and return to the ready screen
Touchscreen keyboard:
Type in the user name and password using the normal keyboard keys
Type Tab to switch between the username and password input
Type Enter to start logging in to Facebook after entering the username and password
Type Esc to exit and return to the sharing screen
Facebook login and PhotoBoothUploader app authorization screens:
Type Enter to login to Facebook and Enter again to authorize the PhotoBoothUploader app

Uploading photos to your personal or business Facebook page
There are a number of free tools for automatically uploading photos to your personal or business
Facebook page or to other social networking or photo sharing sites:
1. Dropbox - Dropbox is a free service for synchronizing files across multiple computers and devices.
When a file is copied into the Dropbox folder on your computer it is automatically uploaded to online
storage in the Cloud. If a photo is copied to a subfolder in the Photos Dropbox folder it will
automatically create an online gallery which can be viewed using a web browser.
Dropbox comes with 2 GB of free online storage which can be increased for a monthly fee. Please
visit the Dropbox website for more details.
2. IFTTT + Dropbox/Box/Google Drive- IFFT (If This Then That) is a free web based automation tool
that works in conjunction with free online storage services such as Dropbox, Box and Google Drive.
It uses "recipes" to perform actions when files are added to your online storage. It can link to many
services including Facebook (to access your personal Facebook page), Facebook pages (to access
a business Facebook page), Flickr, YouTube and Twitter. The recipes are run every 15 minutes and
can upload a maximum of 15 photos each update.
Please visit the IFTTT website for more details

© 2016 Breeze Systems Ltd

Photobooth Shooting

137

3. Wappwolf + Dropbox/Box/Google Drive - Wappwolf offers a similar service to IFFT and can also
to many services including Facebook (to access your personal Facebook page), Facebook pages
(to access a business Facebook page), Flickr, Picassa/Google+ Upload, YouTube and Twitter.
Please visit the Wappwolf website for more details
All of the above services work by monitoring a folder on you PC and automatically uploading the
photos to the Cloud or directly to a Facebook album. The output options in NKRemote can be used to
automatically crop and resize the prints from the photo booth and copy the image to the folder being
monitored for uploading to the Cloud and/or Facebook. The output settings dialog can be displayed by
setting the output option in the photo booth settings to "Print and save JPEG copy" or "JPEG copy
only" and pressing the "Settings..." button:

Select the "Copy JPEG to folder:" option and enter the name of the folder where the JPEG copy of the
© 2016 Breeze Systems Ltd

138

NKRemote

printed output should be copied to. This should be the folder that is being monitored by your the online
storage service. The JPEG copy of the printed output is formatted for sending to a printer and may be
larger than you want for uploading to Facebook. For example a typical double strip of 4 images printed
at 300 DPI on 4"x6" paper will be 1200 x 1800 pixels in size and will show two strips of 4 photos side
by side. You may want to limit the size for faster uploading and viewing on guests' cell phones etc. and
to crop the image so that it only shows a single strip of 4 photos. You can do this using the "Crop
image before copying" and "Resize image before copying" options as shown below:

If you need more control over the layout...
Please take a look at our Hotfolder Prints software if you need more control over how the photos are
formatted before being uploaded to Facebook and other social networking sites. Hotfolder Prints
allows you to create a completely new layout optimized for uploading (e.g. formatting on a 452x440
pixel page to look great in Facebook's timeline) and to add logos or other information that doesn't
appear in the printed strips. Hotfolder Prints can also email photos to users (using the email address
entered using the touchscreen keyboard) and run a slideshow which is automatically updated as new
photos are taken.

Summary Online Storage Services
The free IFTTT and Wapwolf web automation tools can be used in conjunction with the following free
Cloud based online storage services:
· Dropbox: 2 GB of free online storage, more available for a monthly fee
· Box: 5 GB of free online storage, more available for a monthly fee
· Google Drive: 5 GB of free online storage, more available for a monthly fee
Please note the information above was correct at the time of writing but may have changed since.
Please check the relevant websites for the latest information about the various services described on
this page.
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Automatic Printing of Photos
Photobooth mode can also be used for automatically printing out photographs as they are taken.
When this is setup you can take a picture with the camera using the normal camera controls and it will
be automatically downloaded to the PC and printed out using the current photobooth layout settings.
An optional confirmation screen can also be displayed allowing the photographer to decide whether to
print each photo. Applications include school and portrait photography, Santa's Grotto shots and id
photographs.
To use this mode set the number of photos in photobooth mode to 1, design the print layout (e.g. set
the number of rows and columns to 1, add headers, footers, captions and overlays as required) and
then select fullscreen photobooth mode. Then simply take each photo and it will be downloaded to the
PC and printed automatically. If the option to ask for confirmation before printing is selected the display
will show a print preview and ask for confirmation before printing each shot. Reprints of the last shot
can be made by typing Ctrl+R.
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Sample photobooth settings for automatically printing images as they are taken.

13

Setting Camera Date and Time
Click on the Camera menu and select "Set Camera Date/Time..." to set the camera's clock to the
same value as your PC.
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The dialog shows the current setting for the camera's clock and the PC's clock. Click on the
"Synchronize with PC clock" button to set the camera's clock using the PC's date and time.
If the "Automatically synchronize clock when camera is connected" checkbox is selected NKRemote
will automatically set the camera's clock using the PC's date and time each time it connects to a
camera.

14

Running NKRemote from other programs

Overview
NKRemote includes an interface library called NKRemoteLib.dll which can be used by other
applications to control NKRemote. Also included is a simple command line application called
NKRemoteLibTest.exe which can be used to control NKRemote from a command prompt or a batch
file. For example a batch file could be written to take a series of photos using different apertures and
shutter speeds to bracket the exposure.

NKRemoteLib.dll
NKRemoteLib.dll is a library that can be used by other programs to control NKRemote. It can be found
in the main folder where NKRemote is installed (usually C:\Program Files\BreezeSys\NKRemote).
Please see the NKRemoteLibTest\ReadMe.txt and NKRemoteLib.h files for details.
Files included:
NKRemoteLibTest.exe - compiled console application
NKRemoteLib.dll - DLL used by NKRemoteLibTest.exe to interface with NKRemote
NKRemoteLib.lib - lib for apps to link to the DLL
NKRemoteLib.h - header file for C applications using the DLL
NKRemoteLibTest - directory containing a VC++ 2005 project and source code for NKRemoteLibTest.
exe

NKRemoteLibTest.exe
NKRemoteLibTest.exe is a simple command line application that communicates with NKRemote and
allows the shutter to be released and some of the camera settings to be changed. NKRemoteLibTest.
exe and complete source code to build it using Visual C++ .Net can be found in the NKRemoteLibTest
folder where NKRemote is installed (usually C:\Program Files\BreezeSys\NKRemote).
Please note: NKRemoteLibTest.exe only shows some of the commands available using
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NKRemoteLib.dll. Please see the NKRemoteLib.h header file for a complete list of available
commands.
To run NKRemoteLibTest.exe first run NKRemote and then open a command prompt window and
change directory to the NKRemote installation folder. The run NKRemoteLibTest.exe -h to get a list of
the available commands.
Here is the output from a simple session where the output directory is set and the shutter is released
(commands typed in by the user are shown in bold):
Microsoft Windows [Version 6.0.6002]
Copyright (c) 2006 Microsoft Corporation.

All rights reserved.

C:\Users\Chris>cd C:\Program Files\BreezeSys\NKRemote\NKRemoteLib
C:\Program Files\BreezeSys\NKRemote\NKRemoteLib>NKRemoteLibTest.exe -h
Usage: NKRemoteTest <options>
-h
print this usage information
?
display camera info
-w <shots>
run camera as a webcam for <shots> shots
images are saved as webcam.jpg in the current directory
-t <interval>
specify the number of seconds between shots when
used as a webcam
-C <connect>
connect or disconnect from the camera
-a <aperture>
set the aperture, 0 = widest aperture
-b <WB>
set the white balance or kelvin color temp
-e <mode>
set the exposure mode
-s <shutter>
set the shutter speed, 0 = longest shutter speed
-x <comp>
set the exposure compensation
-i <size>
set the image size
-Q <quality>
set the image quality
-I <ISO>
set the ISO
-L <enable>
display/hide live view window
-f <step>
focus lens: step range -32767 (close) to 32767 (far)
-c <comment>
set comment to be added to images (max 255 chars)
-o <directory> set the output directory
-p <prefix>
set the filename prefix (max 255 chars)
-P <action>
Photobooth action: 0=start, 1=stop, 2=release, 3=BW
release,
4=color release, 5=BW mode, 6=color mode, 7=1 print, 8=2 prints, 9=3
prints,
10=4 prints, 11=5 prints, 12=increase copies, 13=decrease copies,
14=profile 1, 15=profile 2, 16=profile 3, 17=profile 4,
18=profile 5, 19=profile 6
-q
query output directory
-n
don't release shutter
-X
exit NKRemote
C:\Program Files\BreezeSys\NKRemote\NKRemoteLib>NKRemoteLibTest.exe -n -q
Output directory: C:\NKRemote
C:\Program Files\BreezeSys\NKRemote\NKRemoteLib>NKRemoteLibTest.exe
Success, image saved as: C:\NKRemote\2009-10-14\0001.JPG
C:\Program Files\BreezeSys\NKRemote\NKRemoteLib>
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Preferences
Click on "File->Preferences" to display the preferences dialog:

Mouse Button Actions
The middle and right mouse buttons can be assigned to release the shutter or take pictures in preview
mode. This allows you to use the mouse like a simple cable release.
Note: This only works if the mouse pointer is over the main window and is not over one of the controls.
Specifying the output directory
These settings control where images are stored on the computer's hard disk. The edit box displays the
base directory for images and can be changed by typing directly into the edit box or by clicking on the
"..." button and using the directory browser. If the Year, Month and Day checkboxes are not checked
this will be the directory in which all images are stored.
Note: If the directory does not already exist it will be created when the photo is saved.
The Year, Month and Day checkbox control the automatic generation of subdirectories according to
the computer's date. The example image name shown at the bottom of the dialog shows how the
various settings are combined. Select the "Flatten date" checkbox to combine the year, month and day
into a single subdirectory e.g. in the example above:
January 14, 2009 with "Flatten date" unchecked gives "C:\NKRemote\2009\01\14"
With "Flatten date" checked it gives "C:\NKRemote\2009-01-14"
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You can also use the tokens to when specifying the output directory e.g. "C:\%Y\%T" would give the
year followed by the camera model.
Image Filenames
When the "Sequential file numbering" checkbox is set NKRemote stores images using a numeric
sequence number when they are saved to the PC's hard disk. It scans the output directory for existing
images and uses the lowest available sequence number e.g. if the output directory already contains
the image 0123.JPG NKRemote will save the next image as 0124.JPG. NKRemote will then continue
numbering from that point even if the images are removed from the directory while it is running. This is
to prevent duplicate filenames when images captured by NKRemote are immediately removed from
the output directory e.g. when using a program to automatically send the images to a picture desk
using FTP.
When the "Sequential file numbering" checkbox is not set NKRemote scans the output directory for
existing images and uses the lowest available number to give a unique filename e.g. if the output
directory already contains the image 0123.JPG NKRemote will save the next image as 0124.JPG.
JPEG images are saved with a .JPG file extension e.g. 0001.JPG, 0002.JPG etc.
Raw images are saved with a .NEF file extension. If raw+JPEG mode is selected the JPEG image will
be saved as the same filename as the raw file but with a .JPG file extension e.g. 0001.NEF and 0001.
JPG.
You can specify an optional prefix to be added at the start of each image's filename e.g. the prefix
"studio shoot " would result filenames like "studio shoot 0001.JPG", "studio shoot 0002.NEF" etc.
You can also use tokens when specifying the output directory e.g. "C:\%Y\%T" would give the year
followed by the camera model.
When "Append sequence letter to end of filenames when auto-bracketing" is selected auto-bracketed
filenames have the same image number and a sequence letter added to each shot for easy
identification. e.g. a 3-shot sequence might give filenames 0001a.JPG, 0001b.JPG and 0001c.JPG as
opposed to 0001.JPG, 0002.JPG and 0003.JPG when this option is switched off.
The image number is padded with leading zeroes to match the number of digits value (the default
setting is 4). For example image number 6 would have the following values:
Digits=1: 6.JPG
Digits=2: 06.JPG
Digits=3: 006.JPG
Digits=4: 0006.JPG
Special case: Using the shutter activation count for filenames
To use the shutter activation count for the filename without adding the image number set the filename
prefix to {imageCounter} and the number of digits to 0.

16

Tokens
Date and time tokens
%a

Abbreviated weekday name

e.g. Fri

%A

Full weekday name

e.g. Friday

%b

Abbreviated month name

e.g. Jun
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%B

Full month name

e.g. June

%d

Date in the form YYMMDD (equivalent to %y%m
%D)

e.g. 080611 for June
11, 2008

%D

Day of the month (01 to 31)

%H

Hour (00 to 23)

%I

Hour (01 to 12)

%j

Day of the year (001 to 366)

%l

Long date/time representation of locale

e.g. Wednesday,
December 17, 2008
19:03:47

%L

Long date representation for locale

e.g. Wednesday,
December 17, 2008

%m

Month (01 to 12)

e.g. 06 for June

%M

Minutes (00 to 59)

%p

am/pm indicator

%S

Seconds (00 to 59)

%t

Time in the form HHMMSS (equivalent to %H%M
%S)

%W

Week number (00 to 53)

%x

Date representation for locale

e.g. 06_11_08 for June
11, 2008

%X

Time representation for locale

e.g. 14_39_29

%y

Year without century

e.g. 03

%Y

Year with century

e.g. 2009

%z

Time zone name

e.g. GMT Standard
Time

%Z

Time zone offset wrt UTC

e.g. +0100 for GMT
during DST

{yearNow}

Year 'now' in the form YYYY

e.g. 2009

{monthNow}

Month 'now' (01 to 12)

{dayNow}

Day 'now' (01 to 31)

{yearLess8h}

Year with century 8 hours ago - useful when
shooting events which continue after midnight

{monthLess8h}

Month (01-12) 8 hours ago - useful when
shooting events which continue after midnight

{dayLess8h}

Day of the month (01-31) 8 hours ago - useful
when shooting events which continue after
midnight

e.g. PM

Shooting data tokens
%c

Camera serial number

%e

File extension (without the '.')
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JPG
%i

ISO value read from the shooting data

%o

Image filename without extension

%O

Owner string (Canon cameras only)

%T

Camera model name starting from the first word
containing digits

e.g. D7000

%T1

Same as %T, but '-' are treated as spaces

e.g. D7000

%T2

Full camera model name

e.g. Nikon D7000

{orientation}

Image orientation: L for landscape or P for
portrait

{orientationAngle}

Image orientation in degrees: 0, 90 or 270

e.g. IMG_4567

Tokens for modifying strings
The tokens below can be used to modify tokens or strings:
Token
{left,n,str}
{mid,n,m,str}

{right,n,str}

Description
Extracts the first n characters from str
(which can be a string or token).
Extracts m characters starting from the n'th
character from str (which can be a string or
token).
Extracts the last n characters from str
(which can be a string or token).

Example
{left,4,{filename}} for filename
IMG_1234.jpg would give IMG_
{mid,5,4,{filename}} for filename
IMG_1234.jpg would give 1234
{right,3,{filename}} for filename
IMG_1234.jpg would give .jpg

Other tokens
{comment}

The value of comment entered in the main
window

{artist}

Artist string stored in the camera {newer camera
models only)

{author}

Same as {artist}

{copyright}

Copyright string stored in the camera {newer
camera models only)

{copy}

Same as {copyright}

{photoboothNumImages
Number of shots defined in photobooth mode
}

e.g. 4

{photoboothImage}

Shot number in photobooth shooting sequence

e.g. first photo returns 1

{photoboothDateTime}

Date and time at the start of the current
photobooth shooting sequence

e.g. 20110126_190509

{photoboothDate}

Date at the start of the current photobooth
shooting sequence

e.g. Jan 26, 2011
returns 20110126

{photoboothTime}

Time at the start of the current photobooth
shooting sequence

e.g. 7:05:09 pm returns
190509
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{photoboothDir}

The value of the full pathname of the photobooth
images folder

e.g. C:
\Photobooth\Profile1

{photoboothSubdir}

The value of the photobooth images subfolder

e.g. C:
\Photobooth\Profile1
gives Profile1

{photo1}, {photo2} etc.

Filename (without file extension or directory path)
of each photo in photobooth mode

{imageCounter}

Shutter activation count (the total number of
pictures that have been taken with the camera)

{imageCounter5}

Same as {imageCounter} but padded with leading
e.g. 01234
zeroes to give a 5 digit number

{imageCounter6}

Same as {imageCounter} but padded with leading
e.g. 001234
zeroes to give a 5 digit number

{filename}

Filename of the saved print layout in photobooth
mode (only available for captions used in
photobooth prints)

{uid}

Unique id in the form ABC12345 updated at the
start of each photobooth shooting sequence. Can
be used in captions and the filename prefix. The
id is guaranteed not to repeat within 72 hours and
is very unlikely to repeat within 10 years.

{message}

Message entered by the user when using the
"Message input at end of sequence" touchscreen
keyboard option

{sharingMessage}

Optional message entered by the user when
sending emails or uploading to Facebook

e.g. 1234

Release History
21 December 2016: v3.5
· Added support for drawing on or signing the print layout before printing or sharing
· Improved support for modifying photos before printing e.g. using Adobe Photoshop droplets
· New touchscreen actions added for increasing or decreasing the number of copies to print in the
print confirmation screen. The print confirmation screen now uses different backgrounds according
to the number of copies e.g. confirm_printing_1.jpg, confirm_printing_2.jpg etc.
· Improved green screen setup in photo booth mode
· Added the ability to share animated GIFs or MP4 video files by email, text, Facebook and Twitter.
Animated GIFs shared on Facebook are hosted on giphy.com
· Added the option to crop the print preview display in photo booth mode
· Reprint selection screen now allows multiple files to be selected and the number of copies to be
printed to be specified
26 July 2016: v3.4
· Added support for posting photos to Twitter
· Added support for sending photos by MMS (US and Canada only) or SMS via Twilio.com
· Added the option to create an animated GIF slideshow of photos taken in the photo booth shooting
sequence
· Added the option to only display live view in the ready screen and to hide it during the countdown
· Added additional photo booth shortcut buttons for taking a test photo and loading profiles
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· Added the option to hide the camera controls normally displayed on the left side of the main window
to provide a simplified interface for photo booth operators
· Now supports MP4 or MOV files for animated screens and countdowns in photo booth mode
· Movie file display no longer uses Apple's QuickTime libraries
· Minor changes to the way checkboxes are displayed in touchscreen keyboards
· The printing option in the sharing screen now has the option to limit the number of prints
· Added a "Close" action for touchscreen keyboards to allow a terms and conditions page to be
displayed at the start of the shooting sequence
· Fixed a problem with bright live view/AF mode not being selected when loading a profile if the default
profile has live view disabled
15 December 2015: v3.3.3
· Fixed a problem with image attachments not displaying in emails sent to Outlook.com
· Replaced %1, %2, %3, %4, %5, %6 tokens with {yearNow}, {monthNow}, {dayNow}, {yearLess8h},
{monthLess8h}, {dayLess8h} to avoid problems with unwanted substitutions in emails
· Fixed a typo in the default text for HTML emails: correcting <image src="{image}"> to <img
src="{image}">
30 November 2015: v3.3.2
· Fixed a problem with photobooth previews not being displayed on some computers
· Fixed a problem with adjusting the print preview size in photobooth mode
15 October 2015: v3.3.1
· Fixed a problem loading Type0016.md3 and Type0017.md3 on some computers
· Fixed a problem with downloading photos from the Nikon D7200
· Fixed a problem with the focus point overlay display when using a Nikon D7200
29 September 2015: v3.3
· Added support for the Nikon D5500, Nikon D7200 and Nikon D810A
· Added new touchscreen action editor
· Added "Message input at end of sequence" touchscreen keyboard option to allow users to enter a
message which can be added to the printed output (using the {message} token)
· Added an option to print photos from the sharing screen (this can also be selected when running the
photobooth setup wizard)
· Added optional password to protect "exit photobooth mode" touchscreen action
· Added touchscreen actions and keyboard shortcuts to select a profile and start the shooting
sequence (profiles 1 to 8 only)
· Added the option to log Facebook uploads to file
· Added the ability to position the photo within the background when shooting greenscreen in
photobooth mode
· The default touchscreen keyboard for entering the user's Facebook login name and password now
displays punctuation characters when the shift key is pressed (US keyboard layout)
· Email message text can now be specified in HTML format and plain text format
· Added mandatory option to <prompt> tag in touchscreen keyboard XML definition to indicate that an
input field must contain text
· Inactivity timer now loads default profile, if defined, before switching to standby mode
· Now supports up to 12 captions in the print layout, options to change the caption display order and
the option to right justify the caption text
·
·
·
·
·

9 December 2014: v3.2
Added support for the Nikon D750
Added RGB display of pixels for images displayed in the main window
Now supports hashtags when uploading to Facebook
Added offline email mode and the ability to send unsent emails later
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· Added reprint selection screen available from the ready screen
· Added inactivity timeout and auto standby options to photobooth mode
· Added the ability to shoot raw+JPEG images in photobooth mode
·
·
·
·
·
·
·

9 October 2014: v3.1
Added support for the Nikon D810
Added the option to crop the photo before uploading to Facebook or sending by email
Added "Single strip of 2" preset layout option
Fixed a possible problem where uninstalling a printer driver could cause the program to crash
The body text for emails now allows return characters
Improved error reporting when testing and sending emails and improved support for services such
as free email services like yahoo.com

18 July 2014: v3.0
· Added interactive editor for photobooth print layouts
· Added the importing and exporting of photobooth print layouts
· Added the ability to print QR codes on photobooth prints
· Added "Pop art" creative filter in photobooth mode
· Added optional thumbnail display in photobooth mode
· Added new photobooth dashboard to provide quick access to the main photobooth settings
· Increased the number of photobooth profiles from 8 to 18
· Increased the number of photobooth captions from 2 to 8
· Added support for the Nikon D4S
·
·
·
·
·

20 February 2014: v2.7
Added the ability to upload photos to a user's Facebook page in photobooth mode
Added the ability to email photos in photobooth mode
Added "Confirm printing (no JPEG copy)" print option in photobooth mode
Added support for the Nikon D5300

28 November 2013: v2.6.1
· Added support for the Nikon D610
· Added a single photo layout option in the photobooth setup wizard and preset layouts tool
· Improved the performance of printing custom layouts in photobooth mode when images are printed
multiple times e.g. the double strip of four layout
· Now disables touchscreen edge gestures when running in full screen photobooth mode on Windows
8 and Windows 8.1 systems
30 August 2013: v2.6
· Added new photobooth creative filter option which can apply a variety of different effects to both the
live view and the final photos.
· Added "bright live view/AF mode" option in photobooth mode to avoid problems with dark live view
images from recent Nikon cameras and to allow AF to be used in photobooth mode
· Added the option to rotate as well as crop and resize the additional JPEG copy of the printed output
· Added optional validation of email addresses entered using the touchscreen keyboard
14 May 2013: v2.5.3.2
· Fixes a problem with Nikon D700 live view that affected versions 2.5.1 through 2.5.3.1
· Improved support for angled multi-line captions in photobooth mode
3 May 2013: v2.5.3.1
· Maintenance release which fixes a memory leak in NKRemote v2.5.3
25 April 2013: v2.5.3
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· Added support for Nikon D7100
· Adding focus peaking option in live view display
· Added clicker mode where the photographer or users choose when to take each photo in
photobooth mode
29 January 2013: v2.5.2
· Added support for Nikon D5200
· Fixed a problem with cropping and resizing the JPEG copy of the printed output in photobooth mode
· Fixed a problem with the fast reprint option not working in photobooth mode
18 December 2012: v2.5.1
· Added the ability to set the artist and copyright information in camera models that support it (e.g.
D7000, D800, D800E, D600, D4)
· Added electronic level display in live view for camera models that support it (e.g. D7000, D800,
D800E, D600, D4)
· Fixed a problem with AF area display in live view when using Nikon D600 and other recent camera
models
· Fixed error loading Type0008.md3 problem which affected some systems
22 November 2012: v2.5
· Added support for Nikon D600
· Added the ability to use movies to animate photobooth screens
· Added next/previous profile keyboard shortcuts and touchscreen actions in photobooth mode
· Added two new preset photobooth layouts: double strip of 3 photos and single strip of 3 photos
8 November 2012: v2.4.2
· Added fast resize option in photobooth mode - provides faster print processing with minimal
reduction in image quality
· Added post processing options in photo booth mode for easier website and social networking site
uploads
· Added options to reprint photo booth photos after an event
5 July 2012: v2.4.1
· Fixes live view for the Nikon D800E
16 May 2012: v2.4
· Added support for Nikon D800, Nikon D800E and Nikon D4
· Added Photobooth Setup Wizard which automatically creates all the screens and the print layout for
common photobooth configurations
· Added an option to include the current printer settings when saving the photobooth settings to file
· Added a quick reprint option (keyboard shortcut: Ctrl+Shift+R) when the output option is set to "Print
and save JPEG copy"
· Added {uid} token which generates a unique id for filenames and captions when shooting in
photobooth mode
3 February 2012: v2.3.2
· Added <caption1> and <caption2> tags to the XML photobooth summary file
· Added an option to the touchscreen keyboard to hide text when entering a password
· Greenscreen backgrounds can now be replaced by copying the new greenscreen_background.jpg
image into the photo booth images folder while the booth is running
· Fixed problems using 8 profiles in photobooth mode
11 January 2012: v2.3.1
· Added timeouts in photobooth mode for print confirmation and touchscreen keyboard input
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· Displays optional reprinting,jpg screen image and skips the print confirmation screen when reprinting
photobooth images
· Added contrast AF keyboard shortcut and touchscreen action in photobooth mode
· Added optional checkboxes to the touchscreen keyboard in photobooth mode
· Improved noise reduction in photobooth live preview when displaying black and white images
8 November 2011: v2.3
· Added the ability to specify a horizontal offset for the live view display in photobooth mode
· Added the option to use {photoboothSubDir} or {photoboothDir} tokens when specifying the profile
pathname to allow the use of more than 8 photobooth profiles
· Added a separate delay for the first photo in the stills photobooth shooting sequence
· Added optional color management of printed images
· Fixed a problem with incomplete screen refreshes when switching photobooth profiles
4 August 2011: v2.2.3
· Added preset layouts when using the custom layout option to help design popular layouts using four
photos
13 June 2011: v2.2.2
· Added support for Nikon D5100
4 May 2011: v2.2.1
· Added blue screen shooting
· Added default profile option to reset the photobooth to a known state after each shooting sequence
· Enhanced touchscreen keyboard in photobooth mode to allow multiple input fields and the use of a
normal keyboard
8 February 2011: v2.2
· Added confirm_printing.jpg and printing_confirmed.jpg screens when using the print confirmation
option in photo booth mode
· Added optional touchscreen keyboard in photo booth mode
· Green screen shooting in full screen photo booth mode now has the ability to use different
backgrounds and overlays for each shot and to save a green screened copy of each photo
7 January 2011: v2.1
· Added support for Nikon D7000
· Photobooth mode now has the option to specify the vertical positioning of the live view display and
countdown text
· Photobooth mode now has the option to disable live view during printing
· Photobooth previews are now green screened and look like the final output when green screen
shooting
· Fixed a problem with raw images being saved when taking preview shots with RAW+JPEG image
quality selected
27 August 2010: v2.0
· Added green screen shooting overlay in main live view window and in photobooth mode
· Added optional overlay image for live view display in photobooth mode
· Photobooth timings changed so that countdown text now counts down to 1 instead of stopping at 2
· Added image overlay option for live view
26 May 2010: v1.4.1
· Fixed a problem that caused the error message "An Invalid Argument Was Encountered" to be
displayed on some systems when selecting full screen photobooth mode
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24 May 2010: v1.4
Added the following enhancements to photobooth shooting:
· New, more flexible custom layout of prints including image rotation. Please note that custom layouts
from previous versions of NKRemote will need to be updated if they use the "Copy left half of page
to right to create a double strip" option
· Captions can now be rotated
· Live view is hidden when displaying the release.jpg image to avoid confusion caused by the live view
freezing just before the picture is taken
· Added an optional minimum duration before closing the processing.jpg screen to allow a 'Please
leave the booth now' message to be displayed for several seconds at the end of the sequence
· Improved handling of external button presses in photobooth mode to prevent a new shooting
sequence from being started before the current one has finished printing
11 February 2010: v1.3.1
· Added support for Nikon D3S
24 November 2009: v1.3
· Added support for Nikon D80 and Nikon D300S
· Automatically restarts live view display if it is canceled by the camera
· Added more flexible touchscreen options to photobooth mode and the ability to switch between
different sets of photobooth settings
· Added optional release.jpg screen which is displayed immediately before taking a picture in full
screen photobooth mode
· Added Ctrl+R keyboard shortcut in full screen photobooth mode to reprint the last print
· Fixed a display problem in live view when loading a previously saved onion skinning backgrounds in
portrait mode
· Added NKRemoteLib.dll interface library which allows other apps and scripts to control the camera
via the main NKRemote window
· Added different sizes for zooming the live view window
5 August 2009: v1.2
· Added support for Nikon D3X
· Added custom layout option for photobooth prints and the ability to load and save photobooth
settings
1 July 2009: v1.1
· Added support for the Nikon D5000
· Added the ability to adjust the size of focus steps in live view on a per lens basis
· Minor improvements to the focus_stacking AutoHotkey script.
11 March 2009: v1.0.3
· Added the ability to play .wav sound files when displaying photobooth prompt screens
· Added the ability to specify the number of copies of photobooth prints
· Added additional start options for fullscreen photobooth mode to facilitate the use of touchscreens
· Added support for the StealthSwitch in fullscreen photobooth mode
2 February 2009: v1.0.2
· Fixed a problem with displaying NEF images in portrait orientation which caused them either not to
fill the available display area or to be cropped
· Removed 1st February 2009 program expiry accidentally left in from the pre-release version
20 January 2009: v1.0.1
· Fixed problems with repeated error messages when the camera connection is lost and autoreconnect is not selected
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· Added a workaround for an intermittent bug in the D300 which resulted in incorrect shutter speeds
being listed in shutter priority and manual exposure modes
· Added a workaround for a bug in the D90 which caused problems when auto updating the onion
skinning background in live view
· Added a warning message when auto-bracketing using an auto exposure mode when the autobracketing range exceeds the exposure compensation range
· Fixed problems with auto-bracketing when shooting using image formats other than JPEG
· Fixed a problem selecting focus points from the PC when using the D300, D700 and D3 with the AF
Point selection set to AF11
14 January 2009: v1.0
· First full public release with support for Nikon D90, Nikon D200, Nikon D300, Nikon D700 and Nikon
D3 cameras
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